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P R E F A C E

Math Writer™ was created to make the writing of mathematics-laden 
scientific and technical manuscripts less daunting. Traditional word 
processors do not provide tools that are powerful enough to provide a 
seamless, visual integration of mathematics as text within a manuscript but 
also intuitive and simple enough not to interfere with the writing process.

MathWriter is an author-centered writing tool. Its creation is a response to 
the needs exposed by twenty-five years of struggle with composing papers, 
tedious transcription using inadequate tools, the tracking of inevitable 
revisions and retyping, and the agony of the equally inevitable task of 
correcting flaws introduced in galley proofs. MathWriter was designed to 
simplify that process. By composing at the keyboard (and mouse), the au
thor retains greater fluidity in the creative process and avoids the tran
scription process. By creating camera-ready copy, an additional step can 
sometimes be saved, as was done with this manual, which we prepared and 
printed using MathWriter.

MathWriter's feature innovations include its "what-you-see-is-what-you- 
get" handling of mathematics, automatic numbering, revision tracking, 
interactive library, ease of handling frequent typeface changes, and modu
larity for customized expansion of functionality.

MathWriter 2.0 evolved from our mathematical expression editor over a 
three-year period of intense effort. We are grateful for the invaluable 
assistance we received from our friends—new and old. Leonard Gillman 
freely shared his insights and professional experience; more important, he 
provided the encouragement that flows when someone believes in the im
portance of your task and in your ability to make a meaningful contribution. 
Morven Gentleman's kind letter first planted the idea for expanding our 
efforts to create a technical authoring environment, and Richard Palais's 
wise words on the subject in the Notices of the AMS convinced us to under
take this massive effort. Robert Perl provided competent and dependable 
support on many tasks.

Some of the features in MathWriter  followed directly from specific sugges
tions. For example, Len Gillman suggested auto-italicizing; Jerrold Mars- 
den, the library for typing built-up mathematical expressions; Mike Axel
rod, the check for repeated words; Dick Szymanski, the table feature; and 
Steve Erde, the file name variable.

Some individuals performed specific tasks of particular importance: Nancy 
Cooke "translated" the manual into English and with Richard Cooke wrote



a primer for students, "Writing a Paper Using MathWriter"; John Cooke 
programmed the HyperCard demo stack "About MathWriter™ 2.0"; Gary 
Wernsing wrote the utility for translating files to and from the data inter
change format (RTF); Julia Noblitt prepared the math-science-engineering 
dictionary with the assistance of Sandra Bates, Sam Lenke, Moss Sweedler, 
and Keith Dennis; Douglas Davenport provided expert PostScript® consul
tation; Gideon Shaanan provided the earliest and most challenging debug
ging. Many were involved in testing during an extended period: Loren Arga- 
bright, Chris Borkowski, Leonard Gillman, David Gries, James Hurley, 
Linda Iroff, Steve Lantz, Benton Leong, Jerrold Marsden, Philip McDun- 
nough, Wendy Nelson, Robert Pucel, Larry Riddle, Tom Scavo, James Tasi, 
Shrinivasa Upadhyaya, and George Wolga. We are grateful for the 
review comments from Peter J. Bickel, Leo Breiman, Javier Cabrera, David 
Eisenbud, Peter Eklund, Susan Franklin, Daniel J. Friedman, Edward I. 
George, Greg Kearney, Benton Leong, Marvin Marcus, Thomas R. Scavo, 
Raymond F. Smith, Gerald L. Thompson, and Esther L. Zack.

Others provided advice and encouragement during some phase of this pro
ject: Claire Berman, Lisa Blessing, Burt Cummings, Kenneth King, M. Stuart 
Lynn, Philip McDunnough, Tim Mount, John Noon, Richard Rand, Gerald 
Rehkugler, Patti Sobel, Anita Szewczak, Dick Szymanski, Cary Tengler, 
Paul Velleman, Daryl Wiener, and the many users of our mathematical 
expression editor who encouraged us by their kind words, including Emmet 
F. Low, Jr., Bruce Finlayson, and Tom McMahon.

One could not hope for a more supportive editor than John Kimmel. Marlene 
Thom was our capable and effective Production Coordinator and the talent
ed Phyllis Larimore was Copyeditor.

Finally, we are indebted to all those brave souls who helped us with any 
phase of the testing, including Ashim Datta, Jesus Dumagan, Debbi Lewis, 
Janet Mathews, and John Wiesenfeld. The picture of an open stomate used 
in the advertising and on the box cover was taken from the Ph.D. disserta
tion of Jae Young Lee, whose manuscript provided compelling evidence of 
the need for MathWriter™ 2.0. Cornell University, true to its tradition, 
provided an open and supportive environment in which this non- 
traditional form of scholarship could be undertaken. We thank especially 
our spouses for their support and forbearance during our extended 
preoccupation with the creation of our magnum opus.

If MathWriter  has contributed significantly to your productivity or if you 
have suggestions for improving the next version or ideas for modules, please 
write to us in care of Brooks/Cole Publishing Company.

]. Robert Cooke 
E. Ted Sobel
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C H A P  T E R

1  Overview

MathWriter™  is a completely new, full-featured word processor that 
facilitates the demanding requirements of technical writing. In addition to 
text and graphics, technical writing often includes mathematical 
expressions. MathWriter allows authors to compose equations and text at 
the keyboard as easily as prose writers compose with an ordinary word 
processor.

Virtually every traditional word-processing feature has been made more 
general in MathWriter. The program updates the screen with each 
keystroke and provides visual clues whenever feasible. It lets you see what 
you are doing to your manuscript and improves on the description "What 
you see is what you get." For example, MathWriter continually displays 
the actual page layout, contents, and numbering. For deferred action page 
and document formatting commands, miniature portraits show the 
consequences of your choices.

You need not memorize a bewildering collection of keyboard commands to 
use Math Writer. You can combine convenient and visually prompted mouse 
control with rapid keyboard input to match your preferences and level of 
experience.

Because each user has different needs, MathWriter provides a broad range 
of settings to accommodate these needs. For example, you may hide the 
mathematical tools when you are not using them. By using default files you 
will have quick access to an initial writing environment that includes 
specific selections of typeface, page layout, text, and graphics you use 
repeatedly.

With tools designed specifically for technical writing, MathWriter helps 
you produce scientific manuscripts more quickly and easily than with other 
word processors. An automatic numbering feature is provided for equations, 
footnotes, and cross-references to them. Math Writer automatically updates 
these numbers when you use Cut and Paste. An additional variable provides 
numbering for figures or tables. You may type and edit headers, footers, 
footnotes, and mathematical expressions without moving into separate,
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isolated windows. In addition, the Find and Replace facility applies to 
mathematical expressions, as well as to text.

MathWriter's signature feature is the full integration of mathematical 
expressions into the text. No longer will you be required to compose 
mathematical expressions using memorized, embedded commands that are 
later transformed into conventional mathematical notation. Nor will you 
need to compose mathematical expressions in a separate environment and 
paste them into the document as graphics, although you can use 
MathWriter simply as an expression editor.

You create equations as part of the text and in the document window. 
MathWriter automatically handles mathematical typesetting conven
tions. It reformats expressions with each keystroke or mouse input sequence 
for maximum visual feedback.

It handles frequent changes in font, font size, font style, and two- 
dimensional character placements with ease and often automatically. 
Common mathematical structures such as fractions, brackets, matrices, and 
tables dynamically resize as you type. Line spacing automatically adjusts 
to accommodate lines of different heights, common in mathematical 
expressions. MathWriter supports PostScript® output for high-quality 
printed documents.

Design and Features in Brief
Math Writer includes a number of unique and convenient features including 
the following.

• Treats mathematical expressions as text, rather than as graphics, 
providing greater formatting control, Search and Replace for 
mathematical expressions, and editing of mathematical expressions in 
context.
• Extends the meaning of "What you see is what you get". MathWriter's  
in-context word processing lets you edit headers, footers, and equations 
without switching into a separate window; provides automatic pagination; 
and automatically formats equations with each keystroke.

• Provides visual clues whenever possible.

• Automatically formats tables and mathematical expressions.

• Automatically numbers equations and footnotes, including cross-references 
within the text, and automatically updates them as you edit. An 
additional variable can be used to number another category such as figures, 
paragraphs, or tables.
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• Provides spell-checking.

• Provides borders and background patterns for highlighting important 
paragraphs and equations.

• Provides file transfer capabilities, as well as automatic extraction of 
equations and graphics, for use in page layout programs.

The MathWriter Screen
r k  File Edit Format Palettes Diac Style Windows
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The process of one-dimensional water transfer in unsaturated soil can be 
described by the well-known Fokker-Planck equation:
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or Richards (1931) equation:
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where 0 is the volumetric water content (L3 I L3) ; z is depth (L) positive 
downwards; t is time (T); K is hydraulic conductivity (L/T), a function of 0; 
D is diffusivity (L2/T) defined by D (0) = K (0) dh / d0, where h is soil water 
suction (L) relative to atmospheric pressure; and C is the capacity (1/L) 
defined by C (9) = -  d0/dh.
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Figure 1.1 MathWriter screen

To better utilize limited screen space, MathWriter  uses floating windows 
that you can reposition or remove if desired. (See Figure 1.1.) Unless you 
hide the ruler, a single thin ruler remains at the top of the window and 
displays information corresponding to the paragraph that contains the 
blinking insertion point.

MathWriter  provides templates for common mathematical structures, 
which format automatically. The Palettes floating window is a typing aid 
that contains the Greek alphabet and user-selected character groups. The 
Tools floating window provides access to editing tools: I-beam to edit text, 
split I-beam to edit within mathematical structures, cross-hair for 
sidebars, and arrow for character placement. The superscript and subscript 
tools in the Tools window automatically adjust the position of the insertion 
point and the font size.
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When used with a screen projector, MathWriter doubles as an overhead 
projector.

We see MathWriter as the centerpiece of a new family of elegant writing 
tools that we hope will allow you to focus your energy on your work, rather 
than on your word processor!

How to Begin
This User's Guide provides two parallel introductions to MathWriter. 
Chapter 2 is a self-guided tour of MathWriter features to be studied while 
at the Macintosh keyboard. Chapters 3 and 4 provide a detailed, step-by- 
step, task-oriented introduction to nontechnical and technical word 
processing respectively. Chapter 5 is a very brief, quick-start alternative 
for more experienced Macintosh users. Chapter 6 is a command-oriented 
description of all features. The appendix includes an interface refresher for 
novice users, a description of MathWriter  files, a summary of advanced 
keyboard commands, and other reference materials.

Typographic conventions

• The names of special keys on the keyboard (return, enter, delete, option, 
96, shift, and tab) are displayed in lowercase italics.

• Lists of ordered steps are numbered; lists of nonordered items or optional 
steps are identified by • or ♦ .

• The full path for menu commands is indicated by the menu name / menu 
command / submenu (e.g., Windows/Tools/Math Editor) and this is often 
followed by a keyboard equivalent (96 shift ; ) where the space separator 
is not part of the command.
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2 Guided Tour

As its name implies, MathWriter's signature feature is its ability to write 
mathematics. We increased the scope of nearly every feature of traditional 
word processors and, in addition, invented many new tools for this task. In 
this guided tour, we provide a task-oriented, rather than feature-oriented, 
introduction to Math Writer. This tutorial assumes that you have limited 
experience using the Macintosh. In the exercises we provide step-by-step 
instructions for completing a progression of increasingly more sophisticated 
tasks. Each exercise builds on and assumes a knowledge of the techniques 
presented in previous exercises.

Because many users may not routinely need to write mathematics, the 
initial examples demonstrate that Math Writer's more technical features 
can be made completely unobtrusive. Later examples illustrate special 
mathematical capabilities.

Preliminaries
Software and hardware requirements

The following requirements are recommended.

1. The Educational Version of MathWriter can be used with two 800K disk 
drives as minimal support, but a hard disk is recommended so spell
checking can be used conveniently. Math Writer uses overlays, which means 
that only those portions of MathWriter code currently in use are RAM- 
resident. This leaves more memory for your documents. Because the 
computer must access the Math Writer disk as you use the program, the disk 
should remain in the drive. With a hard disk you can keep MathWriter, 
the dictionaries, help files, etc., available for immediate use.

2. The most recent operating system compatible with your hardware (e.g. 
System 4.0 and Finder 6.0 or more recent systems that support hierarchical 
menus). MathWriter  is MultiFinder® -compatible. However, if you have 
only 1 megabyte of RAM, use Math Writer with Finder.
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To change from MultiFinder to Finder or vice versa, use the Set Startup... 
selection in the Special menu at the desktop and then select Restart, also in 
the Special menu.

3. Times and Symbol fonts must be available for MathWriter to function.

4. A Macintosh SE/30 or a Macintosh II with 2 megabytes of RAM and a 
hard disk is needed for the Professional Version of Math Writer. We do not 
recommend using the Professional Version with less powerful Macintoshes, 
such as an SE. MathWriter  is a computation-intensive program so its 
performance is sluggish on a 68000-based Macintosh. Because documents are 
RAM-resident, document size must be restricted if you have only 1 megabyte 
of RAM. Use the reduced-feature Educational Version if you are limited to 
a Macintosh Plus with 1 megabyte of RAM and two floppy drives.

Make a backup
Before installing MathWriter, make a backup of the master disks as 
described here.

First, write-protect each master disk to guard against accidental erasure: 
Position the plastic corner tab such that you can see through the square 
hole on the corner of the disk. Then follow the instructions in your 
Macintosh Owner's Manual to make a working copy of each disk before 
storing the originals in a safe place. If a working copy becomes unusable, 
you will be able to make a new one from the originals.

Install MathWriter
If you are using a hard disk, create and name a MathWriter folder on the 
hard disk, successively place each working copy in the floppy disk drive, 
double-click its icon, and then drag the file icons into the new folder on the 
hard disk. If you are using the educational version with two disk drives, 
place Math Writer and your documents on one disk and the operating system 
on the other.

Remove unnecessary files, fonts, INTI'S, and desk accessories to conserve 
disk space. The Times and Symbol fonts must be available for MathWriter 
to operate. The modified version1 of the Symbol font distributed with 
MathWriter should be used. Remove the Apple-supplied Symbol screen 
font and then replace it with the supplied version using the Font/DA 
Mover received with your current operating system.

When activated by double-clicking its icon, MathWriter  automatically 
creates and places a file with configuration information in the system 
folder.

1 The extremities of the stretchable brackets and braces of the Apple-supplied version of the Symbol font do not 
display correctly on the screen and boldface style is not enabled.
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About the Exercises
The exercises that follow present step-by-step instructions for completing 
various common tasks. Some of the steps are numbered and are essential to 
completing the task. Others are simply suggestions for practice and are 
indicated with a diamond ♦ at the left text margin.

Again, do not begin until you have made a working copy and have safely 
stored the master disks. You should have already installed the Symbol 
font. If you wish to print MathWriter files, you must also install the 
appropriate print driver, select the driver using Chooser, and connect and 
prepare the printer for printing.

Exercise 1: Reviewing a Short Memo

This first exercise describes the startup process, how to open an existing 
file, navigating through a document, exploring the interface, printing the 
document, and quitting.

Starting M athW riter
1. Complete the usual Macintosh startup process.

2. Double-click on the Math Writer icon. Math Writer will automatically 
open a new document file named Untitled 1.

To examine an existing file:

1. Select Open... on the File menu.

The file selection dialog window opens.

2. Select the drive that contains the MathWriter file named Exercise 1.

3. Select the folder that contains the desired file. The File Type should 
read All known types or MathWriter™ 2.0. If not, drag to select one of 
these from the pop-up menu list. Only folders and the files that match this 
file type appear in the window.

4. Select the file Exercise 1 and click on the Open button. Note: As a 
shortcut, you can double-click on the file name to eliminate use of the Open 
button.

This exercise asks you to read through and work on the following 
hypothetical memorandum from the authors to new MathWriter users. As 
you move through the memorandum, which is the same in the manual and 
on the screen, the text will tell you what to do.
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MEMORANDUM

Date: Nov. 15,1990

To: MathWriter New Users

From: The Authors

Subject: MathWriter basic features—a first glimpse

We assume that you have a basic familiarity with the Macintosh 
interface as described in the materials supplied with your computer. 
Consequently, this first glimpse will describe the basic features you need to 
perform simple tasks with MathWriter—moving around within a 
document, formatting paragraphs, identifying typefaces, moving text, 
saving and printing a document, and ending a session.

Basic features

Move around within a document

After reading this paragraph, repeatedly drag and release fe l  the 
vertical scroll box to examine the entire document and then return here. The 
number in the scroll box identifies the page that appears in the document 
window when you release the mouse button. More precisely, it is the page 
visible at the top of the document window. Math Writer displays docu
ments as "sheets of paper" and automatically paginates them.

Click immediately above or below the scroll box to scroll one complete 
screen vertically up or down.

Click in the scroll arrows El to move a few lines, or press opt ion when you 
click the scroll arrow to scroll a single line.

The boundary lines of the margins, the header, and the footer are visible 
because Show Layout in the Format menu has been selected (as a result, the 
menu choice now reads Hide Layout). The cursor changes shape when you 
move it from one work space where the blinking insertion point is located to 
another. If you move into the header, click, and then return to the main 
body, the cursor changes to fq  and then back to F[^.

Examine the ruler

Observe that the positions of the left margin marker ▲ (together with a 
left tab it looks like »  and first line indent marker 1 on the ruler change 
when you place the cursor first within this paragraph and then within the 
preceding paragraph ("Examine the ruler"). In this paragraph the first
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line "indent" is to the left of the paragraph margin and produces a 
"hanging indent" to make the paragraph conspicuous.

Notice that the ruler does not scroll from view; it always displays the 
particular conditions of the paragraph that contains the blinking insertion 
point. When you press return, MathWriter  creates a new paragraph that 
inherits the ruler conditions of the previous paragraph. If you change the 
ruler, a ruler icon CHI!] appears in the gray left border unless you select Hide 
Messages on the Format menu.

<— ruler icon in the gray area (in the screen version)

Examine paragraph alignment

Click within this paragraph and then select each of the four paragraph 
alignment symbols just above the vertical scroll bar. As you click each 
symbol, the text of this paragraph changes alignment from left M-, to right 
—W, to aligned left and right w-h, and to centered i* i .

To place horizontal tabs on the ruler, drag them from the supply above the 
paragraph alignment icons. To remove a tab from the ruler, drag it past the 
right margin marker on the ruler. Drag the symbol to reposition a tab. Click 
on the next blank line (paragraph) to see 4 ► ♦  0  on the ruler.

Examine the status bar

Click inside the following words: "Click Here." Notice that the status bar 
at the foot of the window indicates the typeface, in this case bold. Also, 
observe that MathWriter reports in the status bar the line number 
(measured from the beginning of the document) and character position 
(measured from the first character on that line) of the blinking insertion 
point.

Edit a footer in-context

Scroll if necessary and look at the contents of the footer. In the right corner 
find the word "(more)" and click between the left parenthesis and the word 
"more." Then type "Continue for" to see how footers are edited. Backspace 
to correct any typing errors. If you backspace too far, the word "(more)" may 
jump to the beginning of the line. With the cursor placed right before the 
"m" in "more" press tab to restore the word to its original position.

Cut, Copy, and Paste

To observe editing with Cut, Copy, and Paste in the Edit menu, follow the 
instructions to change the sentence below from "Please move this word" to 
"Move this word, please."
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"Please move this word."

Select Please using the mouse or using the arrow keys and shift key. With 
X cut it from the text and with 9$ V paste it after word (or use the Cut 

and Paste selections in the Edit menu). Then complete the editing by 
changing capitalization and punctuation.

Select Clipboard from the Windows menu to see a copy of the word Please 
placed there by the cut command. Click the Clipboard close-box (top-left 
corner) to close it.

Save the document

If this file were not locked, you could use Save on the File menu to save your 
document. However, you can rename the file and save a copy of the entire 
exercise in MathWriter format if you select Save As... from the File menu.

Print a copy of this document

To print the document, click on the Chooser command in the 4  (Apple) 
menu. The name of your printer should appear in the box User Name. If not, 
select Print from the File menu, make the selections necessary, and click OK 
in the print dialog box.

Summary

So far you have learned to:

• Scroll within a document and move the insertion point

• Locate headers and footers and edit them

• Create and format paragraphs (first line indent, tabs, leaders, and 
paragraph alignment)

• Locate the position of the insertion point and identify the typeface of 
the adjacent character to the left

• Cut, copy, and paste text

• Save and print a document 

To continue this guided tour:

1. Select Close on the File menu.

2. Open the "Exercise 2" file to continue the tutorial.
To end this and other MathWriter sessions, select Quit from the File menu.

The Exercise 1 file is write-protected, so exit without saving when 
prompted.
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Exercise 2: Reviewing a Manuscript
Word processors contribute a great deal to the task of perfecting a 
manuscript. In fact, this may be the important contribution a word processor 
makes to the writing process. In Exercise 1 you learned to make additions 
and deletions by retyping and by moving text selections from one place to 
another. In this exercise you learn to check spelling using the MathWriter 
dictionary and to search for a specific word in a document. As was the case 
in Exercise 1, the text of the exercise file will tell you what to do.

Spell-checker

The spell-checker will, at your request, suggest options for misspelled 
words, skip words in all capitals, and locate repeated words.

Find/Replace

The Find/Replace feature can locate any string of text whether it is an 
embedded substring or a whole word. Furthermore, a search can ignore the 
actual text and search for a particular format such as font, size, or style. 
MathWriter can also locate hidden formatting characters such as the end- 
of-paragraph symbol or a tab marker. You can even specify a search direc
tion. For example, when composing a document, you often need to search 
backward from the insertion point.

To search backward from the end of this sentence to find the words "tab 
marker," follow these steps:

1. Place the insertion point at the end of this sentence.

2. Select Find/Replace from the Edit menu.

3. Press on the word Direction of the Find/Replace window and drag to 
Backward.

4. Type the word tab marker in the Find box.

5. Click the Find button or type Si G to locate each occurrence.

You can replace the located text with the contents of the Replace With box 
using the Replace (Si H) command or you can replace and resume searching 
using the Replace, then Find command. The Replace All command cannot be 
undone so you should always make a backup of the file before using this 
command.

Notice that you can search for mathematical expressions, as well as for
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Summary

typeface characteristics and text sequences.

MathWriter provides the following document review tools:

• Spell-checker that finds repeated words

• Generalized find and replace capability

This completes Exercise 2. In Exercise 3, you will examine some text entry 
and formatting tools.

Exercise 3: Input Tools
MathWriter supports both mouse and keyboard input for most commands. 
By pointing and clicking the mouse, the novice or infrequent user can easily 
and quickly use MathWriter without having to memorize commands. On 
the other hand, the experienced or power user will appreciate the speed 
afforded by keyboard commands. Whatever your level of experience, you 
can mix these approaches as you wish.

Online help

We hope that MathWriter’s interface is sufficiently intuitive that you can 
work with minimal prompting. For those times when prompts would be 
useful, use the Help window as described here.

1. Select Help from the Windows menu (#  ?).

The Help window presents a scrollable list of topics, including general 
information, step-by-step instructions for performing common tasks, and a 
menu/command summary. Select a topic from the list, scrolling if necessary, 
and click on the Help button or double-click on the topic. Use the « or » 
buttons to scroll to adjacent help screens, click Topics to return to the list of 
topics, click in your document window to return to it while leaving the Help 
window open, or click in the Help window close-box to put it away.

2. If the Help window is still open, click the close-box in the upper left 
comer of the window to put it away.
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Keyboard commands for type style changes

MathWriter has an extensive set of keyboard commands. Those that 
control type style changes are listed here.

Font Selection
Si spacebar Toggles between the current font and the Symbol

Si+

font (which contains the Greek alphabet and 
other mathematical symbols)
Font Size Selection
Next larger font size on size submenu

Si option + Increase font size by one point
Si- Next smaller font size on size submenu
Si option - Decrease font size by one point

SiP
Font Style
Plain (and removes all other style attributes)

SiB Bold
Si I Italic
S iu Underline
Si Y Other styles (access to numerous other styles)

Si \
Font, Size, Style, Justification, Alignment
Revert to immediately previous style

Si< Style 1 of user-selected attributes
Si> Style 2 of user-selected attributes

Use Doc Preferences... in the File menu to 
assign user-selected attributes.

Transfer of paragraph formatting

Each new paragraph automatically inherits the formatting of the 
preceding paragraph.

To transfer the Ruler, Format, Ruler & Format, and Style information from 
one paragraph to another:

1. Click within the originating paragraph

2. Make a copy of the desired information using Edit/Copy Other

3. Click within the destination paragraph

4. Paste the information using Edit/Paste Other

Using default documents

Many documents such as memos contain repeatedly used formats for 
letterheads, logos, etc. You might have a preferred font for these
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documents, depending upon esthetics or printer availability. To speed the 
creation of such documents, create and use skeletal default files as follows.

1. Use the New command from the File menu (not a New submenu choice 
even if one is present) to open a blank, generic document.

2. Assign all global properties of this default (template) document. 
Change the existing defaults as desired. Some options are:

• Use File/Page Layout to set the choice of printer, printer options, space 
for binding, margin sizes, header and footer sizes, and whether to use facing 
pages format.

• Use File/Doc Layout to assign the placement of headers, footers, and 
footnotes within the document.

• Use File/Doc Preferences... to set font, font size, font style, paragraph 
alignment, and line spacing combinations for styles 1 and 2, and footnotes.

• If relevant, use the Format menu to assign ruler options, line spacing, 
matrix formats, and formats for the variables such as date, time, etc.

• Use the Style menu to set the font, size, and style for the body of the 
document.

• Supply any text or graphics that you wish to appear in the default file.

3. Use Save As... on the File menu to turn your document into a default file; 
select MW Default File from the pop-up menu as the file type. Save the 
file in the same folder with MathWriter  or in the system folder so that 
MathWriter can immediately add this name to the New submenu list.2

To use copies of this template in future sessions you need only select it from 
the New submenu. When you select a default file from New, MathWriter 
automatically uses the defaults contained in that file. Next, we show you 
how to create this primary startup file.

• Before going on, for practice, create a default file.

Default settings and the startup file

Another way to reduce the number of commands and the time needed to 
create a document is to customize the MathWriter  configuration to match 
your needs. The startup configuration pertains to MathWriter, rather than 
to a specific document, and is stored in the MathWriter Prefs file that 
MathWriter automatically creates in the system folder when you first use 
MathWriter.

2 If no default files are present, the New command will not contain a submenu.
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The configuration includes your preferred combination of: the four floating 
windows, Template, Palettes, Tools, Font Table; and the name of the 
primary startup default file. The frequency with which you type math
ematical expressions will probably guide your choices.

♦  To establish your configuration preferences, use the Preferences... 
command in the File menu to record your choices.

The significance of some of these choices may not be apparent until you 
have completed Exercise 5, which describes MathWriter's  mathematical 
tools. Here is a brief description.

The four floating windows can remain active and on-screen in a convenient 
location while your document is active. Scrolling will be faster if your 
screen is large enough to avoid an overlap of the floating windows with 
the active document window. The Templates window provides mouse access 
to the auto-formatting mathematical constructs such as fractions, roots, etc. 
The Palettes window provides mouse access to the Greek alphabet and to 
your choice of symbols and variables duplicated from the Palettes menu. 
The Tools window provides mouse access to the three editors (text, math, 
and character) and to subscript and superscript commands. The Font Table 
window provides mouse "typing" for every character in every font 
available to the system, which is especially convenient for entering 
infrequently used special characters.

You can create a default file here or use the Save As... command discussed in 
step 3 of the previous section to create one. Then, select one of the default 
files as the startup file in Preferences... The name of the designated startup 
file appears at the top of the Preferences dialog box and is the file Math- 
Writer automatically opens when you next initiate a MathWriter session.

Create and designate a startup file now. If you prefer to revert to the 
original startup configuration, put the MathWriter Prefs file in the trash 
when you return to the Finder or MultiFinder. This causes MathWriter  to 
re-create the original Prefs file the next time the program is launched.

Palettes and Diac menus

The Palettes and Diacriticals menus are always available. Palettes 
provides mouse access to the characters of the Symbol font (except the 
Greek alphabet, which is available from the Palettes window), a few 
special characters, and the Variables. As you drag the cursor over the 
Palettes menu, the name of your current choice appears on the bottom row.

The Variables include the following: creation date, current date (which 
you can use in a default file to obtain the current date automatically), 
creation time, current time, page number and total number of pages (which 
can appear only in headers and footers), footnotes and cross-references to 
footnotes, equation numbers, subequation numbers, textual cross-reference to
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an equation, one set of user-defined variables analogous to equation 
numbering, and document file name. You can use these to dynamically 
number figures, tables, paragraphs, etc. The file name variable allows you 
to insert the name of the file into the text automatically so you can more 
easily maintain the correspondence between printed output and the 
MathWriter file used to print it.

MathWriter treats a dynamic variable as a single, uneditable entity 
whose format and style are set with Variables Format... on the Format 
menu. (The name of the user-defined variable and its starting number are 
also set using Variables Format....) MathWriter  automatically updates 
existing variables as you insert, delete, cut, and paste them. The print 
dialog box also provides an option to ensure that the date variables are 
current.

The Diac menu supplies mouse access to the diacritical marks when the 
insertion point is immediately to the right of some alphabetic character. 
The horizontal grouping symbols are available only when you have 
selected one or more characters. To edit within a horizontal grouping, press 
the option key to obtain the split I-beam cursor.

Floating windows

The properties common to MathWriter's floating windows are discussed 
here; refer to Exercise 5 for more detail.

1. Select each of the four windows (Templates, Palettes, Tools, and Font 
Table) from the Windows menu.

2. Place the cursor in the gray region adjacent to the close-box of each and 
move to a convenient location.

3. Explore each menu. Click on the I-beam in the Tools window to be sure 
that you are in text editing mode when you complete this.

4. Remove the floating windows by reselecting them in the Windows menu 
or clicking in their close-boxes.

Auto save

We recommend that you set the automatic file saving feature on Doc 
Preferences... of the File menu as insurance against file loss. The minor 
delay caused by Auto save can offset the inconvenience of retyping. The 
Auto backup command, also enabled on Doc Preferences..., preserves the 
immediate past copy of your document for even better protection.

We STRONGLY recommend that you use these protection features when 
composing original material at the keyboard.
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Summary

In this exercise you have learned to use input aids to:

• use online help

• change typeface characteristics

• transfer rulers and other formatting from one paragraph to another

• create reusable default or template files (stationery)

• configure MathWriter for your particular needs

• use the floating windows

• create and use user-defined style combinations

• enable the Auto save feature to protect your files.

Exercise 4: Graphics
M athW riter supports the mixing of graphics such as pictures and figures 
with text. It can also import mathematical expressions as graphics, but a 
far more powerful approach to writing mathematics is described in 
Exercise 5. In addition to handling traditional bitmapped and PICT file 
types such as those created by MacPaint® and MacDraw®, Ma th Writer 
can also handle encapsulated PostScript files such as those created by 
Adobe Illustrator® or Mathematica® (Figure 2.1). It reads these graphics 
files directly as well as by using the usual transfer via the Clipboard.

y = fix]

Figure 2.1 A Mathematica-created picture
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M athlNriter can resize, crop, and position these graphics. It treats a 
graphic as a tall character within a line of text. You can also apply various 
border designs and background patterns to sidebars.

1. To move a copy of the MathlNriter icon from the above line, select it 
using the I-beam cursor and copy it to the Clipboard using Copy on the Edit 
menu or 96 C. (You could also use the Scrapbook or another application to 
place the graphic on the Clipboard.)

2. Place the insertion point at the destination location, somewhere in the 
document.

3. Use Paste Picture from the Edit menu to transfer the picture into the 
active MathlNriter document.

4. Select the Character Editor by either clicking the arrow tool in the 
Tools window, selecting it from the Tools submenu of the Windows menu, or 
typing 96 shift [. The cursor will change into an arrow.

5. Click on the graphic to select it. A rectangular frame with square 
"handles" at the corners forms around the graphic.

6. To resize the selected graphic, use Scale Picture... in the Edit menu (now 
changed because the Character Editor tool was chosen) or drag one of the 
handles. To preserve the width-to-height ratio, press the option key 
while dragging a handle.

7. To crop the selected graphic, press 96 while dragging a handle. To crop 
all sides proportionally, press both option and 96 while dragging a handle.

8. To reposition the graphic vertically, select it, release the mouse button, 
and then drag it.

To adjust the vertical position of any text character use the Character 
Editor as described in step 8.

In this exercise you mixed graphics and text within a document, and you 
learned:

• To place graphics within a line of text.

• To resize and crop graphics.

M athlNriter allows you to import graphics directly from a file, including 
high resolution, encapsulated PostScript files.

Summary
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For a discussion of Math Writer's treatment of mathematical expressions, 
continue on to Exercise 5.

Exercise 5: Mathematics
In this exercise you learn to type two-dimensional mathematical 
expressions and to number equations automatically.

Part 1: Mathematical expression editor

Preparing to write mathematics

Before we examine math writing features, you need to configure the 
M athW riter environment for these activities. If the Templates, Palettes, 
and Tools floating windows are not visible, select them from the Windows 
menu and drag them to a convenient working location.

The Templates window behaves as if it were a vertical menu bar; press on a 
template category and drag to select a specific template. Alternatively, 
you may type command (96 ) and the row number followed by the column 
number of a specific template. For example, 98 2 and 1 selects the square 
root. If you pause before typing the column number, the selection menu pops 
out to prompt you. Typing other than one of the valid numerals aborts the 
command.

Exercises

Use the following instructions to explore the auto-formatting templates 
that were used to create the equation that follows step 3. Use the space 
that follows the equation as a place to experiment. 1 2 3

1. Select the root template by mouse (from the Templates pop-out menu) or 
by keyboard (981 and 1) from the Templates window. The insertion point is 
positioned to receive the argument.

2. Type "(1 + sin x)". The root symbol expands automatically.

3. Press enter (not return) to exit the root.

Create V (1 + sin x) .

Type here:



If you make a mistake or wish to modify the expression, press option to 
obtain the split I-beam cursor X to edit within the auto-formatting 
structure and click within the expression. You could also select the split I- 
beam from the Tools window or Tools submenu (Windows menu).

Suppose you wanted to square the sine term. Edit the expression below.

Edit this a/(1 + sin -*) to obtain this ] / (l + sin2 jr)

Edit this expression. y d  + s>n x)

4. Option click within the mathematical expression immediately after 
"sin." This positions the insertion point in the square root structure.

5. Press 36 ] or click on the arrow | /* | in the Tools window (Windows menu) 
pointing diagonally upwards (just below the I-beam tool) to create a 
superscript. This changes the vertical position of the insertion point and 
decreases the font size.

6. Type the exponent and press enter (not return).

7. Press enter to terminate the superscript entry.

Because this superscript structure is nested within the square root structure, 
you must press enter again to reach the baseline and recover the I-beam 
cursor of the Text Editor. Alternatively, you could press return at any point 
to reach the baseline immediately. This use of nested operations illustrates 
the general procedure for constructing a mathematical expression of 
arbitrary complexity.

Suppose you wish to attach a superscript to a superscript as in the next 
equation.

y =

1. Position the insertion point after the equals sign.

2. Type "e".

3. Press 36 ] or click [a]  and type "x”.

4. Press 36 ] again and type "2".

Observe that the leftmost display in the document status bar uses two up 
arrows 1T to indicate that the insertion point is two levels removed from 
the baseline.
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5. Observe the status bar as you press enter twice.

How would you type a subscript to a superscript, as in the next equation?

1. Click to the right of the equals sign and add a space.

2. Type "e".

3. Press 96 ] and type "x".

4. Press 96 ] again and type "2".

5. Press enter once to return to the level of the “x".
(Now there is only one up arrow in the status bar.)

6. Press 96 apostrophe or click on the arrow pointing downward £7] in the 
Tools window for a subscript.

7. Type 1 and press enter to return to the superscript level.

8. Press enter again to return to the baseline.

M athW riter reformats the expression after each keystroke so you need not 
count spaces before typing even the most complicated expression. Nesting to 
any depth is supported.

Remember to option click to place the insertion point within the expression.

Suppose you wish to type the error function that appears frequently in 
probability theory and heat conduction problems:

In each example, position the insertion point without reminder.

1. To create a fraction, choose the first fraction template (96 1 followed by 2 
for the first template row and the second template column, or use the 
mouse). The second fraction template automatically reduces the font size.

2. Type "2" for the numerator and press enter to move to the denominator.

Always supply the numerator before the denominator. By using nesting, you 
can create numerators and denominators of arbitrary complexity.

y l = e

yi =

erf (x) =



3. Select the square root symbol (Si 2 and 1).

4. Click on k in the Palettes window.

Use the mouse to select "n" from the Palettes window or type Si spacebar to 
toggle to the Greek alphabet, now noted in the status bar; type p to get pi; 
and then type Si spacebar to toggle back to the previous font. The Greek 
alphabet is taken from the Symbol font; the characters have a mnemonic 
arrangement, "a" for a, "b" for p, etc. But if you cannot locate a character, 
use the Key Caps desk accessory or the Font Table window.

5. Press enter once to leave the root template and a second time to reach the 
baseline. To avoid your having to scroll, the equation is repeated here.

erf (jc) =
2

y /n

erf (x) =
2

y /n

1. Select the single integral template with the mouse or type Si 5 and 1.

2. Type "0", the lower limit of integration. (It could be any arbitrary 
expression.)

3. Press enter to move to the upper limit of integration and type “x".

4. Press enter to return to the baseline.

Use option click if you need to edit either limit.

5. Complete the integrand as in the previous example.

Close this file and open the file "Exercise 5b" to continue.

Here is another practice example.

4 Vn
V =

1
n

n = 0
(2/h-I)

9 9 , 9 (2n+ l )  n x
exp [-K(2n+l)27t2f / L 2] sin ------j------- [1]

As with the previous integral example, use enter to move from the lower to 
the upper limit. The down-scaled infinity symbol is an idiosyncrasy of the 
Symbol font; use option click to select it with the split I-beam and increase 
its font size with §§ + or Text Size on the Style menu.
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Try the next example with the special functions that have an argument 
centered below them. Use 98 7 or click on / in the Templates floating window 
to access the limit template. Get the from the Palettes menu.

1 -  cos x sin x cos x
lim ------ ----- = hrn ——  = lim —

x  —» 0 jr —> 0 >0 2

1
2 [2]

The Cut and Paste operations on the Edit menu apply to mathematical 
expressions, even when you use the Math Editor cursor. In this way you can 
frequently avoid retyping built-up expressions such as ^m()-

M athW riter automatically groups rows of expressions with a stretchable 
symbol as in the following exercise. Use the Palettes menu (or 98 8 and 1) 
and the Greek alphabet on the Palettes window (Windows menu) for the 
special symbols. Use return to create a new row.

y= M J -X, JC > 0
\  -x , x < 0

[3]

If you are using the Apple, rather than the Adobe, version of the Symbol 
screen font, the large brace in the above expression will be truncated, but it 
will print correctly in LaserWriter output. (Use Calc Prev j  or I Size or 98 D 
to size the absolute value symbol from the Palettes menu to fit an 
expression; use the Character Editor to stretch it to an arbitrary size.)

M athW riter automatically formats matrices and other two-dimensional 
arrays. In order to create self-sizing parentheses for a tall fraction:

1. Pull down the Style menu to Auto Math Options... and release the mouse. 
A pop-out menu appears.

2. Click on Auto-bracket sizing if it is not checked and click OK. (This 
includes the auto-sizing feature in the set to be enabled in step 3.) 3

3. Now click on Auto Math in the Style menu (or press 98 E). This activates 
those items you have checked in the Auto Math Options window.



In general, activate Auto Math only while you are typing an equation and 
then toggle this feature off with SS E to reduce the computational load.

[D] =
(

\

\

y

[4]

Type here-»[D] =

4. To complete equation [4], type an ordinary left parenthesis, select the 
fraction template (M 1 and 2), supply the numerator, press enter, type the 
denominator, press enter, and then type a right parenthesis.

5. Complete the expression below by adding the matrix.

[D] =
(

\

\
1 0

n 1 0

0 0 1 — n
2

[5]

[D] =
/

\

\

6. To construct an array of any number of rows and columns just select the 
appropriate construct from the Templates window, in this case vectors and 
matrices (the next to last row on the Templates window), and create the 
elements. The first element corresponds to row one, column one.

7. Press tab to move to the next column (or to create the next column) in the 
same row.

8. Press return to move to the next row (or to create the next row) in the 
same column.

9. To move into an existing cell, use option click with the mouse or 3€ shift 
with the arrow keys.

M athW riter reformats the array as you type. Use Matrix Format... in the 
Format menu to set placement, line type, justification, and spacing of cells.
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Pull down the Format menu to Matrix Format and release the mouse to view 
the formatting possibilities.

Any changes made in the Matrix Format when a matrix is selected apply to 
that matrix only; any changes made when no matrix is selected apply to all 
future matrix input.

As a final exercise, reproduce the following table.

a\\ 123.456 X io (l/ / 2)

y
/ \+x

\l 1-x2 Text

1. Use & 0 and 2 to activate the table template. Create rows and columns 
just as in the matrix example. Use "0" to access row "10".

The cells of a table can contain numbers, text, graphics, or mathematical 
expressions. Use Matrix Format... in the Format menu to change the 
defaults. When the insertion point is within a cell, you can insert or delete 
a row or column using Insert and Delete on the Edit menu.

Remember, option click to edit within a cell. The status bar indicates the 
row and column of the insertion point.

Part 2: Technical support

In addition to the need for writing equations, technical writing places 
other special demands on a word processor. The increased complexity of 
input due to the enlarged set of fonts and symbols, font sizes, and font styles 
was discussed in Exercise 3. Now we will explain another feature of special 
importance.



Numbering equations and cross-referencing them in the text is an important 
feature for writing math. Suppose you decide to assign a number to the first 
equation shown below. Each equation number would then increase by one. 
Without Math Writer's automatic numbering, you would have to find and 
increase all succeeding equation numbers and all cross-references to them in 
the text and elsewhere. M athW riter handles this task automatically. 
Even if you use cut and paste operations to edit your manuscript, 
MathWriter updates the numbering and linkages correctly. This assumes, of 
course, that you move both an equation and its associated number together.

Warning: If you remove an equation number that is linked to a cross- 
reference variable, the cross-reference number is no longer meaningful and is 
changed to a "?".

Observe that /(z) is analytic for all values of z such that 1 < Izl <3. We 
may find the a n’s of [6] by using the following device. [Pennisi, et al., 
Elements of Complex Variables]

To add the equation number to the first equation, follow these steps:

1. Drag a right tab 4 near the right margin.

2. Place the insertion point immediately to the right of the first equation, 
verify that you placed a tab near the right margin, and inspect the ruler. If 
necessary, add a right tab.

We centered the equation at the ruler position by a center tab. To avoid a 
contradiction, NEVER use centered paragraph alignment and a tab to 
number equations. 3

3. Press tab to position the insertion point at the right margin, and select 
equation number [s»| from the last row of the Palettes menu. (As you drag 
the cursor over each icon its name appears on the bottom row of the menu.)

/(z) = I , “  _  a„(z -  z0f ,  if < I z -  Zq I < r2

where [6]

and the integral along C is taken in the positive direction.

Find the Laurent series expansion, in powers of z, for the function
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When you release the mouse button, Math Writer automatically calculates 
and assigns the equation number.

The new equation becomes number [6], the original equation [6] becomes 
equation 17], and M athW riter updates the cross-reference to the original 
equation in the last paragraph of text, too.

The program handles subequation numbering in an analogous manner. It 
numbers multiple parts of any equation, but you have to identify the linked 
variable by number, by relative number, or by pointing.

With Variables Format... in the Format menu you can assign such things as 
the variable style, format, and style of enclosing brackets for equation 
numbers.

M athW riter automatically updates all variables of this type throughout 
the document if you change any of the choices in Variables Format... (For
mat menu). You cannot edit these variables placed within the document as 
you would other character strings; you can only make changes using Varia
bles Format....

♦  Select Show Invisibles from the Format menu to locate the dynamic 
variables identified by dotted boxes and Hide Invisibles to conceal them.

Automatic numbering of other entities such as figures, tables, theorems, 
paragraphs, etc., is also possible. In addition, you can define sets of dyna
mic variables for other items and MathWriter will automatically track 
them.

To create a "figures" user-defined category, follow these steps:

1. Select Variables Format... in the Format menu, and click Rename.

2. Assign a variable name, e.g., Fig., and select it in the scrolling window.

3. Select a numbering scheme; decide on enclosing brackets, if any; assign a 
starting number and category label (e.g., "Fig. " including the trailing 
space). Click OK. MathWriter adds this name to the icon.

4. Drag the mouse over the user-defined category on the Palettes menu to 
verify that the program has assigned the new name.

5. Select and adjust the parameters for the subfigure and figure reference 
variables.

This completes the guided tour. Close this file and begin experimenting or 
read Chapters 3 and 4.
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7\J Nontechnical Writing

Online Help
M athW riter offers more than fifty online Help screens. To use this resource 
you must have placed the M athW riter Help file in the System folder of 
your Macintosh or in the folder containing M athW riter before activating 
Math Writer. If disk space is too limited or if you are an experienced Math- 
Writer user, you may forego the convenience of online help. To access 
MathWriter's Help screen, follow these steps:

1. Type $$ ? (in other words, while depressing the command key type a 
question mark)1 or select Windows/Help2 to open the scrolling index (see 
Figure 3.1). The Help window has a fixed size, but you can reposition it on 
the screen by dragging its title bar.

Help

Rulers/Tab
Screen Display 

Key Commands 
Moving Around 
Scrolling
Speed Enhancements 
Status Bar 

Search 
Find /Replace 

Shortcuts/Keyboard 
Cmds/1-4 
Keyboard/1 -4 

Sidebars 
Styles 

Styles Menu 
Typefaces
User styles___________ o

Select help by double-clicking 
in a topic, or click in Help for 
the currently selected topic.

Figure 3.1 Help index

1 Ignore space separators in commands. See the end of Chapter 1 for a summary of conventions.
2 This notation means select the Help command in the Windows menu.
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2. Scroll to locate the relevant topic.

3. Double-click on a topic in the list or click on the topic and then click the 
Help button.

Rulers/Tabs ( « ) ( » ]  |( Topics

Rulers & Tabs (The paragraph is the basic unit of a document.)
•  Use r e tu rn  to delim it and to create a paragraph. Wordwrap is  automatic.
•  Use cm<f re tu rn  to force a new line w ith in  a paragraph.
•  Use S P e v S tfid e  P u / e r (Format) to display the paragraph ru le r at top of the active 
wi ndow and display the tab w ells and alignment controls at right of the wi ndow. R u le r  
O p tio n s ( Format) sets the measurement unit and origi n of the ru le r . Shadi ng on the 
ru le r shows the bounds of the work area (m arg ins, columns) set w ith Pope La you t 
( F i le ) .  The Ruler displays the tab and margin settings of the paragraph which contains 
the blinking insertion point. To add a tab, drag one from the tab well to the ru le r . For 
fin e r position control, option-drag. To remove a tab, drag it  back to the tab w ell.

Left and right paragraph margi ns. ± Paragraph fi rst l i  ne i ndent/outdent.
Option-drag the left margin tab to decouple it  from the f i r s t  line tab setting.
•  User-defined tabs:► Left a lign< Right align ♦ Center 0  Character align (decimal default)
•  To change Tab type. Tab alignment character, or to assign a Tab leader, double-click on 
an existing tab. To set uniform ly spaced tabs, d b l.-c lick  on the ru le r to assign the spacing.

Figure 3.2 Rulers and Tabs help screen

Figure 3.2 displays the relevant Help message (Rulers & Tabs subheading 
under Paragraph). The Help button becomes the Topics button while 
messages are displayed and provides a return link to the Help index. Two 
adjacent buttons « and » appear and provide scrolling forward and 
backward through the various screens related to this topic. In this case, 
there is only one relevant screen, so when you click on Topics, you will return 
immediately to the list of Help topics.

Either select another topic, drag the Help window aside, or click the close- 
box at the top-left corner of the Help window to remove it.

Producing a Nontechnical Document
M athW riter provides you with more than technical writing capabilities. 
It is a word processor that enables you to capture your ideas with words or 
symbols, supplies formatting that enhances the reader's comprehension, 
allows you to correct errors and rearrange wording to improve precision of 
expression, preserves a computer-readable copy for use in future sessions, 
and produces a printed copy of your document. In short, it allows you to 
produce a printed document efficiently.
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Entering text

In the previous chapter you learned to install M athW riter. If necessary, 
repeat that process now and double-click the M athW riter icon to activate 
the application. In this chapter we will discuss the techniques you will 
need to create a nontechnical document; the more specialized techniques 
associated with technical writing will be discussed in the following 
chapter.

O

VI

n

i

C
u

11
M

m u
_______ 5 / R . 5 ___________
■ I ■ i ■ I4- ' ■ I ■ ' ■ 15. i . I . i . 167 m i

T £gelY ~ H

IE0| 
<► 
♦
o

c s

♦  Steps in producing a nontechnical document

Basically, your woid processor should enable you to capture your ideas with 
jwords or symbols, supply formatting to facilitate the readers comprehension, 
allow you to correct errors and rearrange the wording to improve precision of 
expression, preserve a computer-readable copy for use in future sessions, and 
produce a printed copy of your document. In short, the basic purpose is to 
ieffic iently produce a printed d oc ument. Let's look at the steps to p erform these 
itasks.

□

Figure 3.3 Document window with text
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Figure 3.3 displays a document window with text. If you are not familiar 
with the basics of the Macintosh human interfaces, refer to the tutorial 
materials supplied with your Macintosh. If you only need a simple 
refresher, refer to appendix 1 of this manual for a quick review.

Opening a document

There are three ways you can open a Math Writer document:

• Use the document window and the one-page, blank workspace Math- 
Writer presents at startup, unless you have customized it to present a de
fault or template document using Preferences (on the File menu).

• Select a submenu of the New command (on File menu) to obtain a copy of a 
document template you created previously.



32 Chapter 3

• Open an existing document using File/Open... (98 O).

Math Writer's screen display of a document closely resembles the document 
you eventually print. This important, productivity-enhancing attribute is 
widely known as "What you see is what you get" or WYSIWYG 
(pronounced"whizzy-wig"). The closer the correspondence, the easier you 
can produce the desired printed document. Many of Math Writer's features 
help you visualize the end results as if you were working with a sheet of 
paper.

Creating text

If you have a Macintosh with a small screen, only a portion of the 
document page will be visible at one time. The blinking vertical bar (|), 
known as the insertion point, identifies your position within the document. 
Characters you type appear at the location of the insertion point, and the 
insertion point advances as you type.

Unlike a traditional typewriter, a word processor supplies extensive 
formatting support. For example, when your line of typed text reaches the 
right margin, any whole word that does not fit on the line moves to the next 
line. This is called "wordwrap."

Do not press return until you reach the end of the paragraph. If you must 
force a new line within a paragraph, use shift return.

When you fill a page, M athW riter automatically creates and numbers a 
second page. The vertical scroll box hjfj always displays the number of the

page currently visible at the top of the document window, even if a portion 
of the next page is also visible on the screen.

M athW riter uses a few normally invisible characters to control screen 
formatting. Use the command Format/Show Invisibles to display the end- 
of-paragraph marker *11; other invisible characters include space (shown by 
a dot below the line), tab+ , line break ♦>, column break Si, and page break
O. Page numbering variables in the header or footer are displayed within a 
dotted box when invisible characters are showing. To make all these 
characters invisible again, use the same menu command, which now reads 
Hide Invisibles.

Document organization

The basic elements of a document are paragraphs, sentences, words, 
characters. We organized M athW riter with that in mind. The paragraph 
is the basic organizing unit of a document. As mentioned above, you use the 
return key to delimit paragraphs. Said differently, a paragraph is the 
material enclosed by pairs of invisible paragraph markers.
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Navigating within a document

Because typed text appears in the document at the insertion point, you must 
be able to position the insertion point at different places in a document. And 
because the document is usually larger than M athW riter can display on the 
screen at once, you must be able to select parts for viewing and modification. 
Mouse and keyboard controls are available for navigating.

You can position the insertion point anywhere within existing text. In order 
for M athW riter to format a document automatically, text fragments cannot 
be allowed to dangle arbitrarily within the document, and that would be 
the case if the insertion point could be positioned without any relation to 
existing text. Consequently, you can add text within or on the boundaries of 
existing text. Use Format/Show Invisibles and Show Layout to view these 
boundaries.

Mouse navigation The gray scroll bars are the primary, mouse-controlled 
tools for bringing other portions of the document into view. Separate scroll 
bars control horizontal and vertical motion.

The white scroll boxes indicate the relative location of the current view of 
the document in its scroll range. The vertical scroll box displays the page 
number of the page in view at the top of the active document window.

There are a number of ways to scroll using the mouse.

• To scroll in discrete steps of approximately eight lines, click the cursor in 
one of the arrows at either end of the scroll bar. Because mathematical 
expressions are frequently taller than ordinary lines of text and because 
larger screens are more common now, larger movements are made easier by 
this convention. To scroll a smaller amount (approximately one line), press 
the option key while clicking the scroll arrow.

• To scroll one windowful, click in the scroll bar above or below the scroll 
box. The actual scroll distance depends upon the current size of the active 
document window.

• To scroll an arbitrary amount (especially useful for long documents), drag 
the scroll box with the mouse. You can scroll directly to a specific page in a 
single try because the scroll box immediately reports the destination page 
number even before you release the mouse button. The number in the scroll 
box corresponds to the page that is visible at the top of the document 
window. •

• To scroll to a header, footer, footnote, or back 
to the previous location of the insertion point 
within the body of the text, use the pop-up menu 
associated with the insertion point position HYLISlifiGUffi 
locator in the status bar. To practice using the insertion point pop-up menu:

©  Body 
OHeader 
C l Footer

Every page 
Every page



1. Select a region, such as the Header, from the pop-up menu. M athW riter 
automatically scrolls that region into view for editing.

2. Select Body from the pop-up menu to scroll to the original location of the 
insertion point.

The scrolling options listed above provide the control you normally require 
for editing a document. However, additional choices, described below, 
make M athW riter a convenient substitute for a slide projector for 
presentations.

• To scroll the page boundary separator of the next or the previous page to 
the top of the document window, 96 click in the scroll bar below or above the 
scroll box, respectively.

• To scroll the header of the next or previous page to the top of the 
document window, option click in the scroll bar below or above the scroll 
box, respectively.

• To scroll the text body of the next or previous page to the top of the 
document window, 96 option click in the scroll bar below or above the scroll 
box, respectively.

If you group your material into screen segments (for the presentation screen 
size) each segment can be sequentially positioned at the top of the screen. 
M athW riter allows you to easily and quickly scroll through your presenta
tion. For very rapid scroll speeds, scroll through your document before your 
presentation to allow M athW riter to build lookup tables, or save the file 
with the "Compact file" option disabled using File/Doc Preferences.

When you scroll, the position of the insertion point relative to the text does 
not change. To quickly scroll back to the location of the insertion point, 
either type a character or use the mouse to perform the menu command 
Edit/Show Selection. To reposition the insertion point, just click the I-beam 
point at the desired location, possibly after scrolling. As discussed later, 
when you are selecting text and drag past the top or bottom of the window, 
the screen scrolls automatically.

If you must work with documents wider than the screen (or window), such as 
a landscape orientation view (see File/Page Layout/Page Setup), then you 
can use the horizontal scroll bar to view a hidden portion of the document. 
M athW riter supports automatic left and right scrolling to keep the inser
tion point in view. Most operations in MathWriter can be performed using 
either the mouse or the keyboard. Consider now the keyboard alternatives 
for navigating.

Keyboard navigation The arrow keys (<—, T ,l) move the insertion point
around within text and mathematical expressions.



Nontechnical Writing 35

• The arrow keys move the insertion point one character to the left or right 
or one line up or down. As with the other keys, keeping an arrow key 
depressed causes it to repeat at a rate set in the Apple/Control Panel. If 
necessary, M athW riter automatically scrolls the screen horizontally or 
vertically to keep the insertion point in view. Because M athW riter 
supports variable character widths, vertical scrolling does not move in a 
straight line, but along a path that maintains a constant character count 
(reported in the status bar) from the left margin in the paragraph in which 
the movement begins. The insertion point then moves to the left margin in 
succeeding paragraphs. Repeated use of the right arrow moves the insertion 
point through the text along the path used when reading. The left arrow 
does the opposite.

• Using the option key simultaneously with an arrow key, magnifies the 
movement of the insertion point. Option left arrow or right arrow moves the 
insertion point immediately to the left or the right end of the current line, 
respectively. Option up arrow or down arrow initially moves the cursor to 
the top or bottom of the active window and if pressed again (or if held 
down) the insertion point scrolls to the top or bottom, respectively, of the 
document.

• Using 96 simultaneously with the up or down arrow scrolls the window a 
large amount (approx. 8 lines).

• Using 96 and option simultaneously with the up or down arrow scrolls the 
window a small amount (approx. 1 line).

To make these key combinations easier to remember, note that in general:
• pressing 96 changes the meaning,
• pressing option  modifies the scale, and
• pressing sh ift  extends the range.

Selecting text
In general, you must explicitly identify the object of a command by selecting 
it before you give a command. Selected text is displayed with the black and 
white colors reversed. Rather than black text on a white background, 
selected text is displayed as white letters on a black background. We also 
refer to this as "highlighted text."

Colors can be used for this purpose if you have a color display, but the use of 
color slows the program considerably. For this reason we recommend using 
the Apple/Control Panel/Monitor to disable color output.

You can use either the mouse or the keyboard to make selections. Using the 
mouse, you have the following options: •

• To select a word, click twice at the same position within the word.



When a word is selected by double-clicking (rather than by dragging, for 
example), a space character immediately preceding the word is 
automatically added to the selection if you then use Edit/Cut.

• To select a line of text, click three times at the same position within the 
line.

• To select a paragraph, click four times at the same position within the 
paragraph.

• To select the entire document, use Edit/Select All.

• To undo a selection, single-click anywhere in the document.

To select an arbitrary contiguous string of characters, drag the cursor over 
the text.

1. Position the cursor in the text at either the beginning or end of the 
substring you wish to select.

2. Drag (press and hold the mouse button down while you move the mouse) 
to the other end of the substring and release the mouse button.

If you drag past the top or bottom of the window, the document 
automatically scrolls to make the additional selected text visible. Observe 
that the highlighted text continually changes as you drag the mouse but 
always includes the text substring between the insertion point and the 
current cursor position.

For somewhat longer selections you may prefer to use the shift click 
method.

1. Position the insertion point by clicking the cursor in the text at the 
beginning or end of a substring you wish to select.

2. Scroll to the other end of the text string and press the sh ift  key as you 
click the mouse. (Shift serves as an extender.)

To select text using the keyboard, follow these steps:

1. Using the arrow keys, position the insertion point within, not 
necessarily at one end of, the substring you wish to select. Recall that using 
the option key in combination with the arrow keys produces larger insertion 
point movements—at the beginning or end of a line, top or bottom of the 
window, and top or bottom of the document.

2. To complete the selection process, press sh ift  and use the arrow keys to 
"grow" the selection about the insertion point.

Using option with shift arrow changes the scale. Option shift with a left 
or right arrow selects the current line to the left or to the right of the
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insertion point. So if the insertion point is not at the left or right end of the 
line, use both commands to select the entire line. Option shift with up or 
down arrows selects from the insertion point to the top or bottom of the 
window, respectively. Use the same option shift arrow command twice to 
select from the insertion point to the top or bottom of the document.

Basic editing

Simple editing techniques for adding, deleting, moving, and copying text 
are useful when creating a document.

• To add text you simply position the insertion point where you want to 
add text and type.

• To overwrite text, first select or highlight the text and then type the 
replacement text.

• To delete a character, position the insertion point to the immediate right 
of the character and press delete. Repeatedly press delete or hold it down 
to remove additional characters to the left.

• To delete large selections, select or highlight the text and press delete 
once. Alternatively, use Edit/Cut (96 X) or Edit/Clear to remove the 
highlighted selection.

The Cut command makes a temporary copy of the selection on the 
Clipboard for subsequent "pasting" into the document when the insertion 
point is at another location. The Clear command does not save a copy on the 
Clipboard, but Edit/Undo restores the removed text if used as your next 
command. Clear is especially useful when you are deleting a large selection 
because no Clipboard copy is made.

• To move text from one location in the document to another using the mouse 
or keyboard:

1. Select the text.

2. Copy the text to the Clipboard using Edit/Cut or 96 X.

3. Position the insertion point at the intended destination.

4. Paste the Clipboard contents into the text using Edit/Paste Text or 96 V.

• To duplicate, rather than remove, text from one place to use elsewhere, 
use the procedure described above replacing Edit/Cut (or 96X) with Edit / 
Copy or 96 C.

The command keyboard equivalents appear on the pull-down menus as 
reminders. By convention and for clarity, uppercase letters are shown; 
however, you must use the lowercase letter to execute the command.
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During text entry you may need a few additional, basic editing commands:

• Undo The Edit/Undo (or Si Z) command allows you to undo the effects of 
the immediately preceding command in most cases. A few global commands 
such as Replace All, of Edit/Find/ Replace, cannot be undone with this 
command. If you must use Replace All, save a protective backup copy of the 
document just before you use it, perhaps using File/Save A Copy.

• Invisibles The Format/Show Invisibles command allows you to display 
the otherwise invisible formatting characters in the text. Although you 
need not see a marker to delete a formatting character, seeing them allows 
you to locate them more easily. To hide these markers, use Format/Hide 
Invisibles, as this command is now named.

• Delete Recall that a new paragraph is created when you press return. 
Therefore, to join two paragraphs, remove the separating paragraph 
marker. Do this by placing the insertion point at the beginning of the 
second paragraph, not at the end of the first, and press delete.

Similarly, if you manually create a new page using Format/Insert Page 
Break and later wish to remove that marker, place the insertion point at 
the beginning of the second page (NOT at the end of the first page) and 
press delete. This same pattern applies to column breaks, tabs, etc.

Note that enter and return have distinct purposes in M athW riter. As you 
will see later, the enter key plays a role in creating mathematical 
expressions analogous to return in creating paragraphs in ordinary text.

Space between paragraphs Although you can add space between 
paragraphs by pressing return to create empty paragraphs, we recommend 
that you use Format/Paragraph Format to assign extra spacing before or 
after paragraphs. Just as the first line indent of a paragraph eliminates a 
tab key command, this command eliminates one or more return keys. In 
addition, you can quickly change the spacing between paragraphs in pixel 
increments at any time using Edit/Select All and Format/Paragraph 
Format. Also, this prevents the paragraph count in File/Doc Info from being 
inflated.

Numerous input techniques—the Palettes menu, the Windows menu 
(Palettes Window, the Font Table, and Library)—will be discussed in the 
next chapter.

Formatting
M athW riter provides users with an especially rich set of formatting 
capabilities. A rather modest and quickly learned subset of these should be 
sufficient for nontechnical writing. Depending upon personal preference, you 
can apply formatting to the text as you enter it or apply the formatting 
later. If you are a speed typist or are opening an unformatted text file, you
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Document formatting

might supply formatting after you finish entering the text. In most cases, 
however, you should anticipate the general design of your document and 
make tentative choices before entering the text. Otherwise, changes at the 
document level, such as margins, affect formatting at the paragraph level, 
such as line length. The side effects of the changes become more bothersome 
when advanced structures, such as mathematical expressions and sidebars, 
are involved.

Document formatting has three levels: global formatting, which applies to 
the entire document (page size, page orientation, margins, columns, 
headers, footers, footnote placement, etc.), which you set using the File 
menu; paragraph specific formatting (tab settings, alignment, line spacing, 
borders, etc.), which you set using the Format menu; and character 
formatting (font, size, style, etc.), which you set using the Style menu. The 
design process normally proceeds from the general to the specific. This is 
also reflected in the left-to-right ordering of MathWriter menus.

To format a simple document you need consider only the choice of printer, 
which you assign using Apple/Chooser, and two commands on the File 
menu—Page Layout and Doc Layout.

Chooser Although you can route any existing document to an ImageWriter, 
to a LaserWriter, or to an even higher resolution device, some differences 
besides printer resolution do exist. The usually subtle differences between 
screen display and printer output might affect your choices in order to get 
optimal output. For example, if you intend to use a LaserWriter, you 
probably will elect to use LaserWriter fonts throughout your document. In 
M athW riter's Text Font menu the names of built-in laser fonts are 
underlined. Because font dimensions vary among font families of the same 
font size, substituting fonts automatically when you print can lead to 
undesirable spacing.

Page Layout To set up the Page Layout for your documents:

1. Click on File/Page Layout to examine the choices (see Figure 3.4).

2. Click the Page Setup button (Figure 3.4) first because your choice of 
paper size and orientation will affect your other page layout choices such 
as margins (see Figures 3.5 and 3.6). Paper size choices are listed in Table 
3.1.
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Page Layout... Columns (D I O  2 O  3 O  4

[Max] [ Std ]

Margins:
left

right

top

bottom

Header height: 

Footer height:

□  Gutter 

£*3 Facing pages

Page Setup...

0.750 in

1.250 in

1.250 in

1.555 in

0.402 in

0.000 in

0.305 in
Page width: 6 .50 in. Page height: 8 .19 in.

Cancel |l— gg— 1|

Figure 3.4 Page Layout dialog box

LaserWriter Page Setup 5.2 If nk- '||
Paper: (•) US Lette 

O U S Lega

Reduce or 
Enlarge:

Orientatio

■  i s

O R 5  le tter  [C an ce l]

Hffil ::7 Printer Effects: [Options
------  U  torn substitution?
1 E T e x t  Smoothing? — —. 

El Graphics Smoothing?
^  Faster Bitmap Printing?

Figure 3.5 Page setup window for LaserWriter

If you must switch printer types to print a document, remember that even if 
you make no changes, you need to open the Page Setup dialog box and click 
on OK. This causes M athW riter to implement any necessary formatting 
changes. Proofread your document to verify that no unanticipated changes 
have been made by MathWriter.
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Portrait, the default page orientation, is taller than it is wide. The 
landscape orientation is a portrait-size page rotated 90° producing pages 
that are wider than they are tall. Size reductions, the various printer 
effects, and options are examined in detail in the discussion of printing 
later in this chapter.

ImageWriter V 2 .7  |( OK ]|
Paper (•) US Letter O 04 Letter

O US Legal O International Fanfold f cancel
O Computer Paper l

Orientation Special Effects: □  Tall Adjusted
IjgBI □  50 % ReductionBrail

L a □  No Gaps Between Pages

Figure 3.6 ImageWriter page setup window

Table 3.1 Paper sizes
Paper Width, in. Height, in.

US Letter 8.5 11.0

US Legal 8.5 14.0

A4 Letter 8.25 11.7

B5 Letter 6.9 10.8

Tabloid 11.0 17.0

Computer Paper 14.0 11.0

International Fanfold 8.25 12.0

3. After making your page layout choices, click OK to return to the Page 
Layout dialog box.

4. If you require the largest possible print area, click on Max.

5. If you require more standard margins, click on Std and adjust the default 
margin sizes as necessary. The outer rectangle on the right half of the 
dialog box represents the physical boundaries of the paper. The enclosed 
rectangle including shaded portions corresponds to the printable area. The 
margin sizes are measured from the physical boundaries of the paper, 
rather than from the print boundaries. This accounts for the existence of a 
set of minimum acceptable values. Out-of-range values are rejected and a 
"?" is posted just outside the box. You cannot proceed until you supply an



allowable value. The default units, inches, in, centimeters, cm, and points, 
pt, match the current ruler units discussed below, but you can use any 
combination of compatible units and values. The dimensions of the usable 
print area appear below the miniature portrait of the page.

6. If you wish to reserve any additional space for a binding margin, check 
the Gutter box and supply a measurement (value and unit). With the Gutter 
box checked, the distance from the page boundary to the print area is the 
sum of the values for the gutter and the adjacent margin.

7. If you wish to have the gutter appear on the left of odd-numbered pages 
and on the right of even-numbered pages, check the Facing pages box.

When you use facing pages, the odd-numbered pages are on the right and 
the even-numbered are on the left.
The Print dialog box also provides for printing on the front and back of 
pages. 8 9

8. Optionally, adjust the size of the headers and the footers. Headers and 
footers are the reserved portions of the printable area at the top and 
bottom of the page, respectively. As discussed below, the contents of these 
can appear on every page throughout the document, differ from a standard 
on the first and/or last pages, or differ on left and right pages. If you wish 
to remove a header or footer, set its size to zero; as you do with margins, 
specify a value and its units. The header and footer sizes are constant 
throughout the document. These spaces are frequently used for posting page 
numbers, creation date, print date, creation time, print time, file name, 
letterheads, and other identifying notations. After you leave this dialog 
box and after you make the choices on the distribution of the headers and 
footers throughout the document, you can place text, graphics, 
mathematical expressions, or the variables just mentioned in the headers or 
footers.

9. Click OK to accept any changes you have made. Otherwise, click on 
Cancel to retain the values that existed when you opened this dialog box.

Doc Layout Consider next the placement of headers, footers, and footnotes 
among the pages of the document. The document layout dialog box 
(Figure 3.7) presents the choices visually.



Nontechnical Writing 43

Layout of headers, footers, and footnote/endnotes...

Same for all pages
Every page

3TtVT3T

7 T L ___b 4 _ _ _ — 4GG

r— - r —
Skip f irs t  page

r-~—
Left/Right pages

Skip last page 

Skip f irs t  & last pages

_ r\/i _ TTbAZZ
irn: “ 1ZIII

ill i
ll

B
| 4_._

I
I

i|
l

lii
iii

!]

F irs t  page different

— b A b A

Footnotes
t 2 i 4

Endnotes
--- bA LA

T~2

space before space between

■ H =  E l S 2 Cancel G O
Figure 3.7 Document Layout dialog box

1. In the first column, click on an icon either to place the header on every 
page, to skip the first page, to skip the last page, or to skip the first and 
last pages.

2. In the second column, make a similar designation for footers.

3. In the third column, make two choices. Click to select left-right facing 
pages or same on all pages and then click “First page different" off/on. 
After you return to the document window, the pop-up window associated 
with the insertion point locator in the status bar provides rapid scrolling to 
the headers and footers. You can place parenthetical materials in 
automatically numbered footnotes located either at the end of the 
document or at the bottom of the page that contains the reference to the 
footnote. Space for the footnote is automatically liberated from the space 
normally allocated to text in the main body of the page. You can make four 
choices relative to footnotes:

• At the bottom left corner of the dialog box, click to select placement at the 
bottom of the page or at the end of the document.

• At the right, choose one of the three icons (no line, dotted line, or solid 
line) for the separation of the footnotes from the body of the text.

• Set the spacing before footnotes (in pixels) using the scroll bar.
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• Set the spacing between footnotes using the scroll bar.

4. Click OK to accept any changes you have made. Otherwise, click Cancel 
to retain the values that existed when you opened this dialog box.

To access the header or footer areas, simply click inside them, without 
opening a separate window, and begin typing. Throughout MathWriter, you 
can edit within the various structures, such as headers, footers, footnotes, 
sidebars, mathematical expressions, etc., without opening special windows. 
The formatting tools available in the body of the text are available for 
these structures, too. Refer to the section on headers and footers later in this 
chapter for additional details.

To create a footnote:

1. Position the insertion point in the text where you want the footnote 
marker.

2. Select the footnote icon from the bottom row of the Palettes menu.

3. Either scroll to the footnote area or select the footnote region from the 
pop-up menu at the insertion point locator in the document status bar.

4. Type the contents of the footnote.

5. Either scroll back to the body of the text or select Body from the same 
pop-up menu.

Paragraph formatting

Having established the global environment in which to place your ideas, 
you can now consider the next most important formatting issues—how to 
present paragraphs. Since the paragraph is the basic modular unit of 
composition,M athW riter  makes it a primary design focus. As you shall 
see, understanding paragraph formatting is central to using M athW riter 
effectively.

Paragraph formatting commands apply to entire paragraphs. You need only 
place the insertion point within the paragraph to select it. To select 
multiple paragraphs you must use the usual selection techniques.

The ruler M athW riter's paragraph ruler (see Figure 3.8) serves the dual 
role of reporting paragraph formatting choices for the paragraph that 
contains the insertion point and providing a visual dialog box for making 
new choices of margins, first-line indent tabs for character alignment, and 
various horizontal alignment options.

Figure 3.8 The Ruler
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The ruler occupies a prime and predictable location across the top of the 
window with an additional portion in the right border of the window 
above the vertical scroll bar. You can hide the ruler to obtain a better view:

♦  Use Format/Hide Ruler or S€ '.

To view the ruler again:

♦  Use Format/Show Ruler (or #> '), which toggles with Hide Ruler.

When the ruler is visible, only one copy is on the screen; it does not scroll out 
of view and it corresponds to the paragraph that currently contains the 
insertion point. Each paragraph in a document has a ruler that contains its 
formatting information. Because the vertical dimension of the screen is 
especially critical when viewing displayed equations, we have designed 
the portion of the ruler across the top of the window for a minimum depth 
by placing the tab wells and alignment controls on the right side of the 
window.

When you press return to create a new paragraph, M athW riter copies the 
ruler of the previous paragraph to the new paragraph as the default ruler.

Unique ruler icon If you modify the ruler of any paragraph, M athW riter 
flags the paragraph formatting change by placing a ruler change icon LI2J in 
the left margin of the document. Use Format/Hide Message to hide these 
margin notes and its toggled version, Show Messages, to restore them.

The ruler can be used with three units of measure—inch, centimeter, and 
point (or pixel), which is 1 /72 inch.

Ruler units To select a unit of measure use the Ruler Options submenu of the 
Format menu to make a selection.

The fourth submenu option, Page Ruler, which toggles as Column Ruler, 
allows you to have the ruler span all columns of the entire page or begin 
anew in each column.

Ruler icons The gray shading on each end of the ruler (see Figure 3.8) 
depicts the boundaries of the working text area you established using the 
File/Page Layout command. You can work with narrower, but not wider, 
paragraph margins.

Paragraph margins You may have to scroll horizontally to set the left and 
right paragraph margins.

The paragraph margin settings allow you to create special effects easily. 
You can place tightly fitting borders around narrow paragraphs or 
equations by changing the margins. Quoted material is often single-spaced



with a reduced paragraph width. Using the paragraph margins can allow 
you to place sidebars, which are discussed in the next chapter, on the page 
outside the margin.

First line indent To emphasize a paragraph break you might wish to start 
its first line to the right or left of the rest of the paragraph. Of course this 
effect could be achieved using tab ►, but using the first line indent marker i  
is a better way.

For a first line indent drag the first line indent marker to the right of the 
left margin paragraph marker. M athW riter immediately repositions any 
existing text to conform to the new setting.

For a flush first line drag the first line indent marker to the same position 
as the left margin paragraph marker. If you move the left margin 
paragraph marker in either of these cases, the first line indent marker is 
coupled with it and moves the same distance to preserve the magnitude of 
the indent.

For a hanging indent (or "outdent") drag the first line marker to the left of 
the left margin paragraph marker. If the left margin marker is flush with 
the left border of the text area, you must first move the left margin 
paragraph marker to the right before you can make a hanging indent. To 
decouple the first line indent and the left margin markers to create a 
hanging indent, press the *  key when you drag the left margin marker.

A hanging indent is especially useful if you wish to have a single line 
(words or the number of an item in a list) extend to the left of the remainder 
of the paragraph.

Tab alignment of characters The horizontal alignment of characters —  
within a line of text is facilitated by four types of tabs—left align ►, ^  
right align i, center align ♦ , and character (decimal) align 0 . Because ^ 
M athW riter supports variable-width characters, accurate horizon- I—  
tal alignment would be difficult, if not impossible, without 
them. Figure 3.8 provides an example of each type.

Added text aligned with left-aligned tabs advances to the right, keeping 
the left end anchored. When right-aligned, added text advances to the 
left. When center-aligned, added text advances the string to the left and 
right simultaneously, keeping the center of the string anchored on the tab. 
Do not use center-aligned tabs with fully justified alignment (due to the 
implied contradiction discussed next). When decimal-aligned, added text 
advances the string to the left or right as appropriate, keeping the decimal 
point in the string anchored on the tab. The decimal tab is most frequently 
used to align a column of decimal numbers. (See the next section for a 
discussion of creating tables automatically without tabs.)
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To position a tab on the ruler, drag a tab from the tab well (located above 
the vertical scroll bar at the right of the window) and place it on the ruler 
just below the horizontal scale and between the left and right paragraph 
margin markers. To make horizontal alignment with existing characters 
easier, you can drag a tab down into the text to the horizontal position you 
want it in the paragraph; when released, it snaps onto the ruler.

To reposition a tab, drag it to its new location (and take text aligned on the 
tab with it), but beware of the complexity and potential confusion if you 
drag it past another tab. Use option-drag for a smoother drag and finer 
control of tab spacing.

To remove a tab drag it past the right margin on the ruler. Jliill

To align text on a tab, use the tab key either before or after you place text on 
the line. If you become confused about your results, use Format/Show 
Invisibles to display identifying markers. To again hide the markers, use 
Hide Invisibles, which toggles with Show Invisibles.

i , 12, i| I 1 I |

Fixed tabs: If you require evenly spaced tabs across the ruler, double-click 
on the ruler anywhere, except on an existing tab, to obtain the Tab Options 
dialog box (see Figure 3.9). In the Tab Options box you can specify fixed tabs 
and the interval spacing.

Tab Options...

O Fined tabs

® Uariable (user-defined) tabs 

[ Cancel

Figure 3.9 Tab options

Paragraph alignment Using automatic wordwrap, M athW riter strings the 
characters you type together into lines of text that form paragraphs. You 
can influence the placement of line breaks in several ways. Changing the 
left and right paragraph margins can produce different results with 
wordwrap. To override the automatic wordwrap algorithm you can press 
return to end a line and the paragraph, or press shift return to start a new 
line without beginning a new paragraph. Adjacent words can be connected 
by nonbreaking spaces ( option spacebar ) to force them to wrap together as a 
unit.



Lines of text are frequently aligned flush on the left boundary of the 
paragraph, allowing lines of text of variable length to form an 
uneven right end. This is called left-aligned text, corresponding to 
the first of the alignment icons in the right border of the document 
window just above the vertical scroll bar. All lines of text within a 
paragraph share the same alignment. There are four types of alignment:

1 3

1. Left aligned: w- (Described above.)

2. Right aligned: —w This is the mirror image of left-aligned with
alignment flush along the right end of the paragraph.

3. Double aligned: m-h This is also referred to as full justification. The text 
is simultaneously aligned on both ends of the paragraph in newspaper 
style. Warning: (1) Hyphenation (see Edit/Hyphenate) becomes increas
ingly important with shorter lines. (2) Do not use this alignment and center 
tabs together.

4. Center aligned: i* i All text on a line is automatically centered. Use this 
command to center titles on the page. Warning: The first line indent tab 
(rather than the left margin tab) forms the left boundary of the centering 
area and can produce an unexpected shift in the first line of the centered 
paragraph if the first line is set for an indent or outdent.

To change the paragraph alignment of existing text:

1. Select the paragraph by placing the insertion point within it. Use the 
customary selection techniques for multiple paragraphs.

2. Click on the appropriate alignment icon.

Paragraph attributes for each new paragraph, including alignment, are 
inherited from the immediately previous paragraph. You can also use the 
Edit/Copy Other, Style/Style 1, Style/Style 2, and Style/User Styles 
commands to transfer or to assign paragraph formatting.

Paragraph spacing and placement Paragraph spacing on the page (not to be 
confused with line spacing) affects visual appeal and readability. 
MathWriter provides a dialog box for paragraph attributes (Figure 3.10), 
which controls the placement of paragraphs.
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Paragraph format... 
.....................Spacing...................
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Figure 3.10 Paragraph format dialog box

Spacing between paragraphs: Using Format/Paragraph Format, you can 
specify the spacing before and after paragraphs in pixel units. Just as the 
first line indent eliminates extra keystrokes, this command also eliminates 
the empty paragraphs that you must otherwise place between paragraphs 
of text to produce whitespace. In addition to keystroke economy, this fea
ture provides an easy way to globally change the spacing between para
graphs.

To adjust the spacing between paragraphs:

1. Select the paragraphs to be affected.

2. Select Format/Paragraph Format (or M ] ).

3. Drag the scroll box in the scroll bars to set the spacing.

4. Click OK.

Spacing paragraphs on the page: The placement of paragraphs with 
respect to the top and bottom of the page can affect readability. Several 
controls for this are available in MathWriter.

The menu commands that force a paragraph to appear at the top of a page 
or, in other words, to force a column or page break after the preceding 
paragraph are Format/Insert Column Break and Format/Insert Page Break. 
To use these, position the insertion point in the text and select the command 
from the menu. These commands insert nondisplayed, formatting 
characters, which you can locate using Format/Show Invisibles. Use 
Format/Hide Invisibles, which toggles with Show Invisibles, to remove 
them from the display. These markers remain associated with a particular 
paragraph even if further editing makes them inappropriate. To remove a 
paragraph command in such instances, move the insertion point to the



beginning (the top and leftmost position) of the next column or page and 
press delete.

Other page break controls: The selection Link to next 'I causes the current 
and next paragraph to appear and print on the same page. To link multiple 
paragraphs, select all paragraphs except the last before using this 
command. If you want linked paragraphs to appear on the same page, 
MathWriter can move them to one page, provided they actually will fit on 
a single page. Use this feature to assure that a heading is not separated 
from the next paragraph by a page break.

The Page break before selection assures that the paragraph will appear at 
the top of the page. This command serves the same purpose as Insert Page 
Break on the Format menu, but it remains associated with the paragraph 
when the paragraph format is transferred using the Copy Other (Edit) 
command. Use this command when you want a paragraph to begin on the 
first line of a page. There is no icon that indicates a paragraph carries this 
attribute. If an unexpected gap appears at the bottom of a page during 
editing, check for this command by clicking in the paragraph and 
examining the Paragraph Format dialog box.

The Can't split over page break option assures that the entire paragraph is 
kept on the same page. If insufficient space remains on the page to display 
that entire paragraph, as with graphics, MathWriter moves the para
graph to the next page.

Paragraph Borders Use borders to highlight or emphasize paragraphs 
or groups of paragraphs. As you shall see in the next chapter, mathe
matical expressions are also paragraphs, so you can use borders to 
emphasize important results.

M athW riter provides many variations on a theme. For example, the box 
above was formed with a single, one-pixel-wide, solid line on each of the 
four sides of the paragraph, a two-pixel border, and a 1% gray scale 
background. In general, you can apply borders to any combination of sides, 
including a single border on the left or borders above and below a 
paragraph. To group several contiguous paragraphs with a single border, 
select them and enable the Treat paragraphs as a group option which then 
appears (Figure 3.10) below the whitespace scroll bar.

M athW riter places a border at the paragraph's extremities, but you can 
change the extremities of a paragraph using the left and right paragraph 
margins to obtain borders that do not extend the full width of the print 
area. You control the whitespace between the paragraph and the border, 
and between borders if two border lines are used. Numerous line thickness 
and line pattern choices are available. You have 38 choices or any gray 
scale shading (1-100%) for the background pattern.
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To assign paragraph borders:

1. Select a paragraph. You need only place the insertion point within a 
paragraph to identify a paragraph because the command inherently 
applies to the whole paragraph. Drag the mouse or shift dick to select 
multiple paragraphs that share a common ruler. Recall that a unique ruler 
icon identifies paragraphs that do not share the paragraph formatting of 
the immediately previous paragraph; you may need to use Format/Show 
Messages to see them.

2. Select Format/Paragraph Format (or §8 ] )  to access the dialog box.

3. Select which sides need borders. To select all sides simply click on the 
paragraph icon at the bottom-left corner of the dialog box. To select (or 
deselect) individual sides, click on the relevant icon border or the arrows as 
shown in Figure 3.10. A miniature portrait adjacent to the icon illustrates 
your choices.

4. Click in the space identified in Figure 3.10 by "Click above for thickness 
and pattern" to obtain another dialog box (see Figure 3.11).

Select thickness and pattern... 
.....  Outer border..........................

Thickness
Pattern

Inner border

Thickness 
Pattern | Gray scale | [Q|iif

..... Background pattern ..........

Pattern

Space between borders |0||f

WO1 5 %

K l  2

Cancel OK

Figure 3.11 Paragraph borders line thickness and pattern dialog box

5. Assign border attributes and a background pattern. To assign these 
attributes, click in the area identified by "Click above for thickness and 
pattern," which will display your choices. Use the four pop-up menus to 
select line thickness and line pattern for the outer border and, if you elect to 
have one, an inner border. A solid black pattern is the default and a solid



white pattern hides the border. A hairline border can only be printed 
properly if you have a PostScript printer; it defaults to one pixel width on 
an ImageWriter. If you select "gray" in the bottom-right corner of the pat
tern palette, M athW riter supplies a scroll bar for you to set a percentage 
level. You can also assign a background pattern for the paragraph using a 
similar pop-up menu. If you elect to have two border lines, specify the spac
ing between the two lines here. For setting the space between the para
graph contents and the borders, see the previous discussion of Figure 3.10.

6. Click OK to accept the choices you just made, or click Cancel to abandon 
your changes in favor of previous settings. Either choice returns you to the 
Paragraph format dialog box. Make any final corrections there.

7. Click OK to accept the choices you just made in the two dialog boxes, or 
click Cancel to abandon your changes in favor of previous settings.

Line spacing Because M athW riter must adjust the line spacing when 
mathematical expressions of variable height are present, the line spacing 
options are more complicated and, therefore, are accessed from a dialog box 
(Figure 3.12) using Format/Line Spacing (or 98 K), rather than from the 
ruler.

Fixed ascent_______________________  Displaced equation adjustment

£  r £ 14 O l i l i l L
Fixed descent + leading

Cancel f OK4

Figure 3.12. Line spacing dialog box

Our discussion of line spacing re
quires some definitions first 
(Figure 3.13). The baseline is the 
line on which the text rests. The 
ascent and descent are the 
distances above and below the

Ascent.......;.......................

_  J s 5 l .t X L p l v  Baseline 
Descent.................4............

Figure 3.13 Line spacing definitions
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baseline, respectively, which together determine the line height. 
Automatic spacing allows M athW riter to adjust line spacing to 
accommodate height variations in characters, graphics, and mathematical 
expressions. Math Writer uses the maximum of the ascents and descents on a 
line as the line ascent and descent, respectively. At the other extreme, 
Fixed spacing ascent and descent are set in the dialog box (Figure 3.12). This 
assures a constant line spacing even if some characters overlap in the 
output. Between these extremes is Mostly fixed, a combination of automatic 
and fixed. The text and mathematical expressions embedded within a line 
are treated as fixed, but expressions displayed on a separate line perhaps 
with an equation number are treated as automatic.

Line spacing varies with font size, of course. Furthermore, the line spacing 
provides space between lines for the ascenders and descenders of the 
individual characters. In contrast with ordinary word processors, 
M athW riter's Mostly fixed option allows inline expressions (i.e., 
expressions embedded within a line of text such as subscripts and 
superscripts) to protrude into the leading (pronounced 'Tedding") or white 
space between the lines. This avoids the unsightly fluctuation in line 
spacing ordinary word processors produce. Mostly fixed also allows you to 
assign whitespace around equations that occupy a separate display line 
and which are referred to as displayed equations.

Mostly fixed and Fixed both support the standard line spacings of single, 
1-1/2, and double (6, 4, and 3 lines per inch, respectively). The Other 
spacing option allows you to specify separately the ascent and the descent 
plus leading.

Ordinarily, you compose your manuscript using automatic line spacing and 
then, if desired, reassign as either Mostly fixed or Fixed to achieve a 
uniform spacing throughout the paragraph or document.

To set line spacing:

1. Select the text.

2. Access the line spacing dialog box using Format/Line Spacing (or 96 K).

3. Select one of the alternatives (Automatic, Mostly fixed, or Fixed) by 
clicking.

4. If you choose Mostly fixed or Fixed, select a standard spacing or assign a 
custom spacing (Other).

5. If you choose custom spacing, assign ascent and descent values using the 
scroll bars.

6. Finally, if you chose Mostly fixed, set the Displayed equation 
adjustment.
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7. Click OK to accept your choices, or click Cancel to abandon your changes 
in favor of previous settings.

Character formatting
Having discussed document-level and paragraph-level formatting, we can 
now turn our attention to the third level of formatting—.-character 
formatting. Character formatting applies to individual characters and to 
any combination of characters in the document. Character formatting in 
MathWriter centers largely on the Style menu (Text Fonts, Text Sizes, and 
Text Styles) and alternative or shortcut ways to execute combinations of 
those commands.

Typeface: Fonts, Sizes, Styles Character formatting involves three main 
choices—font, size, and style. The first three menu commands on the Style 
menu present these options in submenus.

The Style menus for Text Fonts, Text Sizes, and Text Style use a V to 
indicate that the checked item applies to the entire text selection, while • 
means that it is used in part of the range.

Fonts: A font is a family of characters having a similarity or family 
resemblance. You should be aware of three typeface categories. The first 
category deals with traditional categories typefaces fall into based on 
design characteristics. Those typefaces such as Times and Courier that 
contain fancy ends for the main strokes are called serif type and those 
without, such as Helvetica and Geneva are called sans serif type. A second 
classification of typeface is according to character spacing—proportional, 
such as Times and Helvetica, and nonproportional, such as Courier. The 
characters in a nonproportional font have a uniform width and are said to 
be monospaced. The third classification is one that arises from technology, 
and its significance is expected to diminish substantially with the release 
of the Macintosh System Version 7.0. The bitmapped screen displays in the 
past have been optimized for 72 dots per inch while the LaserWriter and 
other printer devices support 300 or more dots per inch. Smoothly scalable 
screen fonts will significantly improve the screen displays. The names of 
the built-in LaserWriter fonts are identified with underlines on the Text 
Fonts menu. If you press and hold option before and while you select the 
Text Fonts submenu, each font name appears in its particular typeface.

If you intend to print a document with a LaserWriter, we strongly recom
mend that you use laser fonts when writing the document. If you enable font 
substitution (using Page Setup on the Page Layout command of the File 
menu), printing may take longer, especially with mathematical expres
sions, and you may not like the modified spacing. So, although M ath- 
Writer supports the complete mixing of fonts (and font sizes and font styles) 
within a document we recommend restraint in the use of this capability.
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Sizes: M athW riter supports the use of all font sizes, from 4 point through 
128 point, with each font. A point corresponds closely with a pixel, which 
is 1/72 inch on the Macintosh screen. The sizes that appear most clearly on 
the screen and in ImageWriter output are listed in outline style letters in 
the menu.

Styles: M athW riter provides an extended set of styles to modify all 
characters from all fonts. Plain, Bold, Italic, Underline, Outline, and 
Shadow are the most widely used styles. Strikeout, Overbar, Box, Low 
underline, Underline pattern, Underline weight, and Gray scale are useful 
in writing technical documents. Certain other style listings, such as not 
applying the style attributes to space characters, reducing or expanding the 
space between characters, changing the case of words without retyping 
them, and providing a background pattern, are available. Background color 
and character color are supported but impose a substantial computational 
load on MathWriter with only modest benefit.

Assigning character formatting: In most instances you will select favorite 
font, size, and style before writing a document and will have quick access to 
them via your custom-made default files. A default file is a file to which 
the program automatically reverts unless you instruct it otherwise; thus 
M athW riter can automatically call up your favorite selections. When you 
click the cursor in existing text, Math Writer automatically ascertains the 
typeface of the character immediately preceding the insertion point and 
applies that combination of font, size, and style to the text you enter. Al
ternatively, you can assign a font, size, and style to the insertion point and 
have those attributes apply to text you enter. To change the typeface of 
existing text, you must first select the portion of text to be affected and then 
assign font, size, and style.

Specifically, the steps to take to change the format of existing text are:

1. Select the text (refer to text selection techniques above).

2. Select the attributes from the Style menu.

To insert text with the same typeface as surrounding text:

1. Position the insertion point using the mouse or arrow keys.

2. Enter text using the keyboard or using the mouse if text is from the 
Palettes menu or the Font Table. The font, font size, and font style of the 
entered text will be taken from context, i.e., will match the attributes of 
the text immediately to the left of the initial insertion point position.

To insert text with a different format:

1. Position the insertion point using the mouse or arrow keys.
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2. Assign the desired font, size, and style to the insertion point.

3. Enter text using the keyboard or using the mouse if text is from the 
Palettes menu or the Font Table.

Using the Style menu The Style menu has a few unique features that merit a 
brief discussion. The font, size, and style choices are made with submenus. 
M athW riter's list of fonts must always include those fonts that are 
required by the operating system and, in addition, the Times and Symbol 
fonts. There are slight differences between the Symbol font as distributed 
by Apple and by Adobe that affect the stretchable brackets, parentheses, 
and braces. M athW riter has been tuned for the Adobe fonts, which are 
supplied on the distribution disk. In addition, the supplied version has 
been modified to allow boldface Greek letters to retain that attribute when 
printed with a LaserWriter. Use the Font/DA Mover3 to make these fonts 
available to MathWriter.

M athW riter supports all user-installed fonts4 that are compatible with 
the Macintosh system. In addition to commercial fonts, commercial 
utilities allow you to create your own specialized laser fonts. You should 
remove unneeded fonts to increase the RAM available to RAM-resident 
documents.

Ruant Garde A v a n f  G a r d e
Bookman Bookman
Chicago Chicago
Courier Courier

✓  Geneua ✓  G e n e v a
Heluetica H elvetica
Monaco honaco
N Heluetica Narrow N Helvetica Narrow
New Centurg Schlbk New Century Schlbk
Palatino Palatino
Sgmbol SypfloA
Times Timas
ZaDf Chancerg Zapf Chancery
ZaDf Dingbats m o o ®  * * B * G O T A

Figure 3.14 Text fonts submenu

The Text Fonts submenu: (Figure 3.14) To see the font names listed in their 
own fonts, press option before you drag the submenu. If only one font is 
included in a section of text you selected, a check mark appears adjacent to 
the font's name. If multiple fonts are included in a selection, a bullet 
appears next to the names of the fonts included in that selection.

3 or a utility such as Suitcase II
4 including Adobe Type Manager
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If File Warnings on the File/Preferences... dialog box has been enabled, you 
will be warned if fonts used in the document are not available in your 
computer. This M athW riter feature is especially important for technical 
documents because the content may change as a result of an unintended, 
automatic font substitution. While the alphabetical characters have 
standard locations in a font, regardless of the font, this is not true for other 
special symbols. Because inadvertent font substitution is not simply a 
matter of style, M athW riter takes special steps to assure that the 
document has the same appearance and content on any Macintosh.5

The Text Sizes submenu: (Figure 3.15) Frequently used font sizes are listed on 
the Text Sizes submenu. Those sizes that have screen bitmaps available to 
the system are identified by outline style type. To use any size between 4 
and 128 (inclusive) not on the list, click the Other command and supply the 
desired size. These generated sizes will appear ragged on the screen and on 
ImageWriter output, but will print smoothly on a PostScript device.

6 point
7
8
0 
m  

✓ ns
a s  
m
36
48
Other (64)...

Figure 3.15 Text sizes submenu

The Text Style submenu: (Figure 3.16) Eight character styles are listed on 
the submenu; four of these can be selected by either mouse or keyboard. The 
remaining four require use of the mouse.

Select font size...

Cancel

EG
G O

technical note: MathWr i te r  stores in each document file a table of the local internal font identification numbers 
and the corresponding font names. When the document is opened with a different Macintosh, MathWr i te r  uses the 
font names to match the fonts with the new local font identification numbers, thereby assuring unchanged content.
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Figure 3.16 Text Style submenu

Style/Other Styles... (or 36 Y) activates a dialog box with additional 
choices (Figure 3.17). Except for Plain, any combination of the styles with 
check boxes beside them can be used simultaneously. Plain has the special 
characteristic of automatically overriding all other style attributes. If 
only one style attribute is represented in a selection, a check mark 
identifies that choice in the dialog box. If two or more attributes are 
included within the selection, a bullet appears next to the attributes 
included.

Certain styles are mutually exclusive choices. For example, you can change 
the displayed case of text to UPPERCASE, lowercase, or Cap. First without 
retyping the selection, but you can select only one of these alternatives at a 
time. When you deselect these styles, M athW riter restores the original 
case used when you entered the text. When exporting such text in TEXT 
format, the displayed, not the original case, is sent to the file.

Other styles...

□  Plain
□  Bold
□  Ita lic
0  Underline

□  GMD0E0
□  a a a c a a i!)

□  Words only
□  Strikeout
□  Ouerbar

□ i » 3
□  Lout underline 
0 1 UPPERCASE^

Background pattern 

Background color 

Character color

White |

Black |

0 | Condense 

□  Gray 

Underline pattern

Underline weight [

Cancel C 0K-JJ
Figure 3.17 Other styles dialog box
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Likewise, you may either Condense or Extend text to remove or to add 
pixels between characters. The mutually exclusive choices for Underline 
pattern and Underline weight can be applied if and only if at least one of 
the underline attributes has been chosen also.

The Underline and Low underline attributes can be used concurrently to 
obtain double underlines. Words only and Underline used together produce 
underlines for the words, but not the spaces between the words. Box and 
Strikeout are frequently used for revision tracking. Subscripts and 
superscripts are handled using the Tools window, and are not included here 
as a style.

M athW riter will reformat paragraph lines automatically if typeface 
changes require it. No hidden text style is included because that capability 
is handled more conveniently using hideable memos (See Format/Insert 
Memo). As mentioned previously, M athW riter supports color attributes for 
text and text background, but this slows the program considerably.

Using formatting shortcuts: Mathematical manuscripts make extensive use 
of typeface changes to convey information, especially in mathematical 
expressions. M athW riter supports technical typing by handling many 
typeface changes automatically and making manual changes more 
convenient. As discussed in the next chapter, automatic formatting is 
especially important when entering mathematical expressions. For 
example, when typing superscripts, the cursor changes position and the font 
size adjusts automatically. The typeface of the character located to the 
immediate left of the insertion point is described in the document status bar 
at the bottom right corner of the document window.

Greek font selection shortcut: Because the Greek alphabet is used frequent
ly, there is a shortcut for toggling between it and your current font.

♦  Press Si space bar to toggle to and from Greek.

The Greek letter assignments have a mnemonic relationship to the 
keyboard. Use the first letter of the name of the Greek letter (a for alpha, b 
for beta, etc.), except in four instances (h —> rj, j —> cp, y —> vj/, and w —»co) to 
avoid ambiguity. To review the keyboard layout, use the Key Caps desk 
accessory on the Apple menu and select the Symbol font from the Key Caps 
menu that appears to the right of M athW riter's Windows menu. 
Alternatively, you can "type" the Greek letters from the Palettes Window 
(Windows menu) or the Font Table (Windows menu) if you have selected 
the Symbol font from its font pop-up menu.

Symbol font selection shortcuts: You can "type" all other characters in the 
Symbol font from the pull-down Palettes menu. (The Greek characters are a 
subset of the Symbol font.) As you drag across a symbol in the Palettes pull
down menu, its name appears on the last line of the menu. In contrast with 
entries made from the keyboard, the font choice for subsequently entered
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text is not affected by this font change. Even more convenient access to 
repeatedly used characters from the Palettes pull-down menu is possible by 
assigning a row of the Palettes menu characters to the Palettes Window 
displayed using the Windows menu.

Assigning characters to the Palettes Window:

1. Select Windows / Palettes Window to display the floating Palettes 
Window.

2. Drag to select the name of a row of characters in the Palettes pull-down 
menu. Add other names as desired. Selected rows have a check mark to the 
left of the row name. Reselect a row to remove it from the Palettes Window.

3. Drag the Palettes window to a convenient location using the gray region 
below the window's close-box. If you are using two monitors, you can even 
drag the floating window to the second screen.

You can also enter any of these characters at the insertion point using the 
Font Table. In fact, the Font Table provides mouse access to every character 
available to the system.

Using the Font Table:

1. Select Font Table from the Windows menu.

2. If you are using two screens, you can drag the floating window to the 
second screen using its title bar, or,

3. If screen space is limited, adjust the size of the floating window using 
the grow box at the bottom-right corner of the window and use the 
horizontal and vertical scroll bars to bring the characters of interest into 
view. If you have reduced the font table size, you can use the zoom box at 
the top-right corner to expand the Font Table quickly to its original full 
size.

4. If the desired font is not currently displayed, place the cursor on the 
name of the current font and select the desired font from the pop-up menu.

5. Press on the desired character until it appears at the insertion point.

6. To remove the Font Table, click in its close-box or reselect Font Table 
Window from the Windows menu.

Changing font size:

1. Select the text.
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2. Select Larger Size or Smaller Size from the Style menu or use the 
keyboard equivalents (98 plus or 98 minus using plus and minus on the top row 
of the keyboard, with or without the sh ift key). This command selects the 
next larger or smaller size on the Font Size menu. If you press the option key 
when using this command with the keyboard or mouse, the size changes by 
one point.

Changing font style: Eight popular styles are listed on the Text Style 
submenu; but numerous additional styles are available from the Other 
Styles submenu command. For more convenient access, the Other Styles 
(Figure 3.17) dialog box can be accessed directly using 98 Y. The usual list 
has been expanded to provide revision tracking styles and other special 
purpose styles.

Changing combinations of attributes: Often you need to change several 
attributes simultaneously. M athW riter provides quick access (using 98 < 
and#? >) to combinations of font, size, style, line justification and line 
spacing (called Style 1 and Style 2) and another command to restore the 
Last Style (or 98 \). In the next chapter you will be introduced to "User 
Styles," which perform an analogous role but also remain linked to the text 
such that a change in the definition at any time changes all the text 
throughout the document having this user-style.

Using Style 1 and Style 2:

1. Select Doc Preferences... on the File menu. These are document specific 
definitions. To use the same definitions in other documents you will find it 
convenient to define template documents using MW Default File Type using 
Save As... on the File menu.

2. Click either the Style 1 or Style 2 button (see Figure 3.18).

Style 1...

__________ Style 2...__________

Figure 3.18 Style buttons on Doc Preferences dialog box

3. Assign the attribute combinations (Figure 3.19) that you desire.

Only the categories with check boxes selected will be applied when this 
style combination is selected. Make font, size, and line justification choices 
using pop-up menus. The style and line spacing choices lead to other dialog 
boxes. Your choices are illustrated in the window.

4. To abandon your choices, click Cancel. To accept your choices, click OK.

5. If desired, assign Style 2.

6. Click OK to close the Doc Preferences dialog box.
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Editing

Moving text

Set style number 1...

£3 Font | Palatino]

3  Size 112 | [3 Justification Left |

[El Style select style... □  Line spaciny t spadny...

Style number 1 will appear like this. Justification is 
affected.

Cancel

r  «  ~ i

Figure 3.19 Style dialog box

To use Style 1 or Style 2 to apply a style combination to existing text:

1. Select the text.

2. Press S8 < or 88 > for Style 1 or Style 2, respectively 

To resume use of the immediately previous style:

Press 98 \ or select Last Style.

We now supplement our earlier discussion of elementary editing techniques 
to include additional cut and paste operations, find and replace, 
hyphenation, and spell-checking. A brief discussion of editing auto
matically formatted tables is included in this chapter, but we defer a 
discussion of M athW riter's extensive, mathematical expression editing 
features until the next chapter.

The ease with which you can rearrange and perfect the contents of a 
document is probably the most compelling reason for replacing a typewriter 
with a word processor. M athW riter supports the Macintosh metaphor for 
cutting and copying text onto a Clipboard, a temporary holding area, for 
subsequent pasting (transfer) to another location within the document, or 
even into another application. You can, for example, create a picture in one 
application and paste it into M athW riter via the Clipboard. In addition, 
you can read certain standard file types directly without activating the 
generating application.
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To transfer text and graphics treated as characters:

1. Select the text (and graphics) by mouse or by keyboard. (The Cut, Copy, 
and Clear commands remain dimmed until you select text.)

2. Use Edit/Copy (or 96 C) if you want to transfer a duplicate of the select
ed text onto the Clipboard and leave  the original intact. Another option is 
to Edit/Cut (or 96 X) to transfer the selected text onto the Clipboard and 
remove the original selection.

3. Optional: To examine the contents of the Clipboard, select Windows / 
Clipboard. Reselect it to hide the Clipboard.

4. Using the mouse or keyboard, position the insertion point where you 
want the Clipboard material placed.

5. Use Edit/Paste (or 96 V) to transfer an exact copy of the Clipboard 
contents into the active document at the insertion point. If you want a copy 
of the Clipboard contents to assume the typeface (font, size, style) of the 
character to the immediate left of the insertion point rather than retain its 
original typeface, use Edit/Paste Other/Paste in Context (or 96 shift V).

The Clipboard remains unaltered when you paste, when you switch among 
applications, or even when you shut down the program. It can be pasted 
repeatedly. The name of the Paste command changes to reflect the current 
contents of the Clipboard. If the Clipboard contains text (or mathematics 
treated as text), it reads Paste Text. If the Clipboard contains a 
mathematical expression stored in PICT format, which can be transformed 
back into an editable expression, it reads Paste Math. If the Clipboard 
contains a picture, the paste command reads Paste Picture.

6. Use Edit/Undo (or 96 Z) to reverse the immediately preceding operation. 
Undo applies to most operations, not just to editing procedures.

The Edit/Clear command removes selected text, but does not place a copy on 
the Clipboard. If you must delete large text selections, use Clear, rather 
than Cut, to minimize temporary storage demands.

To immediately scroll to the location of the insertion point during an 
editing operation, use Edit/Show Selection.

The Cut/Copy/Paste operations apply to mathematical expressions if the 
transfer remains within M athW riter documents. Because other word 
processors do not support the enhanced data structure of M athW riter for 
editable mathematical expressions, you must instruct M athW riter to 
transform such expressions into PICT graphics form when placed on the 
Clipboard if you intend to subsequently paste the expression into the more 
limited formats. To do this use Edit/Copy Other/Copy as Picture, not the 
usual Copy command. See Figure 3.20.



You can replace text (delete old text, insert new) during a paste operation if 
the text to be replaced is selected before the paste operation is executed. To 
do this:

1. Place text on the Clipboard as previously described.

2. Select the text to be replaced using the mouse or keyboard.

3. Use Edit/Paste to replace the selection with the Clipboard contents.

In addition to the more advanced techniques for assuring format uniformity 
such as Styles 1 and 2 on the Style menu, Math Writer supports an extended 
copy feature, Edit/Copy Other, for this purpose (Figure 3.20).

Copy Ruler §€OR
Copy Format §€<> F
Copy Ruler & Format 3€OR
Copy Style 3€OS
Copy Memo
Copy Rs Picture 9§OC

Figure 3.20 Copy Other menu

Paragraph formatting is stored in two parts—in the ruler and in all the 
other paragraph attributes—and can be copied separately or together. The 
ruler stores the paragraph unit of measure, paragraph margins, all tab 
settings, and paragraph line alignment; in brief, that is the displayed 
information that is hidden by Format/Hide Ruler (Si shift R). Copy Format 
(Si shift F) saves all other paragraph formatting information, such as 
spacing before and after paragraphs, borders, and such attributes as the 
ways paragraphs are linked, etc. (See Format/Paragraph Format.) Both 
types of information can be copied at the same time using Copy Ruler and 
Format (Si shift A). Recall that when you press return to create a new para
graph, the new paragraph assumes the format of the preceding paragraph 
unless you change it. You do not need to use the Copy Other commands as 
often.

To transfer paragraph formatting, the steps are:

1. Identify the originating paragraph by clicking the cursor anywhere 
within it; you need not highlight the paragraph.

2. Use the appropriate Edit/Copy Other command (either Copy Ruler, 
Copy Format, or Copy Ruler and Format) by mouse or keyboard.

3. Click inside the destination paragraph to select it. You can also select 
several contiguous destination paragraphs.

4. Use the companion Edit/Paste Other command (either Paste Ruler, 
Paste Format, or Paste Ruler and Format) by mouse or keyboard.
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5. Repeat steps 3 and 4 as often as needed.

Ordinary copy and paste commands can be intermixed with paragraph 
copy and paste commands without disturbing the paragraph formatting 
information.

You can transfer character formatting (font, size, and style, but without the 
actual character) from one character to others you have selected. Use of 
this command is analogous to use of the paragraph command, although you 
will usually wish to select several contiguous destination characters at 
once. The steps are:

1. Place the insertion point to the immediate right of a character having 
the typeface (font, size, style) you wish to transfer.

2. Use Edit/Copy Other/Copy Style (or $$ shift S) to make a copy of the 
character formatting information.

3. Select the text that is to be assigned this typeface.

4. Use Edit/Paste Other/Paste Style (or shift D) to transfer the charac
ter formatting.

The Copy Other commands use a mnemonic letter for ruler (R), format (F), 
all (A), and style (S); the Paste Other commands use an adjacent letter on 
the keyboard that is to the right of the corresponding copy letter, except for 
A whose neighbor (S) is already used.

The Clipboard is the temporary storage (buffer) for material being copied 
from your document of another application or file and pasted into your 
document. During a complicated set of manipulations it may be useful to 
examine its contents:

♦  Select Windows/Clipboard to display the floating Clipboard window.

No editing can be performed directly in this window—it is a display only. 
It does respond to other window controls. It has a title bar with which you 
can reposition the window, a zoom box to toggle the size of the window, a 
grow box to change the width and height of the window, a status display 
bar just below the title bar that allows you to choose which type of 
Clipboard contents to display, and a close-box.

♦  Click the close-box on the Clipboard window or reselect Clipboard on 
the Windows menu to hide the Clipboard.

To use the Scrapbook:

Unlike the Clipboard, the Scrapbook is a permanent, online storage 
location for text, graphics, and mathematical expressions. Individually 
selected items can be stored here for recovery and use by any standard
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Macintosh application. The actual file is stored in the System folder with 
the name Scrapbook File. Only one Scrapbook file6 can be stored there.

To place material in the Scrapbook:

1. Select and copy material to the Clipboard.

2. Select the Scrapbook from the Apple menu.

3. Use the Scrapbook scroll bar to select an entry, which the new entry will 
precede.

4. Use Edit/Paste to transfer a copy of the Clipboard to the Scrapbook.

5. Optional: Close the Scrapbook or make another window the active 
window by clicking in it or selecting it from the Windows menu.

The lasso paint tool allows extraneous whitespace to be trimmed from 
graphics stored in the Scrapbook, thereby avoiding the need for cropping.

To recover material from the Scrapbook:

1. Select the Scrapbook from the Apple menu.

2. Use the Scrapbook scroll bar to select an entry.

3. Use Edit/Copy to transfer an item to the Clipboard. Use Cut or Clear to 
remove an item from the Scrapbook.

4. Use the customary paste procedure to transfer the item from the 
Clipboard into the document at the location of the insertion point.

If you wish to create multiple scrapbooks, you can assign a new name to the 
Scrapbook file in the System folder and the system creates a new file 
having the name "Scrapbook File". To recover material from the renamed- 
file, you must assign a new name to the current scrapbook file and rename 
the older file with the reserved name "Scrapbook File". A commercially 
available utility6 provides a more elegant approach to this process.

The Find and Replace commands

M athW riter's find and replace commands allow you to locate and change 
text and mathematical expressions in a document. For example, you might 
locate a particular string of characters embedded somewhere in a document 
that you wish to examine or modify. Optionally, you can use these com
mands to replace a string with another string or replace all such located

6 SmartScrap allows multiple named scrapbooks to be used.
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strings automatically. You can qualify a search by looking for only upper
case letters or only whole words rather than embedded strings. Numerous 
and powerful extensions to these traditional search and replace features 
are reviewed in the next chapter.

Find/Replace
Match Rffect Wildcards Special Direction r

Find:

Replace with:

I Find §8G ] | Replace, then Find j | Replace %H] | Replace Rll |

Figure 3.21 Find/Replace dialog box

To find text (and to navigate through a document):

1. Place the insertion point in the document at the starting point of the 
search.

2. Open the Find/Replace dialog box (Figure 3.21) using Edit/Find/Re- 
place (or SS F).

3. Supply the text to be found in the upper box where the insertion point is 
flashing. The search will be for the characters you typed in the upper box 
and will proceed from the insertion point until a match is found or the end 
of the document is reached, whichever comes first.

4. Use Edit/Find Next, Find in the Find/Replace window, or type G or 
return to initiate the search. The search can be directed by mouse from the 
dialog box or by keyboard if you pressed return to remove the dialog box and 
initiate the search. The latter has the advantage of a larger document 
word area and not requiring you to switch repeatedly between the dialog 
box and the document, as the active window, when making changes.

5. MathWriter continues to find matches as you use Edit/Find Next or press 
G until the search reaches the end of the document.

6. To modify the document when using a mouse-directed search, you must 
make the document the active window by clicking in it or by clicking in the 
close-box of the Find/Replace dialog box.



In addition to locating text, this feature also allows you to replace the 
located text:

1. Perform steps 1 - 3  above.

2. Supply replacement text in the lower box of the Find/Replace dialog 
box.

3. Use Edit/Find Next, Find in the Find/Replace window, or type 36 G or 
return to initiate the search.

4. Once a match has been found, four options are available:

• By keyboard: Alternate between 36 H (Replace Selection) and 36 G (Find 
Next) to sequentially find and make changes.

• By mouse: a) Alternate between Replace and Find to sequentially find 
and make changes; b) Repeatedly use Replace, then Find to reduce the 
number of keystrokes needed to individually approve each substitution; c) 
Use Replace All.

Warning Replace All cannot be undone so make a precautionary backup 
before using this command.

You can paste ordinary text into the Find/Replace dialog box, but not 
mathematical expressions, although they can be typed directly into the 
oversized boxes.

5. Until the end of the document has been reached, you can repeatedly find 
matches using Edit/Find Next (or 36 G).

6. Click in the close-box to close the dialog box.
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Figure 3.22 Find/Replace pop-up menus

The primary search categories on the Find/Replace dialog box (Figure 3.21) 
are Match and Affect (Figure 3.22). whose pop-up menus determine 
whether you are searching and replacing text or style attributes of the text 
as well.

The five pull-down menus allow you to customize searches (Figure 3.22).

• The Match menu identifies attributes of text in the find box that need to 
be matched in the search. These attributes, font, size, style, case, or whole 
words, are in addition to matches with the actual characters typed. A case 
match requires that each character match the corresponding case (upper or 
lower) as the text in the find box. A whole word match excludes matches on 
portions of words.

• The Affect menu identifies attributes of text in the Replace with: box to 
be applied to the replacement string. These attributes, font, size, and style, 
are applied to the replaced text, regardless of the attributes of the 
surrounding text.

• The Word and Symbol selections on the Wildcards menu allow you to find 
matches on a character string when a leading or trailing string of characters 
(Word) is immaterial or when an individual character (Symbol) is
immaterial. For example, use the Word option "run ivordi" to find "run" and 
"running", or any word that begins with "run". Use the Symbol option "ca

represents exactly one character. Thel?j" to find "cat" and "car". [?i
remaining three options 
discussed in Chapter 4.

apply to mathematical expressions and are



70 Chapter 3

• The Special menu allows you to locate (and replace) the invisible 
formatting characters—tabs, line breaks, column breaks, page breaks, or 
any character you identify by its ASCII number. Use the mouse to "type" 
these characters in the Find/Replace dialog box from the pull-down menu. 
See the appendix for an ASCII list. The most common use of the Character 
Code option is to clean up imported files.

• The Direction menu controls the search direction and range. With the 
arrows you can search forward from the position of the blinking insertion 
point or backward to the end of the document (only), or search the entire 
document.

The preceding exercise illustrated a text search, the conventional use of 
Find/Replace. To change a specified text string and typeface combination to 
another text string and typeface combination, follow these steps:

1. Select the match style combination (Figure 3.23) in the Match pull-down 
menu and supply the search text string in the Find: box (Figure 3.21) and 
assign the selected style attributes.

Match
Text Only

✓  Font
✓  Size
✓  Style

i
(iiords

Affect
Text Only

✓  Font
✓  Size
✓  Style

Figure 3.23 Match and Affect attributes

2. Select the replacement string style combination (Figure 3.23) in the 
Affect pull-down menu and supply the replacement text string in the 
Replace with: box (Figure 3.21) with the selected style attributes assigned.

3. Perform the search and replace as described above for ordinary text re
placement. However, in this search, the selected attributes will not be 
taken from the context.

Spell-checking

M athW riter can compare each word in your document with a vocabulary 
list and identify the words that are not found in the vocabulary list. You 
create a supplementary list of words using the User Dictionary. You can add 
new words to the supplementary list or remove unwanted words. If you 
wish, M athW riter presents a list of alternative spellings for words not 
found in the dictionary. Words in uppercase often are acronyms and can be 
excluded from the suspect list automatically. Repeated words can also be 
flagged and removed with MathWriter.
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The word lists Because the system files and M athW riter each nearly fill a 
disk, spell-checking is practical only if you are using a hard disk. The word 
lists, also called dictionaries, must be accessible to M athW riter. If the 
word lists are placed in the System folder or in the same folder as Math- 
Writer, the program automatically locates the main MathWriter diction
ary and the supplementary dictionary at startup. Otherwise, to locate 
them and access a dialog box, you must use the two buttons Main Dictionary 
and User Dictionary on the Check Spelling dialog box. Only one user dic
tionary can be active, but you can manually switch to other word lists.

Spell Finder® from MicrolyticsT

[Main Dictionary: MathUlriter Dictionary

User Dictionary: ] MID User Dictionary < Edit

Finding alternate spellings.
03 Rlternates I

0  Skip words in Rll Caps 

Change to:

^  Check for repeated words

Check Replace Skip Learn Cancel

Figure 3.24 Spell-checking dialog box

Spell-checking your documents To find and correct misspelled words, follow 
these steps:

1. Position the insertion point in the document where checking is to begin.

2. Select Edit/Check Spelling to access the spell-checking dialog box 
(Figure 3.24).

3. If the names of the main dictionary and the user dictionary do not ap
pear in the dialog box adjacent to the Main Dictionary and User Dictionary 
buttons, click on those buttons to locate them.

M athW riter locates them automatically at startup if they are in the 
folder with M athW riter or in the system folder. The path to these files is 
stored in the Prefs file so this process need not be repeated.

4. Click in the check boxes to select which of the following options you 
prefer: •

• Alternatives. If the suspect word shown in the "Status" box is either 
misspelled or not in the dictionary, M athW riter can provide an optional 
pop-up list of alternatives.



If feasible, M athW riter places a "bestguess" alternative in the Change to: 
box; otherwise, it places the suspect word there. If M athW riter finds other 
alternatives, the list appears in the pop-up menu. When you select an entry 
from the pop-up menu, Math Writer transfers the word to the Change to: 
box.

When you recognize that the suspect word is correct, you can terminate the 
search for alternatives prematurely by pressing $8 period or by clicking the 
mouse. If the desired word is not located, type it in the Change to: box.

• Skip words in All Caps. This option excludes acronyms.

• Click on Check for repeated words to locate contiguous, repeated words. 
This option locates and removes duplicate words. When contiguous, 
repeated words such as "very very" are found, the dialog reports "Status: 
Repeated word." Click on Replace to remove the word and an adjacent 
space or on Check to resume checking without making a change.

5. Click on Check to begin checking. The progression of the search
is reported just above the Alternates pop

up menu. The triangle ▼ indicates the relative position of the start of 
checking.

When a suspect word is found, you have three options:

• Supply the correctly spelled word in the Change to: box if it is not 
already provided by the Alternatives option and click Replace.

• Click on Skip to bypass the word, leaving it unchanged.

• Click on Learn to add the word to the user dictionary, thereby avoiding 
manual verification of this word in future sessions.

6. Optional: Click on <Edit to review the list of words in the active user 
dictionary and to remove any that you wish to exclude. (See Figure 3.25 for 
a view of the Edit User Dictionary dialog box.)

• To remove a word, select it and press Delete Word.

7. When the spell-checker reaches the end of the document, it asks you 
whether it should continue checking from the beginning of the document. 
Click on Stop Checking to terminate the search or Continue Checking to 
resume checking.

8. Click on Cancel to terminate checking.
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Edit User Dictionary...

Delete IDerd

* °K )l
Figure 3.25 Edit User Dictionary
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Caution: Always read your document carefully. Spell-checking does not 
assure that you have used words correctly.

Printing

This section describes the final step in producing a document—printing. 
M athW riter supports output to the ImageWriter and the LaserWriter with 
the customary options for multiple copies, range of pages, etc. Enhancements 
allow you to select page ranges based on the page variable numbers; print 
markers for ruler changes; collate multiple copies; print on both sides of the 
paper; and print pages in normal or reverse order.

Installing the print driver

Consult your Macintosh user's guide for hardware installation instructions 
and placement of the appropriate print drivers in the System folder.

Although you can change printers at any time, we recommend selecting the 
printer type before you create the document because page sizes, margins, and 
placement of some mathematical expressions are affected by the printer 
choice.

To route output to a particular printer:

1. Select Chooser from the Apple menu.

2. Click on the icon of the desired printer type (Figure 3.26).

3. Select a specific printer:
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Figure 3.26 Chooser dialog box

ImageWriter To print with an ImageWriter, you must specify a Specific 
printer port by clicking on the icon that corresponds to the printer connection 
on the back of your Macintosh. Supply your user name if you wish. Click on 
the close-box.

LaserWriter To print with a LaserWriter you must click on the name of a 
particular "online" LaserWriter. Only the names of active printers avail
able on your AppleTalk network appear in the list. If the Print Monitor is 
present in the System folder, you can select background printing, which 
means that the file will be printed to disk and then sent to the printer, 
freeing your Macintosh for other tasks.7 Supply your user name if you intend 
to print an identifying cover page. Click on the close-box.

In general, you should have decided the type of printer before creating your 
document because this decision can affect your choice of fonts, and, 
therefore, can alter the page layout. If your document layout is critical, 
explicitly make your own font selections rather than using the "Font 
Substitution" option under Page Setup on the File/Page Layout menu. Select 
the "Tall Adjusted" option for proper ImageWriter output of mathematical 
expressions. Other factors such as paper size are dependent on printer 
choice, too. (In mathematical expressions the choice of printer affects the 
horizontal placement of superscripts.)

7 The current version of a public domain virus program interferes with background printing.
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Selecting a document

The document you want to print must be in the active window.

To select a document, open it, if necessary, using the File/Open command. 
The document opens at the location of the insertion point when last saved. 
To have the document open at a specific page, position the insertion point 
on that page before you save the file.

If the document is open but not in the front window, either click in a portion 
of the document window or select its name from the Windows menu to bring 
it to the front.

Using the print dialog boxes

The File/Print command activates a dialog box with the output options, 
which are different for the ImageWriter and LaserWriter. See Figures 3.27 
and 3.28 for a glimpse of these two dialog boxes. Note that you may use the 
mouse or the tab key to move among the input boxes.

ImageWriter v2.7 1 OK ]|
Quality: O  Best ® Faster 0  Draft
Page Range: ® fill O  From: To: ( C an ce l]

Copies: 1

Paper Feed: ®  Automatic O  Hand Feed

□  Page Range Refers To Page Uariable Numbers
Print Markers For:

□  Memos Q □  Ruler Changes ra □  Reuisions |
Print Multiple Copies: ® Uncollated O  Collated
□  Print Both Sides □  Reuerse order

Figure 3.27 ImageWriter Print dialog box

The ImageWriter-specific options are:

• Quality: These options let you balance speed and print quality. "Best" is 
the slowest option and uses the highest density of dots. "Faster" preserves 
the font and style information but speeds up delivery. "Draft" is the 
fastest, but does not preserve the character formatting information. •

• Paper Feed: Use "Automatic" for fanfold, tractor-fed paper and "Fland 
Feed" for individual sheets of paper.
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LaserWriter “LaserWriter II NT”

Copies

5 .2

1 Pages: (•) fill 0  From: To:
L°iU)

Cancel
Couer Page: (§) No O First Page O Last Page Help ]
Paper Source: <•) Paper Cassette O Manual Feed
□  Page Range Refers To Page Uariable Numbers 
Print Markers For:

□  Memos D  □  Ruler Changes ra □  Reuisions |
Print Multiple Copies: ® Uncollated O  Collated
□  Print Both Sides □  Reuerse order 
Paper Motion Configuration:

TR AY MAN. MAN.

LWII LWII LWII

Figure 3.28 LaserWriter controls

The options common to ImageWriters and LaserWriters are:

• Page Range: Use "A ll," the default, to print the entire document, 
regardless of the number of pages. Otherwise, supply the beginning and 
ending page numbers in the "From:" and "To:" boxes; leave the "To:" box 
blank to print to the end of the document. You can use either the physical 
page numbers, which correspond to the scroll box in the vertical scroll bar, 
or page numbers as they appear in the header or footer, in which case you 
would click on "Page Range Refers To Page Variable Numbers." These 
numbers will be the same, of course, unless you supply a starting page 
number (Format/Variables Format) different from "1," which you might do 
if the current file were a continuation of a previous file. To print a single 
page, assign the same page number to the "From:" and "To:" boxes.

• Copies: Type the number of copies you wish to print here.

• Page Range Refers To Page Variable Numbers: See Page Range above.

• Print Markers For: This command prints the locating tags for ruler 
changes. Use Format/Show Messages to display these markers in the left 
margin on the screen. Paragraph format changes are identified by "unique 
rulers."

• Print Multiple Copies: This command lets you control the order of 
printing. "Uncollated" is faster and prints all copies of a particular page 
before moving to the next page. "Collated" prints all pages of a document 
before beginning another copy of a document.



Nontechnical Writing 77

• Print Both Sides: This command prints the odd and even pages separately 
and provides instructions for changing the paper. For a LaserWriter you 
must identify the paper motion configuration discussed below.

• Reverse Order: This command automatically adjusts the printing order. If 
Reverse is not checked, the pages print in normal reading order. For a 
LaserWriter you must identify the paper motion configuration discussed in 
the next list in order for this feature to work.

The LaserWriter-specific options are:

• Cover Page: Use this option to identify your output when you are sharing 
a LaserWriter with others. This identifying page can precede or follow 
your document.

• Paper Source: The LaserWriter can automatically feed sheets of paper 
from a paper cassette (tray) or receive hand supplied sheets. If you choose 
manual feed, you will be prompted by a screen message to insert the pages.

• Paper Motion Configuration: The path of the paper through the 
LaserWriter depends on the model and paper source. Click on one of the 
icons to select the printer type.

LaserWriter+ LaserWriter II

Other printing options

For additional printing options refer to the discussion earlier in this 
chapter about the Page Setup dialog box available via the File/Page 
Layout command. (See Figure 3.29 and Figure 3.3Q) Tall adjusted, 50% 
reduction, and no gaps between pages are available for Image Writers. 
Options for the LaserWriter include reducing and enlarging the page image, 
font substitution, text and graphics smoothing, faster bitmap printing, 
fractional widths, flip horizontal, flip vertical, invert image, precision 
bitmap alignment, larger print area, and unlimited downloadable fonts in a 
document.

Selecting Tall Adjusted is necessary when using the Image Writer for the 
output to look like the screen.
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ImagellJriter_____________________________________________________ V2 .i
Paper: (•) US Letter O H4 Letter

O  US Legal O International Fanfold
O Computer Paper

Orientation Special Effects: □  Tall Adjusted
□  50 % Reduction
□  No Gaps Between Pages

Figure 3.29 ImageWriter Page Setup dialog box

Eg
E g

[ Cancel

Lasertilriter Page Setup______________________________________5 2

Paper: (5 ) US Letter O  H4 Letter OTabloid 
O  US Legal O  B5 Letter

Reduce or 
Enlarge:

Orientation

Printer Effects:
□  Font Substitution?
□  Tent Smoothing?
□  Graphics Smoothing?
□  Faster Bitmap Printing?

Cancel ]

Options ] 

[ Help ]

Figure 3.30 LaserWriter Page Setup dialog box

Printing at the Finder level

You can select and print multiple files from the Finder level, as well as 
with the Print Monitor under MultiFinder as follows:

1. Use the usual selection techniques to select the icons of one or more files 
from a folder.

2. Choose Print from the File menu to initiate printing.

Summary
In this chapter you have examined the techniques used to create, edit, 
format, and print a nontechnical document. Most steps can be performed by 
mouse and by keyboard. Math Writer provides immediate visual feedback 
throughout—from defining the page characteristics and creating fully 
formatted "sheets of paper" with automatic pagination to typing special 
characters and designating the type of LaserWriter you're using.

The next chapter covers the features required for more specialized 
applications, including M athW riter’s unique capability for creating, 
editing, and numbering mathematical expressions in a document.
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The techniques for creating, editing, formatting, and printing general, non
technical documents are described in the previous chapter. In this chapter 
we extend that discussion to include techniques for enhanced document lay
out, such as creating headers, footnotes, and advanced typing aids, such as 
the font table. Our primary focus, however, is the presentation of tools and 
techniques for composing a mathematics-laden document at the keyboard.

Mathematical expressions contain a larger assortment of fonts, font sizes, 
font styles, and special characters, as well as more frequent changes in 
these attributes than is typical of ordinary writing. Furthermore, the 
special positioning of these characters produces a two-dimensional, rather 
than a one-dimensional, stream of characters governed by an extensive set 
of formatting conventions. To the extent feasible, M athW riter handles 
these formatting tasks for you.

The chapter closes with a discussion of customization to reduce repetitive 
setup tasks, sharing data among applications, and an important modulari
zation technique for extending the scope of tasks handled by MathWriter.

Formatting Revisited
A few general formatting techniques not covered in Chapter 3 will be 
reviewed here.

Document formatting

Ruler options

Because mathematical expressions usually require more vertical space 
than a line of ordinary text, the vertical dimension of the screen becomes an 
important issue. Hiding the ruler provides a larger work space.

♦  To hide the ruler, select Format/Hide Ruler to remove the tab setting 
scale across the top of the document window.



The tab wells and paragraph alignment icons displayed above the vertical 
scroll bar are also removed at the same time. Hiding the ruler is also useful 
when you use Math Writer for a video presentation of "slides." In the 
previous chapter we discussed the techniques for rapid, top-of-the-page 
scrolling.

♦  To show the ruler, Select Format/Show Ruler (or 96' ) to display the 
ruler.

♦  To change the unit of measure, drag to select inches, centimeters, or 
points on the Ruler Options command of the Format menu.

The abbreviations for these units in the File/Page Layout dialog 
(Figure 4.1) are: in, cm, pt (without a period). Recall that the ruler has an 
intentional and convenient "coarseness" (for matching tab settings at one- 
sixteenth inch increments) that you can override by pressing option while 
dragging a tab.

The zero point of the ruler can correspond to either the actual left boundary 
of the page or to the left edge of the text area.

♦  To change the horizontal position of the ruler, drag to select 
Format/Ruler Options/Page Ruler or Format/Ruler Options/Column Ruler 
to toggle to the other.

Page Layout.

[Matt] ( Std Page Setup...

Margins:
left

right

top
bottom

Header height: 

Footer height:

0.750 in

1.250 in

1.250 in
1.555 in

0.402 in

0.000  in

□  Gutter 0.000 in

Facing pages

Figure 4.1 Page Layout dialog box
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♦  To assign an enlarged margin for binding (Figure 4.1), click on the word 
"Gutter" or on its check-box and supply a value and unit. The gutter is space 
in addition to the margin you specified above in the left and right margin 
dialog box.

If you intend to print your document on the front and back of pages (see 
File/Print) and have assigned a binding margin or gutter above, you can 
have M athW riter place the binding margin alternately on the left and 
right borders of the pages.

♦  To create facing pages, click Facing pages to set this option.

Note: If you use the Facing pages option, you will probably also elect to 
make your headers and footers differ on alternate pages (see File/Doc 
Layout, "Left/Right Pages").

Paragraph formatting

Line spacing

Appropriate spacing of lines of text in a paragraph makes documents easier 
to read. Straight prose requires fewer formatting options than technical 
writing. With the usual word-processor choices of single, 1-1/2, and double 
spacing, you can double space a printed draft of prose to allow space 
between the lines for editing and then single space the final document 
without retyping. However, in the case of simple mathematical 
expressions, such as exponents, embedded or in-line constructs produce 
uneven line spacings.

Line spacing...
(§) Rutomatic
O  Mostly fined 
O  Fined

Simple text line (24 pt)..

!»,•></

Other...

Minimum ascent

frLLJ............. I
Minimum descent + leading

f c H J .........................

@ 9  

S  3

..CQMJex.mtlilwe.,,
( - i )

i f + i

S 1 )

Cancel I -  1

Figure 4.2 Line Spacing dialog box



M athW riter provides additional controls for line spacing (Figure4.2). The 
Automatic selection allows you to create mathematical expressions of 
arbitrary complexity without concern for the required line spacing. If the 
resulting text has a distracting unevenness, you can select the offending 
paragraph or paragraphs and assign to it one of the other two spacing 
options.

Fixed spacing allows you to specify a line spacing that will be maintained, 
even if portions of the line must be clipped. The ascent and descent settings, 
not just the leading, can be set separately (Figure 4.3). The Mostly fixed 
option allows some mathematical structures, such as superscripts and 
subscripts, to protrude into the whitespace that already exists between the 
lines of text. Mostly fixed automatically switches to Automatic for 
mathematical expressions that occupy a separate line (but not for 
expressions embedded within a line of text).

default

adjusted

Figure 4.3 Ascent and descent are separately adjustable

The Automatic spacing default settings (Table 4.1) for ascent and descent 
are 9 and 3 for the minimum ascent and minimum descent plus leading. 
Figure 4.3 shows a spacing of 30 (top) and 20 (bottom) pixels.

Mostly fixed spacing (Figure 4.4) lets you choose from three standard line 
spacings and a user-defined fourth. You can add extra whitespace above 
and below displayed equations (equations on a separate line, not embedded 
within a line of text).
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Line spacing...

O Automatic
(§) Mostly fitted 
O Fined

Fixed ascent

Figure 4.4 Mostly fixed spacing 

Table 4.1 Default line settings

Setting: Single 1-1/2 Double Other

Lines / inch 6 4 3 na

Min. Ascent 9 14 18 user

Min. Descent + Leading 3 4 6 user

........................ 0
Fixed descent + leading

o n £

: S ing le  (6  lines/inch) 

j 1—1 / 2  (4  lines/inch)

: Double (3  lines/inch) 

; O ther...

9

3

Displayed equation adjustment

H i Ml 6
Cancel o o

To change the spacing of existing text:

1. Select the text to be affected. Line settings apply to an entire paragraph. 
Recall that to identify a single paragraph, you need only place the 
insertion point within the paragraph. You can also select a portion of text 
within the paragraph to identify it. To select several contiguous 
paragraphs, place the blinking cursor somewhere in the first paragraph 
and, with the shift key depressed, click somewhere in the last paragraph.

2. Select Format/Line Spacing and assign values for line spacing, dis
played equation adjustment, and ascent and descent by clicking or dragging.

When you create a new paragraph by pressing return, it inherits the line 
spacing of the previous paragraph, but not its border information. You can 
also assign the line spacing for a paragraph any time, including 
immediately after you create it and before you type any characters.



M athW riter applies various borders and background patterns to 
paragraphs. You can place a border on any combination of sides of an 
existing paragraph. The border can consist of one or two lines of user- 
selected thickness, pattern, and spacing (between lines and between the 
border and the paragraph). The paragraph itself can have a background 
pattern or a gray-scale on a PostScript printer.

One or more contiguous paragraphs can have borders, but borders must be 
assigned explicitly to existing paragraphs rather than being passed 
automatically with the ruler. If you choose borders on all four sides and 
select two or more paragraphs, the common boundaries will be deleted 
automatically. Since an equation can also constitute a paragraph, this 
provides a means for highlighting the important result of a derivation.

To assign paragraph borders:

1. Select the paragraph.

2. Select Format/Paragraph Format. (See Figure 4.5.)

Paragraph format.. 
.....................Spacing

Before SI \0\ |i
After SI IQ HI {

Borders

0  0
£ | 8

------------Attributes ....................
□  Link to nent SI
□  Column break before
□  Page break before
□  Can't split ouer page break

Click above for thickness and pattern

Whitespace (Q| | j - ...... (Ql 6

Cancel OK II
Figure 4.5 Paragraph Format dialog box

3. Click on the sides of the paragraph icon at the left (Figure 4.6) to 
designate the sides to be assigned a border. Click in the middle of the icon 
to select four sides at once.

4. To assign the number of lines (1 or 2), line thickness and pattern, or 
background pattern, click in the space to the right of the paragraph icon.
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................Borders
♦

ill
♦

Click above for thickness and pattern

Figure 4.6 Assign sides and line characteristics

5. Make choices regarding number of lines, line thickness and pattern, and 
background pattern using the pop-up menus (Figure 4.7).

6. Use the scroll bar to assign the whitespace (in pixels or points) between 
the paragraph and the borders.

Character formatting

Diacritical marks

Select thickness and pattern. 
.....  Outer border.......................

Thickness 
Pattern

..... Inner border

Thickness hairline 

Pattern

..... Background pattern

Pattern

Space between borders |Q|§[

Figure 4.7 Assign border styles

7. Click OK to accept the choices and close the dialog box.

A number of Math Writer's numerous techniques for quickly assigning the 
typeface information to text were discussed in Chapter 3. A few mathe
matically related techniques are discussed here.

Many Macintosh fonts include characters that contain diacritical marks. 
You can use the Windows/Font Table to type them and the Key Caps desk 
accessory to locate them on the keyboard. The Diac menu supplements this 
and also provides various horizontal groupings (over and under bars).
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1. Place the insertion point immediately to the right of a character to be 
assigned a diacritic. Once you have selected a character in this manner, 
the previously dimmed diacritical marks become available.

2. Select a character using the mouse.

The diacritics in the Diac menu, but not those that are part of the font 
character sets, are bypassed by the spell-checker.

3. If necessary, adjust the height of the diacritic using the Raise or Lower 
commands on the Diac menu (or their keyboard equivalents 96 R and 96 L).

Multiple levels of characters

To place multiple lines above a character:

1. Place the insertion point to the immediate right of a character, which 
optionally might already have a diacritic mark.

2. Click [ f ]  on the Tools menu or press 96 [ and supply one or more characters 
to be centered above the base character.

3. Optional: Choose the matrix template with no separating lines as the 
ninth icon (column) on the ninth icon (row) of the Templates window or use 
96 9 and 9 (if typed rapidly and the Template is not visible) when you must 
stack an arbitrary number of rows above a character.

Use the special functions templates on row seven, rather than center below 
for limits, etc., where irregular spacing around the base character must be 
avoided.

Horizontal grouping of characters

Twelve, stretchable, grouping symbols become available when you select a 
string of contiguous characters to represent complex conjugates, vectors, and 
soon.

Note: Boldface Greek letters (often used to denote vectors) will not print 
properly on a LaserWriter unless you use the Adobe Symbol font licensed 
for use with MathWriter.

To supply horizontal grouping symbols for multiple characters:

1. Select two or more characters.

2. Select the desired symbol from the Diac menu. After a slight pause, 
MathWriter places the symbol over or under the characters.
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3. If necessary, you can use the split I-beam math cursor (obtained by 
pressing option anytime the regular text cursor is present) to edit within the 
group of characters.

Headers and Footers
Size

To set the size of the header and footer:

1. Select File/Page Layout.
The outer rectangle of the page 
diagram (Figure 4.8) corre
sponds to the physical bound
ary of the paper; the outer 
rectangle of the area with the 
darkest shading identifies the 
maximum LaserWriter print 
area. The margins (top, bot
tom, left, and right), measured 
from the page boundaries, 
allow you to exclude addi
tional print areas.

2. If necessary, adjust the 
margins by typing new values.
The interior of the remaining 
rectangular portion of the 
page contains the body of the 
document and the headers and 
footers. The headers and foot
ers extend across the page, even if multiple columns are used.

3. Type the vertical dimension of the header and footer in the dialog box 
(Figure 4.9). Supply dimensions with units (in, cm, or pt without a period). 
To eliminate a header or footer, set its dimension to zero. Out-of-range 
values will not be accepted.

4. Click OK to accept your choices.

Only text that fits in the header will be displayed. You can resize the 
vertical dimension if necessary.

Paper boundary
Top
margin

Header

Footer
Bottom
margin

Left Right
margin margin

Figure 4.8 Page layout schematic
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Page Layout... Columns (§) I O 2 O 3 O -4

[Man] ( Std )

Margins:
left

right

top

bottom

Header height: 

Footer height:

^  Gutter 

Column gap:

□  Facing pages

Page Setup.

1.250 in

1.250 in

0.430 in

0.430 in

0.500 in

0.305 in

1 . 0 0 0  in

0.250 in
Cancel OK

Figure 4.9 Page Layout dialog box

Figure 4.10 Doc Layout dialog box
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Placement
To place the headers and footers on pages throughout the document:

1. Select File/Doc Layout (Figure 4.10).

2. Click to make your choices for placement of headers and footers that can 
appear on every page, skip the first page, skip the last page, or skip the 
first and last pages. An enclosing border identifies your choices for headers 
and footers. Additional choices remain. Four sets of alternatives are 
provided for headers and footers—three sets are comparable, in their 
actions, to radio buttons and the fourth is comparable to a check-box. (For a 
complete description of these features, see Chapter 3.)

3. Click to select either "Same for all pages" or "Left/Right pages." By 
convention, left pages are even-numbered and right pages are odd- 
numbered. If you choose "Left/Right pages," you must specify the 
placement of the contents of the headers and footers on both odd and even 
pages. If you have not yet supplied any text, you can use Format/Insert 
Column Break to make the second page appear. If you selected facing pages 
using File/Page Layout, then M athW riter prints the pages as mirror 
images with binding margins preserved.

4. Click to toggle "First page different" if you wish the first page headers 
and footers to differ from the rest. This option is useful, for instance, if you 
wish to create stationery that has a letterhead only on the first page or if 
you wish to place page numbers on all pages except the first.

5. Click OK when you are satisfied with your choices.

If you wish to create "stationery" with page numbering that begins on the 
second page, temporarily add a second page using Format/Insert Page 
Break, add the page number by clicking HJh on the Palettes menu, format it 
with "Page #" on Format/Variables Format, and remove the temporary 
second page by placing the insertion point at the top left of the text of the 
temporary page and pressing delete.

Editing headers and footers

To edit existing headers and footers:

1. Click within the header or footer to position the insertion point. Your 
choices in the previous section may have created several different headers 
or footers so remember to verify that you are editing the correct one.

2. Supply text, graphics, or mathematical expressions as if you were 
working within the body of the text. Sidebars cannot be placed in the 
header or footer, but background pictures can.

Select All, Cut, Copy and Paste (all on the Edit menu) apply to headers 
and footers, as do Format/Paragraph Formatting and Format/Line Spacing.
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3. Click within the body of the text to leave the header or footer.

Footnotes and Endnotes
Supplementary or parenthetical information is sometimes placed at the 
end of the page (as a footnote) or at the end of the document (as an endnote) 
with a unique symbol assigned to text and to the note to establish a visual 
linkage. M athW riter dynamically numbers footnotes using a user-selected 
format and reformats the page to make space for them. When you supply 
footnote text that exceeds the allocated space, M athW riter automatically 
moves body text from that page to the following page to make room for the 
footnote. If you cut from a document a portion of text that contains a footnote 
or endnote reference and paste that material elsewhere in the document, 
M athW riter automatically renumbers the notes, preserving the linkage to 
the content of the footnote, and displaying the note in its proper location. If 
you remove a footnote that is cross-referenced by a footnote re-reference 
variable, that linkage is broken.

Footnote (and endnote) placement
To choose footnotes or endnotes:

1. Select File/Doc Layout. (See Figure 4.10.) Normally, you decide where 
you want parenthetical material placed (at the foot of the current page or 
at the end of the document) before you create the document. If you forget, 
however, MathWriter can reformat the document.

2. Click on either the Footnotes or Endnotes icon (Figure 4.10).

3. Select one of the three separation formats (no divider, dotted, or solid).

4. Use the scroll bars to set a) the space before the first footnote and b) the 
space between footnotes, measured in pixels (or points).

5. Click OK to accept the choices and leave the Doc Layout dialog box, or 
click Cancel to abandon your choices when you leave the box.

Creating footnotes (and endnotes)
To create a new footnote (or endnote), follow these steps.

1. Place the insertion point in the text where the footnote reference is to be 
placed.

2. Drag to the footnote icon *_on the Variables row of icons of the Palettes
menu and release the mouse button. Math Writer automatically assigns a 
footnote number using the default format. The name of the icon appears on 
the bottom row of the Palettes menu as you drag across the icons in the 
palette. Alternatively, type $$ option F.
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If you must select a Variables icon frequently, a speed enhancement is 
available to you:

• Place the row of variable icons on the floating Palettes window for 
convenient mouse access without using a pull-down menu. To do this, select 
Windows/Palettes Window to place the Greek palette on-screen and then 
select the name "Variables" on the Palettes pull-down menu.

3. Select the footnote number in the pop-up menu of the insertion point 
locator box in the status bar at the bottom of the page (see Figure 4.11) to 
scroll to the footnote. You can also use standard scrolling techniques. The 
window scrolls to the footnote/endnote area with the insertion point 
positioned for text entry.

Body
O  Header - Every page 
□  Footer - Every page 
O  Footnote 1 
O  Footnote 2 
10) no ___________

Figure 4.11 Pop-up locator menu

4. Supply the footnote content. The footnote area increases as necessary, 
displacing lines from the body of the text and automatically moving them 
to the next page as needed. The technique of setting global formatting 
attributes for footnotes is described later in this section.

5. Click Body in the pop-up menu (Figure 4.11) in the insertion point locator 
box of the status bar to scroll back to the location of the insertion point in 
the body of the text. You can also use the standard mouse and keyboard 
scroll techniques to return to the text.

Cutting and pasting footnotes (or endnotes)

When you cut and then paste text that includes footnote references, 
M athW riter automatically renumbers and re-positions them. Do not cut 
and paste the contents of the footnotes separately as that is handled 
automatically.

To cut and paste a footnote (or endnote):

1. Select the text, which includes the footnote reference. Note that the 
footnote number is a discrete character that you can cut and paste separate
ly-

2. Cut the text with its footnote reference number. M athW riter auto
matically renumbers the remaining footnotes and updates the linkage to 
the actual footnote.
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The link to a footnote re-reference (i.e., a cross-reference to an existing foot
note) is necessarily broken when the footnote is removed, even temporarily, 
and must be reestablished manually. A question mark replaces the cross- 
reference number when the link is broken.

3. Indicate the destination of the text and footnote reference by reposition
ing the insertion point.

4. Paste the text and footnote reference back into the document.

M athW riter automatically renumbers the footnotes; moves the text of the 
footnote to a new page, if appropriate; and places the footnotes in the 
proper order.

Formatting footnotes and endnotes

M athW riter supports five standard formats for consecutive numbering of 
footnotes and a set of six user-selected symbols for non-numeric referencing. 
To change the default format of footnote numbers, follow these steps:

1. Select Format/Variables Format.

2. Scroll to and click on footnote/endnote. (See Figure 4.12.)

3. Click on one of the numerical formats or the "use symbols" category.

4. If you chose to use symbols, you can edit the six characters, which are 
listed in sequential order.

5. Edit the "starting at" box in the Footnote dialog box to set the lowest 
footnote number if this is a continuation document.

Complete steps 6 - 8 if you do not want to take the style from context.

6. Optional: To assign a style, click the Variable Style button.

7. Optional: Click the check-boxes or the category names to enable Font, 
Size, Style, Justification, or Line spacing categories. Font, Size, and Justifi
cation lead to pop-up menus and Style and Line spacing lead to dialog boxes 
for those more complex choices.

8. Optional: Make style selections, verify the output, and click OK.

9. Click OK (Figure 4.12) to accept your choices and leave the Variables 
Format dialog box, or click Cancel to abandon your choices when you leave 
the dialog box.

Variables format is a global command so the format of all footnote numbers 
will assume the format you assign there.
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Figure 4.12 Footnote format choices

To change the default style of the text of footnotes:

1. Select File/Doc Preferences.

2. Click the Footnote/Endnote style button [ Footnote/Endnote  ~~) to access the 
Footnote/Endnote style dialog box (see Figure 4.13).

3. Click the check-boxes or the category names to enable the Font, Size, 
Style, Justification, or Line spacing categories. Font, Size, and Justification 
lead to pop-up menus which list the available choices. Style and Line 
spacing lead to dialog boxes for those more complex choices.

4. Make selections, verify the output, and either (1) click Apply to 
implement the changes throughout the document, or (2) click OK to affect 
the next one.

5. Click OK to accept the choices and leave the Variables Format dialog 
box, or click Cancel to abandon your choices when you leave the box.
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Figure 4.13 Footnote style

Typing Tools (Revisited)
Technical word processing typically uses an enlarged character set. 
Without special typing aids, learning to type these extra characters would 
take longer. M athW riter's typing tools reduce the learning time and 
facilitate font changes. Among these tools are the Palettes menu, 
Diacritics menu, and Font Table, which place visual prompts in front of the 
typist. Another important typing aid, Style/Auto Math, is discussed later 
in this chapter.

Palettes menu
The Palettes menu contains rows of special symbols taken largely from the 
Symbol font. To use the Palettes menu:

1. Position the insertion point in the text to specify the destination of the 
character.

2. As you drag the cursor over the symbols in the Palettes menu, the name of 
each symbol crossed appears in the last row. Release the mouse button when 
the desired character is located by the cursor to "type" the character.

The | and || symbols have special stretch properties. To modify these 
characters:

1. Click on Character Editor in the Tools submenu, type 96 shift [, or click 
the arrow tool on the Tools floating window.
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Diac menu

2. Select a character previously placed in the text. A "character" can also 
be a built-up mathematical expression that extends to the baseline.

3. Press option and, with the cursor, drag either end of the selected 
character to stretch it. Click at the middle of the symbol to restore its 
original size.

U i

1 +

X I

s
X7

stretch

After step 3, the bottom portion of the Tools window, which 
formerly contained the subscript and superscript icons, now contains 
arrows for moving the selected character vertically in one pixel 
increments. The square in the middle is a reset button; you can click 
on the middle of the selected character to restore its original size.

The symbols in the last row, called Variables, have special 
characteristics. These are the numbering and linkage variables that 
automatically supply values. They include: creation date, current date, 
creation time, current time, page number, number of pages in a document, 
footnote/endnote, re-reference footnote/endnote, equation number, 
subequation number, equation reference number, user-category, user- 
subcategory, user category reference number, and file name. The typing and 
formatting of these variables are handled separately. See the section on 
automatic numbering later in this chapter for details.

When variables are placed in a document, they behave as an indivisible 
unit, even when composed of several characters. You can edit the entire unit 
but not its components. You can change its style and cut, paste, and delete it.

Most Macintosh fonts contain characters with accents and other special 
markings required for foreign languages. You can identify the key 
combinations to type them using Apple/Key Caps. The next section 
describes Math Writer's Font Table for mouse access to any character in any 
font, including the characters that already incorporate a diacritic. The 
Diac menu provides additional diacritical marks that you can raise and 
lower as well as symbols for grouping characters together horizontally.

Diacritical marks

The symbols on the first row of the Diac menu, two 
symbols from the second row, and two from the fourth 
row are available when the insertion point is placed 
to the immediate right of an alphabetic character. To 
type a diacritic:

1. Place the insertion point adjacent to a character, on 
its right side.

B 0 0 0 0 B 0 B
i- i I- I ■ I

■HR1-1 1 - 1 I- I
■-•■ S-I i- i

2. Select a symbol from the first row of the Diac menu.
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3. If necessary, use Raise, Lower, or Remove from that menu.

If more than one level of symbols is needed, consider using the center above 
and center below tools on the Tools window in addition to the Diac menu. If 
more than two levels are required, consider using the two-dimensional 
array on the Templates window, row 9, column 9. (Access these by mouse or 
by using 96 9 and then 9).

Horizontal groupings

To type a horizontal grouping symbol:

1. Select two or more adjacent characters of text.

2. Click on one of the symbols from rows two, three, or 
four of the Diac menu.

If you press the option key to obtain the Math Editor, 
you can edit inside the text string of the group; the grouping symbol length 
adjusts automatically. Horizontal grouping symbols cannot be raised or 
lowered.

To remove a horizontal grouping symbol:

1. Select the grouped characters.

2. Select Remove from the Diac menu.

Font Table
Because technical typing uses many special symbols, M athW riter provides 
a Font Table containing every character in every font available to the 
system.

To "type" a character with the mouse:

1. Position the insertion point within the text.

2. If the floating Font Table window (Figure 4.14) is not visible, select it 
from the Windows menu.
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Figure 4.14 Font Table

3. If necessary, click on the font name that appears on the Font Table to 
select a font from the pop-up menu.

4. Press (don't just click) on a character to select it.

If desired, you can drag the Font Table window by its title bar to position it 
more conveniently, perhaps even to a second display monitor. If you require 
access to only a portion of the table, use the grow box in the bottom-right 
corner of the floating window to shrink it and use the vertical and 
horizontal scroll bars to adjust the visible portion of the window. The zoom 
box in the top-right corner of the floating window quickly expands the 
table to full size. Use the close-box in the top-left corner of the floating 
window or reselect the Font Table on the Windows menu to hide it.

Automatic Numbering
Technical writers extensively cross-reference pages, footnotes, equations, 
figures, tables, theorems, and so on. When editing, updating the numbers 
for these items and the references to them can be daunting.

M athW riter offers a broad automatic numbering capability, one example of 
which is automatic-numbering of footnotes, discussed earlier in this 
chapter. This section concentrates on equation numbering, which plays a 
special role in technical writing because of its importance. An additional 
user-defined variable in M athW riter also provides numbering for other 
entities and will be covered next.



Various numbering schemes can be used to identify the equations in a 
document. In MathWriter, equation numbers are user-controlled and appear 
before or after the equation. Proximity is the only link between the 
equation and the equation number. Thus you have to cut and paste both the 
equation and its number together. You number the starting equation and 
Math Writer automatically numbers subsequent ones.

You also have a number of options for styling and formatting equation 
numbers in M athW riter. In the following example, the equations have 
been created in a paragraph with automatic line spacing, Format/Line 
Spacing, the paragraph is left aligned w-, the equation is centered using a 
center tab ♦ , and the equation number is aligned at the right margin 4 .

References in the text to equations [1] and [2] are linked to the actual 
equation numbers such that the references are automatically updated when 
the equation numbers are changed. In this example the equation numbers are 
bracketed, but many other possibilities exist.

1. To format equation numbering, using Format/Variables Format, scroll to 
equation number X#, select it, and define the format options. There are 
seven numbering schemes (1, 5.1, 5-1, A, a,I, and i), four bracketing options 
(none, (1), [1], and user-selected characters), a starting number (an Arabic 
number), and text label (such as chapter and section number). The font, size, 
and style of the variable is the same as the text surrounding the equation 
unless you assign different ones using the Variable Style button.

Subequation numbers are handled the same way but you select among six 
numbering styles (a, A, 1, I, i) and three separators (no space, dash, and 
period); for equation reference, the same options as equation numbering are 
available. Note that the format of the equation reference variable need not 
be the same as the equation variable.

The variable format choices you make for your first equation numbers 
apply throughout the document and remain linked such that a redefinition 
is immediately and automatically applied throughout the document.

♦  Establish the paragraph ruler tabs for displayed equations (i.e., 
equations that occupy a separate line). If the ruler for a displayed equation 
is to be different from the text ruler, you can copy the ruler by clicking 
Edit/Copy Other/Copy Ruler. Then, if you want all displayed equations to

[11
has two roots

[2]
2 a
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have the same paragraph ruler, click Edit/Paste Other/Paste Ruler to 
place that ruler in your document. If you wish to establish the paragraph 
alignment, etc., you can copy and paste both the Ruler and Format at the 
same time.

To create a displayed equation and equation number:

1. Establish the paragraph formatting, perhaps using Edit/Paste Other 
/Paste Ruler & Format (or 98 shift Z), as just discussed, tab to the center tab, 
and enter the equation.

2. Tab to the position for the equation number and select lr_J, the equation 
number variable, from the Variables row of the Palettes menu to insert the 
equation number. You can identify the icon easily because as you drag across 
a variable icon its name appears on the last row of the menu. You can also 
use the Palettes floating window or type 98 option E.

Apply subequation numbers[2 ] using the same technique to show a grouping 
relationship such as 5.a, 5.b, 5.c.

Cross-references

To create a cross-reference to an equation:

text references to 
numbered

Using the M athW riter cross-references command 
equations can be dynamically linked to the automatically 
equation variables such that if the number of the equation cited updates 
automatically, so does the reference to it. There are three ways to provide 
this linkage after you insert the variable.

Type an equation number that this reference points to 
or type a re lative number:

or '<n' = previous or previous /7th 
'>', or '>n' = next or next /7th 

or click on an equation number in the document.

Cancel OK

Figure 4.15 Equation reference dialog box

• Supply the current value of the equation number being cited by typing it in 
the dialog box (see Figure 4.15).

• Supply the equation number being cited by typing in the dialog box the 
relative equation number (< means the immediately previous equation, <2 
means the second previous equation, >2 means the second higher equation). •

• Scroll to and click on the equation number being cited and M athW riter 
will calculate the linkage.
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If you must move a numbered equation, cut and paste both  the equation and 
its number. This maintains the proper linkage and automatically renumbers 
all equation variables affected by the move except when a cross-reference 
variable is linked to it. The linkage of a cross-reference variable is 
maintained if only a cross-reference variable is moved.

However, if you cut or delete, even temporarily, an equation numbering 
variable that has a linked cross-reference variable, the linkage becomes 
meaningless and a question mark replaces the cross-reference equation 
number to identify the broken link. You must remove the cross-reference or 
manually reestablish the linkage.

M athW riter was created as an authoring tool, not just a transcription or 
desktop publishing tool for completed technical manuscripts. The equation 
numbering variable epitomizes the difference between these two tasks. 
Without M athW riter, an author can incur a heavy penalty for adding or 
deleting numbered equations or figures. Design choices for this version 
emphasize operational simplicity for the author, rather than transcription 
typing speed or the handling of large documents.

User-Defined Variable

In addition to footnotes and equations, various other entities are frequently 
referenced by number in technical manuscripts—figures, tables, paragraphs, 
theorems, corollaries, etc. M athWn'fer/Educational Version provides one 
user-defined variable.

Defining a variable
To define a user-variable:

1. Select Format/Variables Format. The user-defined variable is obtained 
by renaming the triplet of variables (User category #, sub-User category #, 
User category reference) found at the end of the scrolling window in the 
Variables Format dialog box (Figure 4.16).

2. Scroll to and click on User category #.

3. Click on Rename.

4. Supply a name, e.g., "Figure," in the Rename dialog box (Figure 4.17) and 
click Rename. This renames the collection of three user-defined variables 
and supplies the name to the Palettes menu icons.

5. Assign the formatting attributes for this family of variables by 
responding to the same dialog box used for the equation number variables 
shown in Figure 4.16.
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Your formatting choices in Figure 4.16 (variable style button, brackets, 
numbering scheme, starting number, and label) apply throughout the docu
ment; all subsequent changes in this dialog box will be applied immediate
ly to the entire document.

Uariables Format...

i-  footnote/endnote
re-reference footnote/endnote 

2 * equation # 
sub-equation # 
equation reference

N# User category
u, sub-User category *

Uj User category reference

Yr

O

Nem... Rename.

Example

[Category 1 1]

Uariable Style..

(•) 1, 2, 3 O R ,  B-RR, BB 

O  h. 1 , h.2  O  a, b-aa, bb 

O h- 1 , x- 2  O l . H . I I I  
O  i, ii, iii

o  — <D [—J O (—)
Q  Otherfj |—  [}

Starting Rt 
Label
Category 1

Cancel 1■ 0>( )
Figure 4.16 Select the User category

1 Rename category...

User Category II
Cancel Rename

L — ___J
Figure 4.17 Rename the User category

To identify variables in your document, use Format/Show Invisibles. 
Variables (but not portions of variables) can be moved using the usual cut 
and paste techniques.

6. Click OK to accept your choices.

Applying the variable

If you have defined the triplet of variables, you place this variable in the 
document in exactly the same way equation numbers are placed, but using 
the adjacent triplet of icons from the Palettes menu.
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For access from the Palettes Window:

1. Select Windows/Palettes Window if it is not already in view.

2. Place the Variables row of icons on the Palettes window by dragging to 
the name "Variables" on the Palettes pull-down menu and selecting it.

3. Press on the desired user-defined variable icon type on the Palettes 
window and drag to select the variable from the pop-up menu (Figure 4.18) 
on this floating window.

Figure

Figure 4.18 Palettes user-category pop-up menu

If the starting number for the variable is different from the default, such as 
occurs when a document extends beyond a single file, follow these steps to 
reset the starting variable number:

1. Select Format/Variables Format.

2. Scroll to and select the name of the variable.

3. Assign a new value in the Starting At box.

4. Click OK.

Collaborative Writing

Scientific manuscripts usually involve multiple revisions and collabora
tion, among authors and between authors and editors. This communication is 
an important part of the writing process. Math Writer provides a document 
history that characterizes the evolution, size, and complexity of the file.

Document history

To track the history of a MathWriter file:

1. Select File/Doc Info. This dialog box (Figure 4.19) provides nonprinting 
space for a history of the document and keywords. Math Writer automati
cally reports various characteristics of the file—number of sessions, crea
tion date and time, date and time last modified, size on disk—and various 
characterizations of the document such as pages, paragraphs, lines, words, 
memos, etc.

2. Click OK to close the window.
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Abstract/N otes:

Sessions: 
Creation date: 

Modification date: 
Size on d isk :

T h is  is  space fo r  non-printing m essages and 
keyw o rd s

10
Sep . 2 ,  1 9 9 0 , 5 :4 0 :2 4  PM 
D ec. 3 ,  1 9 9 0 , 11 :5 3 :4 7  AM 
1 3 6 ,5 4 4  b y t e s (1 3 3 K )

Pages: 2 2  
Paragraphs: 271  

Lines: 6 1 0  
Words: 5 5 2 2  

Memos: 3

Unique ru le rs : 44  
Unique s ty le s : 3 5  

Style  runs: 6 2 6

Characters 
on base line : 3 2 ,8 3 9

in sub-expressions: 2 6
containing sub-expressions: 3

Total: 3 2 ,8 6 5

r ~ 5 i T l

Figure 4.19 Document info dialog box

Revisions

With Matfe Wn'fer/Professional Version the actual additions and deletions 
you make when revising a manuscript are marked automatically using 
distinctive, user-selected styles to identify the changes. That version also 
provides tools for locating and implementing the changes conveniently. In 
this Educational Version you can use the enlarged set of text styles to 
identify proposed changes also, but you must mark the additions and 
deletions manually. Define Styles 1 and 2 using the File/Doc Preferences 
dialog box and apply them using the Style menu or the keyboard 
equivalents as discussed in Chapter 3.

Tables

Because simple tables are often required in technical writing, M athW riter 
treats them as a variation on a matrix and provides automatic formatting. 
M athW riter adjusts the spacing of the cells and the borders with every 
keystroke so the layout is always visible. New rows and columns can be 
added or deleted quite easily.

You prescribe the alignment of text in a table cell (left, right, center, or 
decimal), the typeface of the text, the attributes of the bounding lines and 
background, and the minimum amount of space between the contents of cells 
and the borders. Tables (Table 4.2) can contain text, mathematics, and 
graphics.
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Table 4.2 Table with graphics

Ruler
Icons

Usage

paragraph indent

▲ paragraph margins

4 right align

► left align

♦ center align

0 character align

Tables are fully editable using the Math Editor. The self-formatting 
templates provide tables that have no boundaries, a single boundary 
enclosing the table, or boundaries for each cell. Individual cells can even 
contain a table. Tables, and sidebars discussed below, provide a side-by- 
side paragraph option. The word-wrap algorithm treats a table as a tall 
character and, therefore, does not split it across page boundaries. In 
addition M athW riter can transform a table into PICT format for pasting 
into other applications.

Create a table

Although you can use tabs to create tables, M athW riter provides a self
formatting template for this purpose. Simply select the template and, 
while you supply the contents of the cells, M athW riter handles the 
formatting. You may use the mouse or the keyboard to create a self
formatting table.

To create the table using the mouse, follow these steps:

1. Select a table template by, first, opening the Windows/Templates 
Window if it is not already accessible.

2. In the Templates Window, drag to the next-to-last template, the matrix 
, or to the last, the table ffiTl, and release the mouse button.

The last entry on the matrix category | : | is an array without visible 
borders. The table category includes a table with an overall bounding
border |TT| | and one with borders for each cell
3. Optional: Supply the contents of the first cell (row 1, column 1).

4. Press tab to create a new column and press return to create a new row. 
Repeat these steps to create a rectangular table of the desired number of 
rows and columns. When columns and rows exist to the right or below the 
current cell respectively, the tab and return keys simply advance the 
insertion point. A 3 x 3 table is shown in Table 4.3.
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Table 4.3 A 3 x 3 table

(1,1) (1,2) (1,3)

(2,1) (2,2) (2,3)

(3,1) (3,2) (3,3)

5. Supply the contents of the cells in any order. To reposition the insertion 
point with the mouse, press option to switch from the Text Editor (I-beam 
cursor) to the Math Editor (split I-beam), and click. Click outside the table 
or click on the I-beam tool to resume text editing.

To create the table using the keyboard:

1. With the Template window visible, press 36 and a template row number 
followed by the column number of the individual template that you want on 
that row. For example, typing 36 9 followed by 9 selects the template for an 
array without bounding lines (Figure 4.20). If you pause after typing 36 9, 
the matrix menu pops out with prompting numbers on each choice. Typing 36 
0 (for the last row) followed by 2 selects the template for a table with 
bounding lines for each cell.

If the Template window is not visible, you must type the commands quickly 
and the prompting column numbers do not appear.

2. Optionally, supply the contents of the first cell (row 1, column 1).

3. Press tab to create a new column, and press return to create a new row. 
Repeat these steps to create the rectangular table of the desired number of 
rows and columns. The tab and return keys simply advance the insertion 
point to the next column and row, respectively.

4. Supply the cell contents in any order to the cell that currently contains 
the insertion point. Place the insertion point within a cell and press the 
option key to switch from the Text Editor (I-beam cursor) to the Math 
Editor (split I-beam), and click. Click outside the table or click on the I- 
beam tool to resume text editing. Use 36 shift cursor keys to move the 
insertion point (left, right, up, down) among the cells.

Array without 
bounding lines

You can edit the text and mathematics of a table by working directly with 
the cells of the table. To select and edit the contents of a cell:

1. To place the insertion point J  within a cell, press the option key to get X 
and click the split I-beam within the cell. Use 36 shift cursor keys to 
navigate among the cells.

[: :] ( : : ) { : : }  |: :| ||: :|| <: :> U U H =1

Figure 4.20 Matrix templates



2. To edit mathematical expressions, option click the insertion point 
within the structure. Use the mouse or shift cursor to make a selection. Cut 
and paste is supported.

To add rows and columns:

1. Option click to place the insertion point in a cell adjacent to the position 
of the new row or column, e.g., row 2, column 2.

2. Select Insert and a submenu from the Edit menu or use a keyboard

Insert

Rom Before 380 Q
Roto Rfter 380 W
Column Before 360 0
Column Rfter 360 P

Figure 4.21 Insert (Edit) submenu

(1,1) (1,2) (1,3)

(2,1) (2,2) (2,3)

(3,1) (3,2) (3,3)

(1,1) (1,2) (1,3)

(2,1) (2,2) (2,3)

(3,1) (3,2) (3,3)

(1,1) (1,2) (1,3)

(2,1) (2,2) (2,3)

(3,1) (3,2) (3,3)

Figure 4.22 Row before and column after, respectively

3. Supply the contents for the new cells.

To delete rows and columns:

1. Option click to place the insertion point in a cell of the row or column to 
be deleted, e.g., row 2, column 2.

2. Select Delete and a submenu for a row or column (Figure 4.23) from the 
Edit menu or use a keyboard equivalent to obtain Figure 4.24.

Delete
Rom 3€<F J
Column 380 K

Figure 4.23 Delete (Edit) submenu

(1,1) (1,3)

(2,1) (2,3)

(3,1) (3,3)

(1,1) (1,2) (1,3)

(2,1) (2,2) (2,3)

(3,1) (3,2) (3,3)

(1,1) (1,2) (1,3)

(3,1) (3,2) (3,3)

Figure 4.24 Row and column deleted

The table template supports a single row of text in a cell, but multiple rows 
can be added if you place a table within a cell. To place multiple rows of 
text in a cell:
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Table format

1. Create a table.

2. Option click to place the insertion point in a cell.

3. Optional: Select Format/Matrix Format and adjust the row spacing of 
the table within the table by dragging the icon, as discussed below. Note 
that negative values produce an overlap.

4. Select the template for a table without boundary lines 

9).

5. Supply the text. Press return for each new row; wordwrap is not 
supported.

: : j 9 and

Cell alignment The alignment (left, right, center, and decimal alignment) 
of the entries within each cell can be set before or after you create the 
table. To set cell alignment:

1. If the table has already been created, drag to select it; otherwise, skip 
to step 2.

2. Select Format/Matrix Format and click on an alignment icon (Figure 4.25 
and Figure 4.26).

Placement Line type Justification
descend

below
line

center on line

Click here to 
select

thickness and 
pattern

■ .... ca Cell spacing

B horizontal spacing = 10 points 
vertica l spacing = 5 points

0.1 100.01
1.000 10.1 cen te r

ro.i 100.01] 
Li.ooo io.i J
r o.i 100.01]
L 1.000 1 o.i J
f 0.1 100.01]
L1.000 10.1 J

le ft

r ig h t

decim al

□  flhtjn rmi»* Cancel OK

Figure 4.25 Table (and matrix) format dialog box
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Figure 4.26 Cell alignment

Cell size Cell height automatically adjusts to the size of the largest 
element in that row and the cell width adjusts to the size of the largest 
element in that column. If you change font size or style, the table adjusts 
automatically. To change the relative size of cells you can pad elements 
with space characters.

Cell spacing The minimum number of pixels of whitespace between rows and 
columns is specified by the user. To adjust cell spacing:

1. If the table has already been created, drag to select it; otherwise, skip 
to step 2.

2. Select Format/Matrix Format (Figure 4.25).

3. Drag the icons to set the minimum number of pixels between any element 
and its borders (Figure 4.27).

4. Click OK to leave the dialog box.

■ SS3 Cell spacing
horizontal spacing = 10 points 

vertica l spacing = 5 points 

Figure 4.27 Cell spacing icons

Borders and Background You can select the line thickness and pattern for 
the borders and specify a background pattern or gray scale for the entire 
table. Background patterns and gray scale can be set for individual 
elements using Text Style.

To adjust borders and background:

1. If the table has already been created, drag to select it; otherwise skip to 
step 2.

2. Select Format/Matrix Format dialog box (Figure 4.25).

3. Click in the Line type box (Figure 4.28) to select line attributes 
(Figure 4.29).
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Line type

Click here to 
select

thickness and 
pattern

Figure 4.28 Line type button

4. Use the pop-up menus to select among the 9 line thicknesses, the 39 line 
patterns, and the 39 background patterns. If you select gray scale, a scroll 
box appears so that you can establish the density of dots.

5. Click OK to leave the dialog box.

Select thickness and pattern... 
.....Outer border............................

Thickness
Pattern

....  inner border

Thickness j 
Pattern

....  Background pattern

Pattern I I

f Cancel | OK
■

Figure 4.29 Line type dialog box

Positioning a table
The wordwrap feature treats a table as a single entity and, therefore, does 
not split it across page boundaries. Note that you must not create a table 
that is wider than the column or page! A table is treated as a single 
character in a line. You control its vertical alignment relative to the rest of 
the line and its horizontal alignment. To align a table vertically:

1. If the table has already been created, drag to select it; otherwise skip 
this step.

2. Select Format/Matrix Format.

3. Click on one of the placement icons (Figure 4.30).



Placement
descend

below
line

center on line

Figure 4.30 Automatic placement in a line.

4. Click OK to leave the dialog box.

You can manually adjust the vertical position of any character using the 
Character Editor.

1. Enable the Character Editor by doing one of the following:

• Click on the upward-left-pointing arrow in the Tools window.

• Select Character Editor from the Windows/Tools menu.

• Type ££ shift [.

2. Click on the table or any character in the table.

3. Now you have two options:

• Drag the table (treated as a single character) up or down with the

• Click on the upward or downward pointing triangles in the lower 
portion of the Tools window. Continued pressing repeats the 
command; the square with an "x" restores the character to its 
baseline position.

4. Select the Text Editor by clicking on the I-beam in the Tools 
window, using the Tools submenu in the Windows menu, or by 
typing :M: shift apostrophe.

Because Math Writer treats a table as a tall, editable character, you can 
use tabs and paragraph alignment with tables. To position a displayed 
table horizontally:

1. Place the insertion point adjacent to the table on the left or right.

2. Click on a paragraph alignment icon.

Tabs are especially useful when you must align a table that is part of a line 
of text. To use tabs with a table:

1. Place the insertion point immediately to the left of the table.

2. Click on the left-align icon for the paragraph.

mouse.

1 +

X I
zx
E
V
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3. Drag a tab (left, center, or right) into the document area and release the 
mouse button when the tab reaches the desired horizontal position. This 
allows you to establish vertical alignment with other objects. When 
released, the tab automatically snaps vertically to the ruler.

4. Press tab to align the table with the tab.

5. If necessary, drag the tab to the left or right on the ruler to adjust the 
position of the table; the table automatically follows the tab.

MathWriter does not protect against an excessively wide table.

Converting a table to PICT format

A table is an editable, self-formatting structure while within M athW riter. 
Other word processors and page layout programs do not support this data 
structure; so if you must export a table, transform it into a format that is 
supported, namely PICT.

1. Select a table by dragging the mouse over it.

2. Copy it with Edit/Copy Other/Copy As Picture or SS shift C. This com
mand transforms whatever is selected, including mathematical expressions, 
text, and graphics, into the PICT format and places the transformed copy on 
the Clipboard.

3. Optional: Select Windows/Clipboard to view the contents of the 
Clipboard. The status bar reports the PICT format.

4. Paste the contents of the Clipboard into the Scrapbook or into another 
application.

M athW riter provides a more powerful approach that you will find con
venient if you need to transfer many mathematical structures or graphics 
into a Scrapbook. (See "Data Sharing" later in this chapter.) Refer to the 
discussion of Edit/Save As for the details of automatically transferring 
these into a named scrapbook when saving a file as a TEXT-only file in 
Chapter 6. In fact, this feature is intended to let you retire our expression 
editor, M athW riter™  1.4; use MathWriter 2.0 to create and format 
mathematical expressions for transfer to other page layout programs.

Deleting a table

To delete a table:

1. Select the table by dragging the mouse over it or moving the insertion 
point to the left or right of the table with the cursor keys and pressing the 
shift key and the right or left cursor key, respectively.

2. Press delete.
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Graphics
M athW riter allows you to import, display, and position graphics. This 
section describes how to treat a graphic as a "ta ll"  character within a line 
of text.

Three types of graphics files are supported by this version of M ath- 
Writer—bit-mapped images created by a paint program, object-oriented 
graphics created by a drawing program, and Encapsulated PostScript, 
created by such programs as Mathematica™ and Adobe Illustrator™, 
which combines a screen display and separate PostScript commands and 
provides high quality printed output. This feature previously has been 
available only in page layout applications. This line of text contains 
several embedded graphics w— w w-h i-m illustrating the simplest case. 
Very early word processors had to isolate a graphic on a separate line.

Placement of a graphic

• Use spaces, tabs, or paragraph alignment to adjust the horizontal 
position of the graphic.

• If necessary, adjust the vertical position of the graphic with the 
Character Editor.

To place a graphic in a line of text, M athW riter offers two techniques— 
transfer via the Clipboard and direct import from a file. To transfer a 
graphic into a line of text via the Clipboard:

1. Place the graphic on the Clipboard by using the application in which 
the graphic originated or by removing it from the universal storage 
structure, the Scrapbook, which is accessible from the Apple menu.

2. Position the insertion point in your active document to identify the 
intended destination of the graphic.

3. Select Edit/Paste Picture, the current name of that command because the 
Clipboard contains a graphic. The customary V provides the same result.

M athW riter can read three file types (MacPaint, PICT, and EPSF) without 
using the application that generated them. This has several benefits. You 
need not switch applications to transfer the files into the Scrapbook or 
have enough RAM to have both applications simultaneously in memory 
operating under MultiFinder. To transfer a graphic into a line of text 
directly:

1. Position the insertion point within your active document to identify the 
intended destination of the graphic.
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2. Select Edit/Import Graphics File.

3. Optional: Drag the pop-up menu of file types 
(Figure 4.31) to a specific type to limit the dialog 
box list to that type (and folders).

Figure 4.31 Graphics file types

4. Select a file, changing drives and folders and scrolling as necessary.

5. Click Open or double-click the file name.

Whichever method you use, M athW riter places the file at the insertion 
point. Additional adjustments may be necessary.

•

When you place a graphic in a line of text, a default baseline posi
tion is used for vertical positioning. However, with M athW riter 
you can drag a graphic (and any text character or built-up mathe
matical expression) an arbitrary distance up or down. To vertically 
position a graphic:

1. After the graphic has been placed, select the Character Editor 
(Figure 4.32).

Figure 4.32 Character Editor
2. Select one of the following options and vertical positioning icons will 
replace the superscript/subscript icons.

• Click on the Character Editor icon (the arrow that points up and left) in 
the Tools window.

• Select Windows/Tools/Character Editor.

• Type Si shift [.

3. Select the graphic. A bounding frame with small squares at the corners

4. To move the graphic vertically use these methods:

• Place the arrow cursor within the bounding frame and drag the graphic 
up or down. The typeface box in the document status bar reports the vertical 
displacement in pixels. •

• Click on the up or down arrow in the modified Tools window for pixel 
movements. Continue pressing for repeated motion, or click on the square 
between the arrows to restore the original placement.

Modifying a graphic

Suppose you wish to mask a portion of a graphic. Clearly you could return to 
the originating application to remove a portion of the picture, but there is

□
«  +

V Rll Graphics Types 
MacPaint 
PICT 
EPSF



an easier way. M athW riter allows you to crop a graphic after it is 
imported:

1. Activate the Character Editor. There are three ways you can do this:

• Select the Character Editor arrow tool in the Tools window.

• Select Character Editor from the Windows/Tools submenu.

• Type 33 shift [.

Selection of the Character Editor replaces the subscript/superscript tools on 
the Tools window with vertical positioning tools, described next.

2. Click to select the graphic. Small square 
handles appear at the corners of the bounding 
frame. If you press 33 while the graphic is 
selected, the typeface box in the document 
status bar displays "Crop" (Figure 4.33). Press
ing 33 and option reports "Crop, Proportional".

3. Press 33 and drag a handle to mask (crop) the 
lower portion of the graphic.

4. To select the Text Editor again, do one of the 
following:

■ LJ

mm + n +

£ Ll £
0̂
7

Figure 4.33 Cropping

• Click the I-beam icon on the Tools window.

• Select Windows/Tools/Text Editor.

• Type 33 shift apostrophe.

M athW riter can scale a graphic using fixed or variable proportionality for 
the width and height.

To resize a graphic:

1. To activate the Character Editor, do one of the following:

• Select the Character Editor arrow tool in the Tools window.

• Select Character Editor from the Windows/Tools submenu.

• Type S3 shift [.

Selection of the Character Editor replaces the subscript/superscript tools on 
the Tools window with vertical positioning tools, described above.

2. Click to select the graphic. Small square handles (Figure 4.34) appear at 
the comers of the bounding frame. The typeface box in the document status 
bar displays "Scale." Pressing option changes this to "Scale, Proportional."
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3. Scale the graphic either by mouse or keyboard:

• By mouse: Drag a handle to scale the width and 
height of the graphic using separate proportionali
ty constants. Press option while you drag if you want 
to assure that the width to height ratio is pre
served.

• By keyboard: When the Character Editor is active 
and a graphic is selected, the Edit menu has a new 
command—Scale Picture.

□ 9 1

III +

X I
Z\
E l
V

Figure 4.34 Scaling
• Select proportional or nonproportional and supply the scaling percent- 
age(s).

4. Click OK to leave the dialog box.

5. To select the Text Editor again, do one of the following:

• Select the I-beam icon in the Tools window.

• Select Windows/Tools/Text Editor.

• Type shift apostrophe.

To hide graphics for faster scrolling:

You can increase the scrolling speed somewhat for a graphics-laden 
document by suppressing the redrawing of the pictures.

• To suppress repeated drawing of the graphics, select Format/Hide 
Pictures.

♦  To restore graphics display, select Format/Show Pictures.

This menu command toggles between Show Pictures and Hide Pictures.

Character Manipulation
M athW riter provides you with tools to vertically position text characters, 
as well as graphics and portions of mathematical expressions treated as 
text characters, by mouse and by keyboard. In addition, it allows you to 
stretch certain characters.
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Moving characters

In contrast with the subscript and superscript templates, which 
automatically change a character's vertical position and font size, you can 
manually move any character an arbitrary distance above or below the 
baseline.

To move a character up or down:

1. To enable the Character Editor, do one of the following:

• Click on the Character Editor icon (an arrow pointing up and to 
the left) on the Tools window.

• Select Character Editor from the Tools submenu on the Windows 
menu.

• Type % shift [.

2. Click on a character to select it.

Remember to release the mouse button before the next step.

3. Move the character by mouse or keyboard.

• By mouse: Drag the character vertically to its destination. The number of 
pixels moved is reported in the typeface box of the document status bar.

• By keyboard: Click on the up or down triangles in the Tools window to 
move in pixel increments. Press them continuously to move rapidly.

4. To reset the character to its initial position, click the square between the 
triangles.

Stretching characters

M athW riter provides numerous templates that automatically self-adjust 
in size. Some manual adjustments are possible too.

Vertical bars land || in the Operators row of the Palettes menu can be 
stretched.

1. Use the mouse to place these symbols in your document.

2. To enable the Character Editor, do one of the following:

• Click on the Character Editor icon (an arrow pointing up and to the left) 
on the Tools window.

• Select Character Editor from the Tools submenu on the Windows menu.

Type 99 shift [.
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3. Click on either the | or || character to select it.

4. Press option and the bottom portion of the Tools window reads "Stretch." 
Drag either end of the symbol to change its vertical dimension.

If you do not press option, the character is simply moved without a size 
change.

5. Optional: Option click in the middle of the character to restore its 
original length.

Rather than always requiring a keystroke to signal the completion of the 
integrand, M athW riter requires a keystroke only when you want to stretch 
the default symbol size.

Suppose you type: r
x 2

Jx=0 1+sin3 x
dx, but prefer this:

m n
x 2

J  x=0
1 +sin3 x

dx.

To stretch the integral:

♦  Select Format/Calc Prev J or I Size, or press 96 D, when the insertion 
point follows the integrand to adjust the size of the integral to match the 
tall integrand.

M athW riter automatically sizes the brackets enclosing the fraction if you 
have selected Auto-bracket sizing in Style/Auto Math Options and enabled 
Style/Auto Math by menu or by using 96 E.

Mathematical Expressions
With M athW riter you can create and edit mathematical expressions 
easily. The Greek alphabet, used prominently in technical writing, 
receives special treatment.

Mathematical expressions are frequently taller than the text, so line 
spacing receives special attention. Built-up expressions are self-formatting 
and can be created by keyboard or by mouse. Various support tasks such as 
automatic sizing of brackets are optional. The find/replace feature is 
general enough to support search and replace on mathematical expressions.

M athW riter can be used solely as an expression editor if you must use a 
page layout program that does not have this capability. Simply create the 
equations one per line, save the M athW riter file, and save them in a 
Scrapbook by selecting Math Writer's File/Save As and choosing TEXT file 
type on the subsequent window. Alternatively, using MathWriter's



File/Copy As Picture you can transform individual expressions into the 
standard PICT format before placing them on the Clipboard for transfer 
into another application.

Greek letters

Since Greek characters are widely used in mathematical expressions, quick 
and convenient access to them is important. M athW riter offers several 
alternatives for accessing them: via keyboard, mouse, or the Library.

Keyboard access

To type Greek characters on the keyboard, press 96 spacebar to toggle from 
the current font to Greek and press 96 spacebar again to toggle back to the 
original font. By mouse, select Style/Greek to toggle between the fonts.

The Greek letters are taken from the Symbol font and generally have a 
mnemonic correspondence with the keyboard characters, such as "a" for 
alpha, "b" for beta, etc. Use the Apple/Key Caps desk accessory to review 
the keyboard assignments. The name of the current font appears in the 
typeface box of the document status bar; when Greek is active, Math Writer 
places a check beside Greek on the Style menu.

Mouse access
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To select Greek characters using the mouse:

1. Select Windows/Palettes Window.

B  P y S  c £ q 8 x k  A h v £ o u | p [ g | t -u $ % y | to 1 ip |ro 
T Smal l  g*ay zone

Figure 4.35 Greek alphabet

2. Drag the Palettes window, if you want to reposition it, by the tiny gray 
bar immediately beneath it (see Figure 4.35).

3. Click on Greek letters in the Palettes window to type them at the 
insertion point. As expected, pressing the sh ift  key changes the Palette to 
uppercase letters (see Figure 4.36).

m m © a & 1 2# 2 []« []*a [1* a
A B r A E Z H_ ©_ K_ A_ N_ s 0_ n p S T Y  <f> X 'F Q|r d

Figure 4.36 Uppercase Greek (and Variables) from Palettes menu

Any combination of rows from the Palettes menu can be placed on the 
Palettes floating window for more convenient access.
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Quick typeface changes

Quick type size changes

Auto Math Options

M athW riter provides three keyboard controls ( 96 <, 96 >, and 96 \) for 
rapid typeface changes. Alternatively, the same options can be exercised 
using Style 1, Style 2, and Last Style on the Style menu. Refer to the 
discussion in the first section of this chapter for more details.

M athW riter provides four keyboard controls for rapid font size changes: 
command plus, command minus, command option plus (96 "NT +), and 
command option minus (96 "NT- ). These commands increase (96 +), or 
decrease (96 —), the font size to the next size on the Text Sizes menu or by one 
point if you simultaneously press the option key (“NT). By mouse, you can 
exercise the same options by clicking Larger Size, Smaller Size, option 
Larger Size, and option Smaller Size on the Style menu. Command 
backslash  ( 96 \) and Style/Last Style revert to the immediately previous 
typeface. Refer to the discussion in the first section of this chapter for more 
details.

The plus and minus can be typed from the top row of the keyboard, or from 
the numeric keypad.

Mathematical typesetting is governed by numerous conventions. Parenthe
ses, brackets, and braces should match the size of the enclosed expression. 
The arithmetic operators in the Symbol font are considered by many to be 
more pleasing than their equivalents in other fonts. M athW riter can han
dle these operations automatically.

♦  To enable the Auto Math Options, set the Style/Auto Math Options 
(Figure 4.37) using one of the following methods.

Ruto Math Options...
(Ruailable Only Lilith Ruto Math Turned On)

36- c  0 □  R u to -S p a cin g  R round O perators 

36̂ = B ^  Ruto-Bracket Sizing
36-m  I □  R u t o -H e iic iz e

3 6 g □  It a lic iz e  Greek C h arm  tors

_  Use Symbol Font For Keyboard 
"'= ^  Generated Operators find Brackets

Cancel

Figure 4.37 Auto Math Options dialog box



120 Chapter 4

• Select Style/Auto Math Options to choose a combination of these options 
and click OK.

• Use the keyboard commands to toggle options on or off at any time.

These commands define the set of options that are enabled/disabled by Si E 
or Style/Auto Math. Because using Auto Math slows M athW riter, you 
usually enable the Auto Math command only while forming mathematical 
expressions.

Auto Math Options merely defines the combination features you desire. You 
MUST use the Edit/Auto Math (or Si E) to actually enable the options!!

Mathematical structures

When Auto Math is enabled, the typeface box on the status bar of the 
document appears in inverse, white on black (Figure 4.38).

Times 12

Figure 4.38 Auto Math enable-indicator

First, let's look at a few general principles. The Templates and Tools 
Windows provide self-formatting templates for key mathematical 
constructs. For convenience, these templates can be selected by mouse and by 
keyboard. M athW riter automatically handles the changes in font size and 
vertical placement.

The templates provide the structure and special symbols needed to create 
them. The template positions the insertion point for entry of the first 
expression, which can be arbitrarily complex. After you enter an 
expression, which can include several templates, press enter to position the 
cursor for the next expression. In matrices and tables, press return to advance 
the cursor to the next row and tab to advance to the next column.

Enter and return serve different purposes.

To edit in mathematical expressions you need a split I-beam cursor. When 
you click outside the structure, the traditional I-beam Text Editor is 
restored; to resume editing in a built-up expression, press option ("NT) and 
click to position the split I-beam cursor anywhere within the expression.

Because mathematical expressions reformat continually as you type them, 
remember to use Format/Line Spacing to assign automatic spacing during 
document creation.
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Fixed spacing must NOT be used while composing mathematical expres
sions because the portion of the text outside the line will be clipped and is 
outside the screen refresh zone.

You can use 96 option Z to refresh the screen any time necessary.

The following examples illustrate the use of the Templates and Tools 
windows.

Throughout these examples assume that the Templates Window and Tools 
Windows have been selected on the Windows menu and that Automatic 
Line Spacing has been selected using Format/Line Spacing (or 96 K).

Displayed equations are often created using a left-aligned w- paragraph 
with the equation centered using a center tab ♦  and a right-aligned tab i 
positioned for the equation number near the right border. (Remember to 
center the equations with a center tab; DO NOT center-align the 
paragraph. If you used a centered paragraph, the right-aligned tab would 
not work for equation numbers, making placement uneven.) If this equation 
ruler is not compatible with the ruler for the text, use Copy Other/Copy 
Ruler & Format (command shift A, i.e., 96 CM) with Paste Other/Paste 
Ruler & Format ( 9% O  Z) to establish it quickly when needed.

Superscripts

Now let's look at the box below that contains instructions for you to follow 
to create superscripts. For the sake of convenience we used the Times font 
and disabled Auto Math. Use 9% E to toggle the selected combination of 
options on or off; when they are enabled, the typeface indicator in the 
status bar appears in inverse, white on black. The first row contains the 
actual characters that you type. The second row offers keyboard 
equivalents when possible. The third row, baseline, illustrates when you 
are on the baseline of an equation and when you move up or down. The 
abbreviation "sp" means press the spacebar.

To create equation [1], follow the boxed instructions.

y = a x 2 + bx + c [1]

action y sp = sp a sp X 0 2 l ’A sp + sp b sp X + sp c

keybd eq. cmd-] enter
baseline Base T Base
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Here are a few more tips. The same four keys used 
with 96 -O to obtain the four editors are used with 
96 to obtain the center above, superscript, center 
below, and subscript commands. M athW riter au
tomatically adjusts the position and font size for 
superscript. The T in the status bar indicates that 
the cursor is one level above the baseline. Pressing 
enter removes one level of nesting, in this case 
moving the insertion point from the superscript 
position back to the baseline. The status bar box 
again reports "Base." Two up arrows would in
dicate that the insertion point is in a superscript to a superscript. One up 
arrow followed by a down arrow would indicate that the insertion point is 
in a subscript to a superscript.

Edit an equation
2

Let's change y = ax  + bx  + c [2]

into y = a x *  + hx + c [3]

First, remember that editing in a built-up mathematical structure is a 
generalization of editing in ordinary text. The I-beam, text editing cursor 
must be replaced by the split I-beam, math editing cursor to edit characters 
that do not directly touch the normal text baseline.

1. Therefore, select the Math Editor by doing one of the following:

• Press option if the cursor is an I-beam.

• Click on the split I-beam j^ j in the Tools window.

• Select Math Editor from the Tools submenu of the Windows menu.

• Type 96 shift semicolon.

The arrangement of the keyboard equivalents for the four editors 
(Character, Sidebar, Math, and Text) corresponds to their arrangement on 
the Tools window. The Sidebar Editor is unavailable in this version.

2. Click at the bottom-right corner of the superscript to position the 
insertion point after "2".

3. Pressdelete to remove "2", leaving the insertion point in the superscript 
position.

4. Type "4".

5. Click outside the expression to restore the Text Editor.

The keys for sub and 
superscripts, 

(obtained with 96 
and [ ]; ’ ) 
correspond in 
position to the 
icons
E 0

0 0  in the Tools.
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Mathematical expressions are fully editable in the context of a document! 
Simply position the split I-beam cursor to add and delete. Drag to select 
expressions within "bounding rectangles," etc. Editing is not limited to 
simple replacements as in this example; you can make arbitrarily complex 
changes. The expression is automatically reformatted with each keystroke. 
If you select and change the font size of an expression containing 
superscripts, for example, M athW riter will scale all font sizes to preserve 
the size relationships established in Style/Metrics.

The insertion point movement handled by mouse in the previous exercise can 
be controlled by keyboard too.

f. Use the four cursor arrow keys to move the I-beam to the immediate 
right of the character with the exponent.

2. Type the superscript command, ST ], to place the insertion point to the 
right of the superscript.

3. You could complete the exercise as in the previous example. A different 
method is to type shift left arrow to select the "2" and then type "4".

To save your work, use one of these options:

• File/Save (ST S) to use the existing file name, file type, and destination. 
You will be prompted if these have not been previously specified.

• File/Save As... to change the existing file name, file type, or destination. 
These changes apply to the active document and the previously active file 
is closed and left unchanged.

• File/Save A Copy to save a copy with a possibly different name, file 
type, or destination WITHOUT making this new file the active document.

M athW riter keeps the entire active document completely within RAM for 
greater speed; this makes frequent saving to a file a prudent action. Unless 
you change the default, files will be saved every fifteen minutes.

M athW riter automatically saves a file if you click AutoSave in File/Doc 
Preferences. You can even indicate how often you want the program to save 
your file. The type-ahead buffer saves the keystrokes you type during the 
file saving activity, letting you continue typing. When you are composing 
an original manuscript, we recommend an additional step—keeping a copy 
of the immediately previous file version too—using the automatic backup 
feature, also enabled with File/Doc Preferences. Click the "Warn me before 
saving" option on Doc Preferences to avoid accidentally replacing a good 
file copy with one that might be in the midst of a major revision.
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M athW riter supports several file types. The comprehensive Math- 
Writer™ 2.0 format preserves the document and all the information 
required to re-establish the complete editing environment as you left it 
when the file was saved. Use Save As with the TEXT file type to save the 
text as an ASCII file without character formatting. This command also 
permits you to automatically extract the graphics and mathematical 
expressions and place them in a named scrapbook for transfer to another 
application. TEXT files can be read by many different applications.

When other translators become available, simply place them in the system 
folder or in the folder with M athW riter before startup and they will be 
added to the File Type pop-up menu automatically. A standard file inter
change format filter (Microsoft's RTF standard) has been written for 
M athW riter. This filter allows M athW riter to read files from all major 
Macintosh word processors and to preserve character formatting, headers, 
footers, page numbering, graphics, graphics placement and even translate 
the embedded, nongraphic mathematical expressions of Word 4 documents 
into "WYSIWIG" editable mathematics. Mathematical expressions 
created by traditional mathematical expression editors, including 
MathWriter 1.4, are received as uneditable PICTs.

Fractions

We will show you how to create the fraction in equation [4] (from linear 
feedback control theory):

K 2
G(s) = —----------------------  [4]

s2(\+ T f s ) il+ T m s)

K2
G(s) = --------------------------------- (not italicized) [4a]

s2 ( l + T f s ) ( l + T m s)

First, here are some general comments. The Templates window provides 
three constructs for fractions on the pop-out menu (see Figure 4.39). All three 
are self-formatting, including adjustment of the length of the fraction bar 
and centering of the numerator and denominator. The first uses the current 
font size as the base, while the second immediately decreases the base font 
size to the next smaller menu size to reduce the display height. The third 
provides a slanted fraction bar.

Figure 4.39 Fractions templates

To use a self-formatting template, such as the fraction: 

• Press on the category icon [£], and the menu pops out.
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• Drag to the first icon | | and release the mouse button.

The keyboard equivalents for steps 1 and 2 are: Press 96 1 and then 1.

The general numbering scheme is 96 row number and then the column number. 
If you pause after typing 96 row number, the menu of icons pops out with tiny 
column numbers to identify them. Type the keyboard equivalents quickly if 
you do not want this prompting menu to appear. Furthermore, if the 
Templates window is NOT displayed, type quickly or the command will be 
aborted.

Enter the numerator and the denominator, in that order. Press enter to 
advance from the numerator to the denominator or to exit the template. 
Both the numerator and denominator can be built-up expressions of 
arbitrary complexity.

To exit a built-up expression and return immediately to the baseline, press 
return, instead of enter.

To create the numerator "K2", use the instructions box that follows:

action K 0 2 l'A

keybd cm d-apostrophe enter

baseline T u T

1. The subscript icon 0  is located on the Tools 
window. The keyboard command for a subscript is 
96 apostrophe. The adjustments of font size and 
vertical placement of the subscript are handled 
automatically.

2. Move the insertion point to the denominator. A 
down arrow indicates that the denominator has 
been entered.

action I 'T

keybd enter

baseline 1

The placement of 
keys [ ] ; ' for sub 
and superscripts 
(pressed with 96) 
correspond to the 
positions of
E 0
0 0  on the 
Tools window.

3. Complete the denominator.

action s 0 2 1% sp ( ) l'A

keybd I enter etc. enter

baseline I I T i 1 Base
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Parentheses, brackets, and braces

Automatic-sizing of parentheses, brackets, and braces is handled by the 
Auto Math feature, which you normally enable only while you are creating 
an equation. First, you select the options in Style/Auto Math Options 
(Figure 4.40). Then you enable them by selecting Style/Auto Math.

To create the parentheses in [5]:

Cp — Cy — — T^ ” v ' d p 'dv_
dT

JP
ydVj.

[5]

1. With the mouse, select Style/Auto Math Options and check all options 
in the set to be enabled together. From the keyboard you can also use 
command option letter to add/remove each option, even when the dialog 
box (Figure 4.40) is not visible.

Ruto Math Options...
(Ruailable Only Lilith Ruto Math Turned On)

0 □
B
1 □
G □

S 0

R u to -S p a cin g  Ground O perato rs 

Ruto-Bracket Sizing

R u t o -ilo iW iz e  

! ta iic iz o  Greek €hara< ters

Use Symbol Font For Keyboard 
Generated Operators Rnd Brackets

■A
Cancel OK------------  1 J

Figure 4.40 Auto Math Options

2. Enable Auto Math by clicking Style /Auto Math with the mouse or typ
ing 96 E from the keyboard. In general, toggle this feature on when creating 
each displayed equation and toggle it off when you finish. The typeface 
indicator in the document status bar at the bottom of the document window 
uses white letters on a black background while this option is activated.

3. Click Windows/Palettes Window to place the floating Palettes Wind
ow on the screen. Then click the Math/Calculus row in the Palettes menu to 
place it in the Palettes window.

A portion of this equation, Cp - C v = - T ,  is created using the techniques of 
the previous example so only the extensions are discussed here. Follow the 
directions shown in the box below.
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'3V
KdT

\2 /

JP

3P
3F /

[6]

M athW riter automatically stretches the standard parenthesis, brace, or 
bracket to match the size of the expression. Enter the numerator and then 
the denominator. Obtain the partial derivative symbol from the 
Math/Calculus row of the Palettes menu. Frequently used palette symbols 
can be copied to the floating Palettes Window for rapid access.

Practice

Test your skills with the following practice problems. We assume you will 
go through these sequentially, so we will not repeatedly instruct you on 
techniques already discussed. First, practice with subscripts in an 
expression that relates stomatal pore width to the pressure in the guard 
and surrounding cells.

W = b0 + bg Pg + bsPs when VP > 0 [7]

We used a center tab to position the equation, a left tab for the condition, 
and a right tab to align the equation number. We supplied the equation 
number by pressing command option E ( 96 "NT E).

The following example,1 2 illustrates that superscripts can be built-up 
expressions. If you create a more complex superscript, pressing enter 
eventually brings the insertion point back to the base level. With the 
mouse, select rho from the Greek alphabet on the floating Palettes 
window; or type 96 spacebar to toggle to the Symbol font, which includes 
the Greek alphabet as indicated in the typeface box in the status bar. Type 
"r" for rho, and type 96 spacebar to return to the previous font.

This example also illustrates that a variable can have both a superscript 
and a subscript; they can be entered in either order.

G2= f 2m 2/3 p l2P CR [8]

In the next example,3 Auto Math substitutes the keyboard version of the 
operators with the Symbol font equivalents.

1 Cooke, J. R. et al. 1976. A finite element analysis of guard cell deformations. ASAE Transactions 19(6): 1107-1121.
2 Cooke, J. R. 1972. An interpretation of the resonant behavior of intact fruits and vegetables. ASAE Transactions 
15(6): 1075-1080.
3 Cooke, J. R. and R. H. Rand. 1980. Diffusion resistance models. Ch 5 in Predicting Photosynthesis for Ecosystem 
Models. J. D. Hesketh and J. W. Jones (ed). CRC Press 1:93-121.
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R = Rh + Rs = (a/D) [ T + [ p 2 In (4/a) + Lpp 2 / a - p\) [9]

The next example4 illustrates the use of subequation numbers and special 
alignment. You establish the style of subequation numbers by selecting 
Format/Variables Format, clicking subequation # in the subsequent 
window, and clicking the buttons beside the style you want.

• To create equation numbers [10a] through [lOf], click on the subequation 
number icon [JTI on the Variables row of the Palettes menu to insert a 
subequation number in your text a t . the blinking insertion point. The 
variables row can also be placed on the Palettes floating window version of 
the Palettes menu for convenient access.

(al+a2co2) 2-(a i w2- a li)(a5 (O2- a ()= 0  [10]

where ax=K  [10a]

a1 = M RL  [10b]

ai = [(ji/3) + M]L2 [10c]

a4 = S + K[(ji/2 + M]gL [lOd]

a5 = (V 5 )M R 2 [lOe]

a() = MgR + K [lOf]

The volume of an apple [11] can be modeled over the entire growing season 
using bispherical coordinates.5 Geometrically, this means rotating a sphere 
about a chord.

Astonishingly, the width to height ratio changes such that both surface 
area and volume increase linearly with time.6

V= [2 7i/3] [a/sin 0]3 [3 sin 6+3 (n -  0) cos 6 - sin3 6] [11]

where 6 is found from [11a].

4 Cooke, J. R. and R. H. Rand. 1969. Vibratory fruit harvesting: A linear theory of fruit-stem dynamics. Journal of 
Agric. Engineering Research 143:195-209.
5 Cooke, J. R. and R. H. Rand. 1969. Vibratory fruit harvesting: A linear theory of fruit-stem dynamics. Journal of 
Agric. Engineering Research 143:195-209.
6 Cooke, J. R. 1970. Mathematical determination of surface area and volume for developing apple, lemon, and peach 
fruits. ASAE Paper No. 70-388. 36 pages.
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W/ H = [Ha]

Equation [11a] illustrates the use of a vertical grouping bracket to 
distinguish between the conditions for a dimpled apple shape and a 
spindle-like lemon shape, including a sphere. This self-formatting 
structure is a matrix without the enclosing bracket on the right. Notice the 
cross-reference to the equation in this paragraph; if MathWriter renumbers 
equation [11] as a result of the addition or deletion of equations during the 
writing process, it also automatically updates this cross-reference.

To create equation [11a]:

1. Select the template from the Templates window by dragging to row 8 
and then to icon 1 or by pressing 96 8 and 1 in quick succession.

2. Create row 1, column 1.

3. Press tab to create a new column and return to create a new row.

4. Supply each cell as required. The enclosing bracket expands as necessary.

5. Optional: Use Format/Matrix Format to adjust the cell spacing, align
ment within cells, line characteristics, and background characteristics.

The next example7 illustrates a parametric representation of a doubly 
elliptical toroidal shell used to perform a stress analysis of a stomate, 
which is the valve that regulates gas exchange in plants. You can type the 
Greek letters using 96 spacebar to toggle between the Symbol and the current 
font.

x = cos 0 {B + /t • B [ 1 + sin 0] [(>4 cos 0)2 + (B sin 0)2] (l/2)} [12]

y = sin 6 {A + B ■ C [ 1 + sin </>] [(A cos d f  + (B sin 0)2]~(:172)} [13]

z = cos0 [14]

whereO<9< n/2, -n /2 < tp < n /2  [15]

The equations of motion8 for the free vibration behavior of a three-degree- 
of-freedom double pendulum model for the detachment of fruits make use of 
diacritical marks.

7 Cooke, J. R. et al. 1976. A finite element analysis of guard cell deformations. ASAE Transactions 19(6): 1107-1121.
8 Cooke, J. R. and R. H. Rand. 1969. Vibratory fruit harvesting: A linear theory of fruit-stem dynamics. Journal of 
Agric. Engineering Research 143:195-209.
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l(H/3) + M]L2 0+M LR <j> + S9+K(0-<p) + [(Li/2) + A f)gL6=0  [16]

(l/5 )M R 2 <j>+MLRQ+K(<t)-d) + MgR<l)=0 [17]

(2/5) M R 2ijr+C y/=0 [18]

♦  To use the diacritical marks:

1. With the insertion point to the immediate right of a character, select 
the double dot symbol for time derivative on the Diac menu.

2. Adjust the vertical position of the diacritical mark with the Raise (99 
R) or Lower (96 L) command.

The second derivative in Matheiu's equation [19] uses the fraction and 
superscript templates.

,2
—^ + [£^ -0! a d 2cos f2r]y = 0 [19]
d t2

Equation [20] gives the radial component of velocity of a spherical seed9 
rolling along the nonradial vane of a rotating disk.

_ i  1/2
2 H r  ^  2 2-------hr ft)m [20]

This example uses a diacritic, as discussed above, the fraction template for 
reduced font size, self-formatting stretch brackets and braces, and an 
exponent for a stretched brace, as discussed next. Remember that you choose 
the combination of formatting features using Style/Auto Math Options and 
then enable/disable all in the selected set using Style/Auto Math (or 99 E).

♦  To enable self-sizing brackets and braces:

1. Select Auto-bracket sizing in Style/Auto Math Options.

2. Click Style/Auto Math or type 99 E to enable Auto Math.

3. Toggle this feature off (99 E) when the equation has been entered.

♦  To use the reduced font size fraction template:

9 Cooke, J. R and J. W. Dickens. 1971. A centrifugal gun for impaction testing of seeds. ASAE Transactions 14(1): 147- 
155.



Technical Writing 131

1. Click the second fraction template or type 1 and 2.

2. Supply the numerator.

3. Press enter to move to the denominator.

4. Supply the denominator.

5. Press enter to leave the denominator.

To achieve the effect of a magnifying glass, select text and choose a larger 
font size; the font size relationships are preserved. Edit the expression, 
select the same text again, and restore the original font size.

• To use a superscript with a stretched brace, the normal superscript 
procedures apply.

The following equation10 using Hankel wave functions illustrates most of 
the features used in the previous examples—alignment of multiple equa
tions, self-formatting brackets and braces, subscripts and superscripts on the 
same variable, Greek letters, equation numbering, etc.

u(z,t) = Tav + B exp[; (w t -  £)] 

v(r,z,t) = Tm +A H(\1V ) exp [i (cot- £)] 

where ft - a\j (Q/c )̂ 

h=Va/(o

7= (m'aca'(t)t) / ks

NBi = (h a /ks)

(')/a  _ E l__ « ( l)B=A[H&l>W) -
N,Bi

■V7
Ay

P
Wo(1)03> j8/3/2 +

-i-i

vtf,(1)03) "bi

[21]

[22]

[23]

[24]

[25]

[26]

[27]

[28]

The next example is taken from a paper11 that demonstrates the conditions 
that allow stomatal pore width (which regulates gas exchange between a 
plant and its environment) to undergo rhythmic opening and closing when a 
plant is subjected to a completely nonvarying environment.

10 Scott, N. R. et al. 1982. Analysis of earth-air heat exchange. Lawrence Berkeley Laboratory Report. 72 pages.
11 Rand, R. H. et al. 1981. Hopf bifurcation in a stomatal oscillator. Journal of Mathematical Biology 12: 1-11.
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5 -  aXQfy + G ^  + q=„ (Gg + Gnn)

 ̂k2(k\ + k\) q2 

d+*3)6

6 (l+ it3r  4 k\ 
------------- + ------

to

[29]

[30]

The pressure in stomatal guard cells and the surrounding cells can be 
described by a system of second order, nonlinear ordinary differential 
equations.12

2V*°where L  = --------

h,=-[l+(7t°/eg)] 

* 2 = [l+(j§/eI)] 

(0 = ^  

b4 = (jl°-7$

wj>J +'

fe5 = eV[l + (jt°/ep]

f>6 = -(eV +2e4V )[l+ (*?/£,)]

b £ t)= -e V  \

h) = (V(n0s - n 0f,) + 2eAV(\Vr+n0s) 

-  2 eAVRp
S\ = ------—-----  (9n~9a)

[31]

[31a]

[31b] 

[31c] 

[3 Id] 

[3 le] 

[3 If] 

[3 lg] 

[3 lh] 

[311]

[3 lj]

M athW riter easily handles the matrix form of this system of equations. 
Use the matrix templates ( 3G 9 and 1; 36 9 and 3) to form the vectors and 
matrices. Use Format/Matrix Format to adjust the placement, line type, 
justification within element cells, cell spacing, and row alignment within 
matrix equations. Tab creates new columns and return creates new rows. To

12 Delwiche, M. J. and J. R. Cooke. 1977. An analytical model of the hydraulic aspects of stomatal dynamics. 
Journal of theoretical biology 69: 113-141.
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edit within a matrix, use the Math Editor (Tools submenu of Windows) to 
position the insertion point. The cursor keys used with 98 O  moves the 
cursor among the elements of a matrix. Use the Diac menu to apply and 
adjust the diacritical marks.

A study13 of parametric excitation of nonlinear normal mode behavior of a 
fruit-stem model for vibratory fruit harvesting reveals a strong dependence 
of resonance upon amplitude of oscillation when you want to harvest 
cherries without stems attached. Equation [32] is a matrix equation where v 
is the horizontal component of the forcing function and f) is the vertical 
component of acceleration of the stem.

Ax+Bx=V [32]

where

0
x = [32a]

(g/3 + M) L 2 MLR  

M LR 7/5 M R 2

S + K + (tV 2 + ML) (g + 'q) - K

- K  K + MR(g + ri)

-(EV2 + ML)£,

-  M R ^

[32b]

[32c]

[32d]

Bold Greek letters, such as v, display correctly on the screen and on 
ImageWriter output, but unless you use the Symbol font supplied with 
MathWriter the boldface style will not print in boldface on a LaserWriter.

The water status in plants is often studied using a pressure chamber14 to 
force sap from the stem of an excised leaf. The results can be expressed in 
series form as in equations [38]—[40]. Two summation templates in 
M athW riter provide for displayed (96 4 and 1) and inline (98 4 and 2) 
series. These can also be selected from the pop-out Templates window. The 
insertion point moves immediately, when the symbol is placed, to the 
lower limit; when you finish, press enter to move to the upper limit. 
M athW riter automatically positions both limits horizontally and reduces

13 Rand, R. H. and J. R. Cooke. 1970. Vibratory fruit harvesting: A non-linear theory of fruit-stem dynamics. Journal 
of Agric. Engineering Research. 15(4): 347-363.

14 Stroshine, R. L. et al. 1985. Analysis of resistance to water flow through wheat and tall fescue leaves during 
pressure chamber efflux experiments. Plant, Cell and Environment 8: 7-18.
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the font size. Use the split I-beam Math Editor to edit within these limits.
o° ^

<Rr,t) = TW+ - (-  (r0) V  t~ X" ' sin \(njt/ rrf r] [33]
r nn = 1

k 4
Vr( x j ) = - - ±  +

*3
m=  1 ,3 3 . . .

4 0|
— exp (Hm0 sin (A.„,x) 

m k
[34]

P M  =
-  16 a ,*,/2 e*p(tw) . ,

Mm „  3 sln (*•!> X)

= 1 ,3 3 . . .

[35]

The electrostatic charge on an elliptical disk conductor is analogous to the 
diffusion from an isolated elliptical surface.15 The result [36] is expressed 
using the integral and square root templates in the elliptic integral [37],

where

Q=

K(e) =

2 k D C0 a

m

n 12 d (j)

=0 V (1 ~ £2 sin2 P

[36]

[37]

, 2  fland e = — [38]

♦  To create the integral symbol with automatic spacing around the 
operators perform the steps in the table (which are summarized in the 
numbered steps 1- 4):

[•TC / 2 

'♦ = 0

* 5 1 = 0 enter n sp / sp 2 enter

1. Type $6 5 and 1 to select the integral that has the insertion point in the 
lower limit of integration. The limits can be built-up expressions of 
arbitrary complexity.

2. Supply the lower limit and press enter.

3. Supply the upper limit of integration and press enter.

4. If necessary, option click in either limit to edit.

15 Cooke, J. R. 1966. Some theoretical considerations in stomatal diffusion: A field theory approach. Acta 
Biotheoretica 173: 95-124.
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5. Create the integrand using the keystrokes in the following table. 

dtp

\j(1 - £ 2) sin2 0

98 I 1 d <|> enter 98 2 1 ( 1 — e 98 ] 2 enter ) sp s i n 98 ] 2 enter <|) enter enter

6. After completing the integrand, press 98 D to resize the integral sign. 
Only if the integrand is tall must you adjust the integral size. If you prefer, 
you can manually stretch the integral symbol (Figure 4.41).

♦  To manually stretch an integral:

1. Enable the Character Editor.

2. Click on the vertical shaft of the 
integral symbol above the midpoint.

3. Press option to enable the stretch
ing capability (see Tools window).

4. Drag upward to stretch the rec
tangular frame around the integral 
and its limits to obtain the desired 
height.

5. Optional: To restore the default height of the symbol, option click on 
the vertical shaft of the integral symbol at  the midpoint.

6. Enable the Text Editor again.

The above procedure also applies to the stretching of | and || characters 
obtained from the Palettes menu.

,irt 2 d(j>

0 Ji/(1 + e2 sin2 't'
U i

H D iHiji +
[ B d4. Y

V ( l  + £2 sin2 4 X I

diji H
\7

'/ (! + s2 sin2 4 stretch

Figure 4.41 Integral stretching

This component of the classical Navier-Stokes equation [39] includes most 
of the structures of the previous examples. Notice that Times and Symbol 
fonts are the workhorses for these equations.

dvr dv 

~dt +V‘

v0 dvr 

r dr r dd

dv,.
—  +v2 —r dx\

dp
dr

+

d_
dr

2_
72  ~de + P8r [39]

In order to analyze the transmission of energy through a tree subject to a 
sinusoidal oscillation, a finite element model of an assemblage of branched



136 Chapter 4

tapered columns was studied.16 To adjust the integral in [40] we used Auto 
Math Options and the Calc Prev J or | Size (Format) or D with the 
insertion point immediately following the integrand.

Before we adjusted the integral size and matrix row alignment:

♦  To calculate and adjust the size of the integral symbol automatically:

1. Place the insertion point after the integrand.

2. Press 9$ D (or use the Edit menu), and M athW riter sizes the integral 
sign.

♦  To align the rows of the matrices in an equation:

1. Select the matrices.

2. Select Format/Matrix Format.

3. Check the Align rows box.

4. Click OK.

The remaining examples illustrate some typical calculus problems.

[40]

After adjustments:

[41]

[42]

\+x
[43]

v du/dx -  udv/dx [44]
V

16 Upadhyaya, S. K. et al. Limb impact harvesting, Part I: Finite element analysis. Transactions ASAE 24(4): 
856-863.
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d v du/dx -  u dv/dx
--------- -- ---------

256 =2

r(z)
z eyz no4>-*

n =  \

Z <  oo

Vt(z) =  z exp (yz) S  r= 1 t( 1 + z/«) exp (-z/n)], | z | < oo

i d / - 2) - '  1 1
n = l l2 22 32

^  (~z2/4)r

2 ) J—t ii T(v+x+ 1) 
x=0

f
J jr=0

xdx= — = t  —— =2 
0 2 2

J M rfv = M V -  J V du

f , ,./i , (az + fc)"+1 ,(ax + b) dx = ----;—- — ,n *  -1J «(«+!)

f W(') fWr) 5 db
fix,c) dx = — f(x, c) dx + f  (b,c) -------J[a,c)

dcJatc) Ja(c) OC dc

y=  lim I 1 + -  + 4 + 7  + ---- Inm
m ->OO I 2  3 4

Use Si 7 and 1 to create the limit (not [ T ] ).

-11/2

dx

l(a+bx)(c+dx)] 1/2

(-bd)

-1

1/2
arctan -d  (a+bx) 

b(c+dx)
, bd<  0

(~bd)

2

1/2
arcsin

f 2bdx+ad+bc'
be -  ad

, b>0,d<0

(bd) 1/2

[45]

[46]

[47]

[48]

[49]

[50]

[51]

[52]

[53]

[54]

[55]

[56]

In | [bd  (a+ b x )X/2 + b(c+ d x )lf2 |, b d > 0
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The self-sizing bracket (96 8 and 1) is a matrix with 3 rows and 1 column 
without a closing brace.

Find/Replace for mathematical expressions

In the previous chapter we discussed the find and replace capabilities for 
locating and replacing text and text styles. Having discussed the creation of 
mathematical expressions in this chapter, we can now extend that 
discussion.

M athW riter can find and replace built-up mathematical expressions and 
portions of an expression that extend to the baseline, i.e., expressions that 
can be selected using the I-beam Text Editor. However, the built-up 
expression must be created within the Find/Replace (Edit) (or 96 F) dialog 
box; only text can be pasted into the Find/Replace window.

Suppose you wish to search for (X 2 and replace it with [5 3.

1. Position the insertion point in your document where the search is to 
begin.

2. Select Edit/Find/Replace (96 F) to access the dialog box (Figure 4.42).

3. Create the expression you want to locate in the upper box opposite Find:.

4. Create the expression to replace the located expression in the lower box 
opposite Replace with:.

5. If necessary, set the search conditions:

Restrict the two general categories using the two corresponding subcatego
ries.

• Set the "Match" pull-down menu to "Text".

• Set the "Affect" pull-down menu to "Text".

6. Optional: Select a search direction in the pop-down Direction menu. The 
search begins where the insertion point is currently located.

7. Direct the search by mouse from the dialog window (Figure 4.42) or by 
keyboard.

8. Click the Find button or type 96 G to initiate the search with the dialog 
box visible or press return to hide the dialog box and initiate the search.

9. When a match is found, click Replace, then Find (or to separate the 
steps click Replace and then click Find), or type 96 H to make the substitu
tion and then 96 G to resume the search.
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F—------------------------------------------------------- — --—---------------
Match Affect Wildcards Special Direction [ 

Find:

Replace with:

[ Find %G )

Figure 4.42 Find/Replace dialog box

10. To continue the search, repeat step 8.

When using the mouse, the Find, then Replace button combines the Find 
and Replace buttons.

<x

[ Replace, then Find | [Replace 3€H] | Replace All 1

If desired, use 96 F to retrieve the dialog box when using a keyboard 
directed search.

When the dialog box is visible, the "thermometer" scale to the right of the 
Direction menu indicates the starting position of the insertion point and the 
progression of the search through the document. When the dialog box is 
hidden, a larger screen area is available for viewing the document.

Wildcard searches on mathematical expressions

In the previous chapter we discussed text wildcard characters that you can 
substitute for a single character [?{ or any leading or trailing string of 
characters jwordj in a match. For example than and then can both be found 
using thl?jn, with the single character wildcard. On the other hand, the 
word wildcard iword; would allow the search "Jojvord! "to find both Jones 
and Johns, and "|^?.^.iarch" would find both search and research, although 
the number of characters differs.

The analogous wildcards for mathematical expressions are
?=F VI

The first matches any built-up mathematical expression that extends from 
the baseline, the second illustrates a category (or row) from the Template 
windows, and the third illustrates a match for any specific template 
selected from the Templates window.
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The first wildcard would match all three of the following, the second 
would match the second and third, and the third would match only the 
second.

To search with a mathematical wildcard:

1. Position the insertion point in your document where the search is to 
begin.

2. Select Edit/Find/Search (or 36 F).

3. Place the insertion point in the large Find: box.

4. Select one of the three wild cards from the Wildcards menu Structure 
(i?*j), or click on one of the ten template categories from Template Category, 
or on one of the 51 templates from Template Object and click OK.

5. Click on Find or type 36 G to initiate the search.

6. Click on the close-box to terminate the search.

The usual cut, copy, and paste techniques apply to mathematical expres
sions alone and those intermixed with text. However, the format used to 
represent editable mathematics is unique to M athW riter, so the usual 
techniques only allow you to cut and paste within and among M athW riter 
documents. Therefore, to transfer mathematics to the Clipboard in a stan
dard (PICT) format:

1. Select the mathematical expression.

2. Use Copy Other/Copy As Picture from the Edit menu to convert the 
selected material into the PICT format before placing the selection on the 
Clipboard.

This works for mathematics, text, and graphics. The mathematical expres
sions that originated in M athW riter can be pasted back into M athW riter 
from the Scrapbook for further modification, if necessary.

However, if the PICTs are modified in a drawing program and transferred 
back into M athW riter or into another application such as a page layout 
program, such expressions will be treated as pictures, rather than as edit
able text.

Even though M athW riter provides tools not included in a conventional 
word processor, we tried to configure the program for those who do not want

Mathematics and the Clipboard

Customization
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to write mathematics as well as those who do. For example, if you do not 
ordinarily encounter mathematics, you should not be burdened by the tools 
used only for that purpose.

M athW riter helps you avoid repetitive startup tasks by providing two 
levels of customization—one that applies to M athW riter, regardless of the 
document, and one that is document specific. Since most of these techniques 
have been considered throughout this and the previous chapter, we give 
only a general summary here.

Global preferences

Certain configuration choices remain relatively constant from one document 
to the next and from one working session to the next. To avoid repetitively 
setting these conditions, M athW riter stores them in the M athW riter Prefs 
file placed in your system folder during your initial session and whenever 
you choose any of the defaults. You set many of these global conditions using 
Preferences on the File menu.

To return to the original defaults, simply place the current Prefs file in the 
trash, and M athW riter will create a replacement. Note: Document-specific 
defaults are stored in each document or in MW Default file templates 
accessible from the New (File) submenu.

The MathWriter Prefs file contains the following categories.

• File/Preferences dialog box

Default file name and volume reference of the file opened at startup

Floating window selection and position at startup (Font Table, Tools, 
Templates, and Palettes).

Combination of symbols in Palettes window at startup 

File warnings at startup 

Enable Screen auto-refresh

• Windows/Font Table 

Name of last selected font

• Format/Matrix (table) format

Placement, Line type, Justification within cells, Cell spacing, Alignment 
within rows
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• Style/Text sizes

Last used Other Font Size

• Edit/Check Spelling

Name and volume reference for main and user dictionaries

State of check boxes in spell-checker (Alternates, All caps, Repeated 
words)

• File/Print

Most recent choice of LaserWriter Paper motion configuration

Local preferences

The typeface and even some of the contents of various document types 
remain constant. M athW riter's primary customization technique is the 
creation of template documents as MW Default Files using the Save As 
(File) command. Math Writer files store not only the contents of a document 
but the complete specifications of the editing environment that existed 
when the file was saved. Therefore, when you open an existing file, you can 
resume work at once. MW Default Files have one additional important 
attribute—they serve as a template that you can copy to form the basis for 
a new working environment. Therefore, each combination of features and 
the initial contents of the document preserved in this form becomes a type of 
stationery. You can create such a file for each of your major tasks. The 
names of the default files appear on the New submenu for convenient 
selection if you store the master copy in the system folder or in the same 
directory as MathWriter.

If you select New, but not one of its submenu entries, you open a blank 
generic file.

Producing a list of all the features you can preset with this technique 
would be exhaustive. Instead, a few of the more important and some of the 
less important but obscure possibilities follow.
• Page Layout (margins, headers, footers, gutter, facing pages); Printer 
Setup (Printer type, paper size, paper orientation, enlargement percentage, 
printer special effects) •

• Document Layout (styles 1 & 2, footnote & endnote typeface, auto-save, 
auto-backup, file compaction, smart quotes, fractional character widths)

• Printer options, print sides, type of LaserWriter

• Format (ruler and units, spacing before and after paragraphs, line 
spacing)
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• Matrix format (row and column spacing, line type and pattern, 
justification within cells)

• Variables format (dates, time, page footnote, page, equation, figure, 
tables, etc.)

• Layout display (hidden boundaries, messages, invisible characters, 
pictures)

• Typeface (font, font size, font style in body, headers, and footers)

Default files can also store frequently used text and pictures such as logos. 
For example, a memo might contain a logo, the "To, From, Subject" 
headings, and automatic date and time stamping. The footer might contain 
variables to identify the source file, the date and time of printing, and the 
current and total number of pages in the file. Such a memo template is 
included on the distribution disks.

Data sharing

Text files

Text File

Scrapbook File

The Macintosh user interface gives special attention to the transfer of text 
and graphics among Macintosh applications. Applications such as Math- 
W riter that adhere to the published interface standards can be assured of a 
communications channel through the Clipboard. MultiFinder makes 
switching applications quick and easy if there is sufficient RAM. Data can 
be stored in the Scrapbook for delayed transfer into other applications. 
System 7.0 will expand the pathways.

Delayed transfer by direct reading of files from other applications is 
another, somewhat more complex, pathway for information transfer. Each 
application must use a file structure that is suited for storing of information 
peculiar to its purposes. Often the translation process does not transfer all 
of the information in a manner that can be fully recovered, so save the 
original MathWriter file before you begin a translation.

Word-processor files, known as ASCII files, that save only the character 
keystrokes and some minimal paragraphing information are the common 
denominator. While this is universally supported, transferring the 
contents of a file from one word processor to another loses such information 
as character formatting and graphics. M athW riter does provide an 
additional enhancement—the graphics and mathematical symbols are 
automatically extracted and stored in a named scrapbook for subsequent 
transfer into another application. M athW riter can also place a marker in 
the text file to assist in the merging of the information from the other 
application.



To save a text (ASCII) file:

1. Select File/Save As.

2. Select TEXT from the File Type pop-up menu (Figure 4.43).

3. Select a destination drive and folder.

4. Supply a file name. Never use the name of the parent file. Appending 
".txt" is a convenient way to show its relationship to the original file.

5. Click Save.

6. Specify that a line break (Figure 4.44) not be added to preserve the 
structure of the lines. Ordinarily the line structure is preserved only if the 
receiving application cannot handle paragraphs as a continuous stream of 
arbitrary length.

S i •M anuscr ip t

Demo.tHt
File Type: | TEXT |

c d HD40

[ Ejee< 1
[ Oriue ]

[ Saue ] 

[ Cancel ]

Figure 4.43 Save As dialog box

7. Check to indicate whether M athW riter should save the graphics and 
equations in a named scrapbook.

8. If yes, indicate a marker, if any, to locate the point of extraction for 
later reassembly in another format. The default encloses a counter enclosed 
between parentheses and asterisks (*0*).

9. Select a grouping criterion. The middle option is the default. If you have 
created a file of only displayed equations, choose the last option.

10. Click OK.

Unless you have a desk accessory such as SmartScrap™ to open the scrap
book file you must place the scrapbook in the system folder, rename any 
existing scrapbook file, and temporarily rename the scrapbook just created 
"Scrapbook File."
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TEHT options:
<•) Tent only
OTent with line breaks

E  Saue equations in scrapbook 
Mark location in tent with: 
Name of Scrapbook file:

(* # *)

Demo.tent.PICT

Equation parser will connect...
O each symbol into a separate P i n  
® groups of symbols into separate PICTs 
O  entire line containing symbols into a PICT

Cancel Saue J
Figure 4.44 Scrapbook file

Microsoft interchange format (RTF)

jx -Jx

RTF filter

The so-called Rich Text Format (RTF) provides a standard for file transfer 
that preserves the character formatting and graphics intact. Depending 
upon the other features supported by each word processor, some information 
is passed as comments and not immediately restored to its original 
appearance. MathWriter's  RTF filter must be placed in the folder with 
MathWriter or in the System folder in order to have its name appear in the 
File Type menu for Open17 on the File menu. Most word processors support 
this file format. MathWriter also imports Mathematica Notebooks that 
have been translated into RTF.

To read an RTF file (if the RTF filter is in the folder with MathWriter or 
in the system folder):

1. Select File/Open.

2. Select RTF from the File Type pop-up menu. Otherwise, the untranslat
ed RTF code will be read as a TEXT file.

3. Click OK. The translation process is lengthy because of MathWriter's 
rich data structure. The translation consists of two parts—translation of the 
RTF code and the formatting of the document within MathWriter. Allow 
time for the completion of both parts and then save the file.

17 Initially the RTF filter provides import only (i.e., RTF to MathWriter).
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File /RTF

Other translators

The RTF filter does not check the code for MathWriter compatibility. 
Furthermore, this code bypasses the usual syntax checking provided by 
MathWriter during mouse and keyboard input.

4. Supply additional formatting in MathWriter  as necessary, especially 
for features not supported by both word processors.

To save an RTF file (if the RTF filter is in the folder with MathWriter  or 
in the System folder):

1. Select File/Save As.

2. Select RTF in the File Type pop-up menu.

3. Supply a file name different from the parent MathWriter  file, perhaps 
by appending "/RTF" to the file name.

4. Select a folder and drive and click OK.

Commercial translators (filters) provide a channel among various formats 
read by both the Macintosh and IBM-PCs. The creation of a TgX translator 
for entire, "WYSIWYG"-created MathWriter  documents is being consid
ered.

Importing from graphics files

MathWriter can read paint, draw, and Encapsulated PostScript files 
directly without the originating application. Refer to the previous chapter 
for details.

Modular extensions
□ — x-=□

fx4x

PREF5

Since Math Writer is a modular18 word processor, you can extend its function 
with modules that can access and process Math Writer's data structure using 
calls to MathWriter. These modules literally extend functionality. When 
modules are placed in the folder with MathWriter  or in the System folder 
before startup, MathWriter  locates and integrates them as a part of Math- 
Writer. No more than one modular extension at a time may be used in Math- 
Writer/Educational Version.

This allows you to customize MathWriter in a fundamental manner. You 
work only with the modules relevant to your needs. This limits the com
plexity and size of MathWriter, decreasing disk space used and increasing 
the speed. Use the Windows/Modules submenu (or $6 option number) to 
access the modules.

18 MathWriter is believed to be the first truly extensible word processor.
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I H i

EKamBuilder™

Figure 4.45 Sample module submenu

ExamBuilder™ is the first such module to extend the function of Math- 
Writer by adding a special purpose, disk-based database for test items. 
ExamBuilder, accessed from Windows/Modules (Figure 4.45) or by key
board, provides a tool for the rapid generation of alternative forms of 
examinations from a collection of test items that can include text, graphics, 
and mathematics. Questions can be true/false, multiple choice, matching, 
essay, or a scenario that is sequence-dependent. The ordering of questions 
can be random and the multiple-choice options can be shuffled. Answer 
sheets and a log of items used is provided. The full formatting power of 
MathWriter is available for output.

The handling of long documents, outlining, indexing, and integrating the 
retrieval of bibliographic citations are likely candidates for modular ex
tensions. The MathWriter interface already exists.
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c<s Summary for Experts

This chapter outlines, for the experienced Macintosh user, how to start up 
MathWriter and how to handle some common tasks. For a detailed, step- 
by-step description of technical word-processing tasks, read the chapters on 
nontechnical (Chapter 3) and technical writing (Chapter 4). The Command 
Reference chapter (Chapter 6) provides a comprehensive description of 
operational commands, and the tutorial summary (Chapter 2) is provided 
as a set of hands-on MathWriter  files. The Quick Reference Card and the 
online help provide terse summaries. All keyboard commands are listed in 
the appendix as well as in the online help.

Getting Started and Handling Text
Installing M athWriter

This summary for expert Macintosh users assumes that you have a 68020- or 
68030-based Macintosh, at least 2 megabytes of RAM, a hard disk, and can 
benefit from all the technical word processing features provided by the 
MathWriter professional version.

To install MathWriter:

• Create a folder named MathWriter f  anywhere on your hard disk, lock 
and copy the contents of all distribution disks into the folder. The support 
files must either be in the same folder as MathWriter or in the system 
folder so MathWriter can automatically locate them. Refer to the 
appendix for a discussion of the various files.

MathWriter disables a feature when its support file is not accessible.

• MathWriter  requires the Times and Symbol fonts. Automatic formatting 
and mathematical templates require these fonts. Install the supplied 
versions using the Font/DA Mover. We recommend that you switch from the 
MultiFinder to the Finder and restart to use the Font/DA Mover; you should 
remove the Apple version of the Symbol font before installing the modified
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version supplied with MathWriter. (The ends of a few stretchable brackets 
are clipped in the screen display, but are still printed properly in the 
LaserWriter output. The supplied version also enables the printing of the 
boldface Greek characters.)

• If you are using MultiFinder, open the MathWriter  folder and click (not 
double-click) on the MathWriter  icon. Unlock the file, allocate the 
maximum available RAM for MathWriter  and its open documents, relock 
the file, and close the Info window. Although MathWriter can be used 
with small documents with only 800K, we recommend 2,000K or more.

• Double-click the MathWriter icon to start the program.

MathWriter must perform various initialization tasks at startup. Since 
this is probably your first use of MathWriter  on your computer, the 
program creates a MathWriter Prefs file in the System folder that contains 
a set of global defaults. Later, you can modify these defaults to customize 
the startup environment to your specific needs. MathWriter also 
automatically locates and links with any support files such as help, 
dictionaries, file translation filters, modules, stationery defaults, etc., that 
you have placed in the folder with MathWriter or in the System folder.

Getting help

For online information use the Help window on the Windows menu or 98 ? to 
access the Help file and select a specific topic. The topics are listed 
alphabetically and within several subgroups.

The online help provides an overview and probably enough detail for you 
to handle most tasks. In order to support the "What you see is what you 
get" nature of MathWriter, the program keeps open files in memory.

Therefore, when you are composing original material at the keyboard, we 
recommend that you enable the automatic save and automatic backup 
features using the File/Doc Preferences dialog box.

• If a MathWriter  Update file is present on the distribution disk, review it 
before you begin serious use of MathWriter. Don't skip this step!

• Select About MathWriter  on the Apple menu for technical support 
information and our copyright notice.

MathWriter reports the approximate amount of RAM available by the 
thin lines in the bottom-left corner of the status bar of the active document. 
The solid line reports the fraction of RAM being essential for MathWriter 
and the open documents. The dotted line reports the actual RAM in use, 
including memory that MathWriter can release when necessary.
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Standard documents

MathWriter handles many ordinary business word-processing tasks in 
addition to the more complicated processes associated with technical word 
processing. Advanced features need not be visible or otherwise require your 
attention. For example, the tools used to create mathematical expressions 
are hidden unless deliberately called up.

MathWriter provides convenient access to your personal collection of 
standard document types (sometimes called stationery) with standard page 
layout, typeface, and boilerplate contents already prepared.

To create a custom default file for memos:

1. Open the Memo default file (Figure 5.1) using the New submenu on the 
File menu.

untitled A1
H|Q i i i I i i i M i i i I i i i 12, i , i i HZm u m z n u z p <►

♦
0

LI. Dough, President
Institution
Street
p ity , S tate , Zip

Phone (A C * ) 555-1212

Page 1 of 1

pate:

To:

From:

[Subject:

Friday, June 1 , 1 9 9 0

[Your logo can fie placed in the header or as a background picture in the body.

O l l l l  1 1 1 1 CH L 1 1, C79

1̂1
o

o
Base Times 12 a

Figure 5.1 An example of stationery: Memo.def

The new file "Untitled Al" is a copy of the file Memo selected from the 
New submenu list. Selecting New, but not a submenu, produces a generic 
blank file.

Stationery or default files located in the folder containing MathWriter or 
in the System folder appear in this list. If none are present, only a 
traditional New command without a submenu appears.

2. Use the Save As command with File type: MW Default File selected 
from the pop-up menu to create stationery for future sessions.
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Figure 5.1 shows the document window too. The name of this open document 
appears on the Windows menu along with any others that might be open. 
When you select a document name from the Windows menu, that document 
window becomes the active window (i.e., it comes to the front for editing).

The document window

Math Writer uses a "sheet-of-paper display" with automatic pagination. 
The Memo stationery file, for example, contains a header at the top of the 
page that displays the current page number and the current total number of 
pages; MathWriter automatically updates both variables as you add 
pages. The header can also contain text or graphics, such as a logo. You 
could also use a bitmapped, a PICT, or an Encapsulated PostScript graphic 
as a background picture, creating a "watermark." The body of the document, 
below the nonprinting horizontal line, contains the standard memo entries. 
MathWriter automatically supplies the current date. You might elect to 
use the filename variable on the last row of the Palettes menu to visually 
associate your printed memo with its originating data file.

MathWriter provides a full "What you see is what you get" visual 
display. All editing is done in context. For example, you can edit the 
headers, footers, footnotes, and mathematical expressions without moving 
into separate windows. Just select the appropriate editing tools using Tools 
on the Windows menu. Even if you suppress the page layout lines with Hide 
Layout on the Format menu, the cursor continues to change depending upon 
its location in your document. In order to achieve maximal visual feedback, 
MathWriter refreshes the screen often; you can initiate a screen refresh 
with $€ option Z.

Math Writer supports the usual window controls such as the close-box, zoom 
box, grow box, horizontal and vertical scroll bars, and ruler lines that 
identify this as the active window. See the Help window (Windows menu) 
for a summary of mouse and keyboard commands used to move around within 
a document. Because displayed mathematical expressions frequently span 
several lines, a click on a scroll arrow moves the document multiple lines. 
Option click on the arrow to scroll only one line.

The ruler does not scroll from the top of the document window but remains 
visible, displaying the tab settings for the selected paragraph, the 
paragraph that contains the blinking insertion point. Each time you press 
return, you create a new paragraph that inherits the ruler settings of the 
previous paragraph. When you change the ruler of the new paragraph, 
MathWriter  adds an identifying icon in the left margin. MathWriter  
places various markers at the left border, but you can hide them by 
selecting Hide Markers from the Format menu.
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The tab supply and paragraph justification controls appear just 
above the vertical scroll bar, rather than on the horizontal portion 
of the ruler, to leave you as much vertical space as possible. This is 
especially valuable when you are writing two dimensional, 
mathematical expressions and screen size becomes critical. Drag the 
tabs onto the ruler or into the text. A rubber-band feature lets you 
drag a tab into the text to determine its exact alignment. When you 
release the tab, it snaps onto the ruler. To remove a tab, drag it off 
the right end of the ruler past the right margin marker.

a-w
W-H
I'M

G

The tab icons are left-aligned ►, right-aligned i, center-aligned ♦ , or deci
mal-aligned O. The paragraph alignment relative to margins includes left 
align [«3, right align 0 /  both margins aligned and centered Q .

The two-dimensional nature of mathematical expressions requires more 
extensive line spacing control than traditional single and double spacing; 
therefore, we expanded this control and moved it to the Format menu. The 
line spacing options include automatic, mostly fixed, and fixed spacing 
with separate leading adjustments for space above and below the baseline. 
The mostly fixed option, a combination of fixed and automatic, permits 
subscripts and superscripts to protrude into the space between the lines, but 
allows displayed equations to increase line spacing automatically. Never 
use fixed line spacing while composing mathematical expressions.

Base E l t̂ >j L 1 7 6 ,C 5 4 - L 1 7 6 , C34~ Times 12 m
Figure 5.2 The status bar

The status bar (Figure 5.2) at the bottom of the document window provides 
advisory information. The font, font size, and font style of the character 
adjacent to the blinking insertion point appear on the right. When you open 
a file, a progress indicator appears here. Indicators identifying the options 
you have, such as Auto Math also appear here. The panel to the left 
reports the line and character position of the cursor or the range of selected 
text. MathWriter supports type-ahead and mouse-ahead features and 
handles numerous off-screen formatting operations in the background while 
the keyboard is idle; a progress indicator also appears here. This panel, in 
addition, provides a pop-up menu to control the movement of the insertion 
point among the various regions of the document and to scroll the window if 
necessary. For example, if you place a footnote or an endnote, you can scroll 
directly between the note itself and back to the reference point in the text 
using the insertion point menu. The "Base" panel reports the progress of 
various background tasks, RAM usage, and the position of the insertion 
point within a built-up mathematical expression or within a table. For 
example, if the insertion point is positioned for a superscript to a 
superscript, two upward arrows appear here.
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Note: Use 96 right bracket and 96 apostrophe to create superscripts and 
subscripts, respectively. The font size reduction and vertical positioning 
are automatic. Press enter to cancel each subscript or superscript command.

See the online Help in the Windows menu for a discussion of the Math 
Editor. The Character Editor provides arbitrary vertical positioning for 
any character.

Menu commands

Before creating a document, structure its global properties. Use Page Layout 
on the File menu for printer and paper choices, margins, header and footer 
size, etc., and use Doc Layout for placement of headers, footers, and 
footnotes within the document.

The Edit menu provides the usual undo, cut, copy, and paste commands as 
expected. In addition, MathWriter supports copying and pasting of 
paragraph formatting information. A Paste In Context command allows 
added text to assume the style of the text adjacent to its destination, rather 
than retaining its original style. Note: To transform mathematical 
expressions into PICTs for pasting into traditional applications, use the 
Copy Other submenu command Copy As Picture. Find/Replace supports 
search and replace for mathematical expressions, typeface changes, 
wildcards, hidden formatting commands, such as return markers at the end 
of paragraphs, and reverse direction searches, which are especially useful 
when you are composing as opposed to simply typing an existing 
mathematical manuscript.

Use the Format menu to format paragraphs (borders, shading, splits at 
page breaks, etc.), set line spacing, and choose the dynamic variables for 
page numbering, paragraph numbering, footnote numbering, equation 
numbering, etc. Set starting numbers for these variables here, too. Use the 
Palettes menu to "type" these dynamic variables at the insertion point. 
(The sequence 96 option E types the automatic equation numbering vari
able.)

Use the Diac menu to type and to adjust diacritical and horizontal grouping 
markers.

The Style menu supplies typeface choices for font, font size, and font style. 
Both mouse and keyboard control are provided for typeface changes because 
of the frequency of this process in mathematical manuscripts. Use Doc 
Preferences in the File menu to assign typeface combinations for Style 1 and 
Style 2 on the Style menu.

All Math Writer versions use a common menu organization; the menu com
mands not available in this version are dimmed on the screen, as are other 
commands not currently available.
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Handling Graphics
Using graphics

MathWriter allows you to import graphics (bitmapped, PICT, and 
Encapsulated PostScript) directly from files, as well as through the 
Clipboard. You can treat a graphic as a large text character within a line of 
text.

To import a graphic as a character:

With a document open and the destination identified by the position of the 
blinking insertion point, use Import Graphics File on the File menu to insert 
the graphic. Unless you select a specific file type with the pop-up menu, 
the names of all folders and all allowable file types appear in the file 
selection window. The usual cut-copy-edit commands apply to the graphic; 
therefore, you can paste into a MathWriter document a graphic placed on 
the Clipboard by another application.

To resize and crop a graphic

1. Activate the Character Editor using the arrow icon on the Tools 
Window of the Windows menu, the Tools submenu, or type Si shift [.

□ I

E
2. Click on the graphic to display the bounding rectangle with "handles" 
on the comers.

3. To resize the selected graphic with the width-to-height ratio 
preserved, either drag a handle while you press the option key or select 
the graphic and, with the Character Editor active, use the Scale command 
that appears on the Edit menu. If width and height are to have different 
scales, just drag a handle or set the actual percentages for each dimension 
using the Scale command on the Edit menu; you can also restore the original 
size here.

4. To crop (or mask) a portion of the graphic or undesired bounding white- 
space, drag a handle on the bounding rectangle while pressing the Si key or 
use££option to crop proportionally. When you press the key, MathWriter 
posts the permitted operation in the typeface box of the status bar.

5. To leave the Character Editor, select the normal Text (I-beam) Editor.
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Using the Math Editor
The handling of mathematical expressions is MathWriter's  most 
distinctive and powerful feature. By reducing typesetting tedium and 
providing you with technical writing tools, we hope you can compose 
mathematical manuscripts at the keyboard, rather than transcribe hand
written drafts into print. We believe these tools empower authors of 
scientific and mathematical papers just as traditional word processors 
facilitate the process of writing prose.

MathWriter treats mathematical expressions as ordinary text, rather 
than graphics; this allows you to compose and edit built-up expressions of 
arbitrary complexity in context. You can generate nearly all input and 
commands by mouse or keyboard. "Smart" templates provide automatic 
formatting of the two-dimensional displays of mathematical expressions. 
Line spacing adjusts automatically. Various input aids expedite changing 
typefaces, and entering special symbols in mathematical expressions. 
During editing, MathWriter  automatically numbers equations and updates 
the text references linked to them. Footnotes are numbered automatically 
too. The Find /Replace command applies to both text and mathematical 
expressions. Revision aids for authors include dynamic line numbering and 
in-context marking of version additions and deletions using automatic style 
changes.

Configure the floating windows

♦ To begin using the Math Editor, select the appropriate combination 
of the floating windows from the Windows menu. Your document 
window remains active even when floating windows are present and 
active.

All of the commands on the following floating windows, which are 
displayed using the Windows menu, can be typed (for a list of 
keyboard commands, see appendix 3), but mouse access is always an 
option.

♦  The Tools window provides access to the auto-formatting subscript 
[VI and superscript [a]  commands (96 ' and 96 J are the keyboard 
equivalents) in addition to the various editors, including Math X.

Use the enter key to complete a mathematical subexpression or 
template and move the cursor to its previous state. Use the return key 
to return immediately to the baseline for text.

♦  The Templates window has ten horizontal pop-out menus of com
mon mathematical expressions. Drag to select or type 96 and a numer
al simultaneously to select a category (numbered from the top) fol
lowed by a numeral for the specific template (numbered from the left). For

□
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example, if you type SSI and 1, the first fraction template appears at the 
insertion point in your document.

Note to MathWriter 1.4 users: The Templates window behaves as a float
ing, vertical menu bar. You must drag, not just click, to select a command.

Use the enter key to advance the cursor from one placeholder to the next. 
For matrices and tables use the tab key to create new columns and the return 
key to create new rows. Most formatting is automatic.

These template structures, including subscripts and superscripts, can be nest
ed to any level; for example, a superscript can have a superscript. Within a 
template, pressing enter returns the insertion point to the previously used 
template. For example, when within the superscript of a superscript, press
ing enter once moves the insertion point back to the first level superscript.

♦  The Palettes window always contains the Greek alphabet and as many 
additional rows of symbols as you want; select a row by clicking on its name 
from the Palettes menu. MathWriter places symbols selected from this 
window in the document at the blinking insertion point. The sequence SS 
spacebar toggles between the current and the Symbol font, which contains 
the Greek alphabet. A Style menu command serves the same purpose.

♦  The Font Table is a generalized typing aid that provides access to all 
characters of all active fonts. Use the pop-up menu to select the font. You 
can reduce the portion of the table that is visible in order to preserve screen 
space.

Two additional floating windows, Clipboard and Help, provide informa
tion, but they cannot be edited directly.

Additional keyboard commands

In addition to more than 100 keyboard commands listed in the appendix 
and those provided by the floating windows, MathWriter supports various 
other user-defined commands, or macros, to control typeface changes. You 
can increase or decrease the font size or revert to the immediately previous 
typeface on the Style menu. Additionally, using Doc Preferences on the File 
menu, you can assign two typeface combinations, from among user-selected 
categories of font, font size, font style, justification, and line spacing, to the 
style menu with SS > or SS <.

Additional typeface and formatting controls

The Auto Math feature provides various tools peculiar to mathematical 
expressions. You select the combination of features in Auto Math options 
and enable/disable the set using Auto Math (with SS E). This feature is 
normally disabled unless needed. When enabled, the typeface indicator on 
the status bar appears in inverse (white on black). MathWriter resizes
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parentheses, brackets, and braces as the enclosed expression changes in 
height.

When the insertion point is adjacent to an alphabetic character, you can use 
the Diac menu to supply diacritical marks. When a group of characters is 
selected, you can apply a special grouping symbol, such as a horizontal 
brace, from the Diac menu.

To adjust the height of integral and absolute value symbols to match the 
expression size when the insertion point immediately follows the integrand 
or argument, use 98 D or the Calc Prev command on the Format menu. Use 
the Character Editor to make arbitrary adjustments to vertical position and 
size.

Other Format menu commands provide borders for emphasizing paragraphs 
and equations and control for line spacing (automatic is the default) and 
matrices. Changes in these settings apply to subsequent input and to text you 
designate by selecting before you change the defaults. Use the Insert and 
Delete submenus of the Edit menu to add or delete rows or columns of ma
trices when you place the insertion point within a cell using the Math Edi
tor X.

Find/Replace of the Edit menu allows you to include mathematical 
template constructs as well as specific built-up expressions within a search. 
Searches can be typeface-sensitive and direction-specific.

Other important commands

MathWriter's automatic scrapbook feature, invoked using the TEXT file 
type with Save As on the File menu, automatically extracts graphics and 
mathematical expressions, converts them into PICT form, and places them 
in a scrapbook file for use with other applications. Traditional word 
processors simply discard these graphics when making a text file and 
require that you individually transfer graphics. With MathWriter  you 
also can transfer a mathematical expression into another application via 
the Clipboard by selecting the expression and using Copy As Picture from 
the Copy Other submenu on the Edit menu. This converts the editable 
expression into a PICT format recognizable by many other applications.

The Preferences command of the File menu allows you to establish a startup 
configuration suitable for mathematical work.

Math Writer's powerful automatic numbering feature in Variables Format 
on the Format menu dynamically numbers footnotes, equations, subequa
tions, and cross-references to them in the text. In addition, the user-defined 
category with cross-references can simultaneously link a user-defined 
variable such as table, figure, theorem, lemma, etc. If you add equations 
during the editing process, MathWriter automatically updates all 
subsequent equation numbers and references to them.
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To number equations, assign a format, position the insertion point with a 
tab, and then use the mouse to type the dynamic variable 2>  from the Pal
ettes menu. Math Writer automatically numbers the current variable high
er than the immediately preceding variable and updates all remaining 
occurrences in the document. Subequations ^ are handled similarly. When 
you assign a cross-reference 2 *  you must establish the linkage; but Math- 
Writer dynamically updates the link after subsequent editing. Use the 
Variables Format command to set the attributes of this triplet of variables. 
You also use Variables Format to establish an arbitrary number of triplets 
for numbering figures, tables, paragraphs, theorems, etc.
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6  Command Reference

This chapter is a detailed reference guide to Math Writer commands and is 
organized by commands, rather than by tasks.

Hardware and System Requirements
The Professional Version of MathWriter 2.0 requires a 68020- or 68030- 
based Macintosh with at least 2 megabytes of RAM and a hard disk. The 
reduced feature Educational Version can be used with 1 megabyte of RAM 
using the Finder, rather than MultiFinder. The reduced version is smaller 
and leaves disk space for files. The other drive would contain your system 
file, the print driver, and limited space for file storage. A hard disk is 
preferred for serious work, especially if you use the spell-checker.

Use the most recent operating system consistent with your hardware, 
although any system that supports submenus will work (i.e., System 4.0 and 
Finder 6.0, or later). MathWriter works comfortably with MultiFinder, 
provided you have enough memory. MathWriter's mathematical capabili
ties utilize the Times and Symbol fonts; therefore, the screen font for at 
least one font size of Times and Symbol must be available to the system 
during writing and printing. MathWriter  includes a self-check of the sys
tem version and the availability of the Symbol and Times fonts.

MathWriter's Main Screen
Figure 6.1 shows MathWriter with a single open file displaying three of 
the floating windows (Templates, Palettes, and Tools), and the ruler, tabs, 
and scroll bar. You can remove the floating windows by clicking in their 
close-boxes or by selecting their names in the Windows menu. You can also 
drag them to more convenient locations on the main screen or to an attached 
secondary screen. This is especially useful if you have a larger monitor. If 
possible, avoid having them mask a portion of the document by resizing the
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document window. An overlap placement slows scrolling due to the extra 
screen refreshing.

With the Templates, Palettes, and Tools windows removed, the screen is 
remarkably simple (Figure 6.2). The ruler is thin and is always at the top 
of the screen, never usurping window space in the body of the text nor 
scrolling out of view. You can even remove the ruler with the Format menu 
if desired. At the bottom of Figure 6.2 is the status bar. You can resize, drag, 
close, or scroll the document window in the customary Macintosh fashion.

6  File Edit Format Palettes Diac Style LUindouis

Figure 6.1 MathWriter main screen configured for mathematical work

Up to four documents can be open at once. This is not an inherent limitation, 
but a reasonable limit since active files are RAM-resident for increased 
editing speed.
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Use Finder rather than MultiFinder if you have only 1 megabyte of 
memory. We strongly recommend that you use more than 1 megabyte of 
memory and use Math Writer with MultiFinder; remember to increase the 
Application Memory Size to make this additional memory available for 
larger documents. While at the MultiFinder level before activating 
MathWriter, use the Get Info command on the File menu to set this before 
activating MathWriter.

«  File Edit Format Palettes Diac Style Windows

Figure 6.2 MathWriter main screen configured without mathematical tools

The Apple operating system 7.0 will let you increase the size of documents 
arbitrarily by supporting memory management for virtual memory. 
MathWriter retains only the necessary parts of itself in memory, obtains 
additional segments from the disk as needed, and automatically purges 
unused parts. That leaves unused RAM for your current document, which is 
memory resident. The thin lines in the "Base" panel of the status bar 
(Figure 6.1) indicate the relative utilization of RAM, as discussed later in 
this section.
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Ruler and tabs

MathWriter is paragraph-based and the ruler refers to the —  
paragraph that contains the blinking insertion point. Note that you ^  
end a paragraph by pressing the return key. The ruler displays the ^ 
tab settings for the current paragraph, the paragraph with the I—  
flashing insertion point. The tab wells at the right of the document 
window, just above the vertical scroll bar, contain left, right, center, and 
user-defined character alignment tabs; this placement avoids a reduction in 
the critical vertical dimension of the screen, necessary for displayed 
equations. Double-click in the ruler to select ruler options for uniformly 
spaced tabs.

To place a tab, drag one from the well and pull it into the text area to 
decide its exact placement (or place it directly on the ruler). When 
released, the tab icon snaps to the ruler as if attached to a rubber band. To 
remove a tab, drag it off the right end of the ruler past the print boundary 
indicated by shading I J1  on the ruler. Double-click on a tab in the ruler to 
open a window for additional control or to choose a tab leader and 
alignment symbol. You can assign an arbitrary alignment character, such as 
an equals sign used in mathematical writing, rather than the traditional 
decimal-aligned tab.

To obtain left, right, full, and center line justification for paragraphs, 
locate the icons just below the tab supply and click on the one you 
want. Justification applies to the paragraph that contains the blink
ing insertion point or to multiple paragraphs of selected text. The 
usual text selection techniques such as dragging, shift clicking, etc., 
apply; however, to identify a paragraph for justification or tab placement, 
you only need to place the insertion point within that paragraph.

MathWriter automatically passes the ruler settings from one paragraph to 
the next when you press the return key. If you change the ruler settings, a 
small ruler icon on the left border of the window identifies ruler changes 
unless you use Hide Messages on the Format menu to hide this and other 
message icons.

The status bar

Base O I I I ! L I ,  CO Geneva 12 a
Figure 6.3 MathWriter status bar

The status bar at the bottom of the document window (Figure 6.1 and 
Figure 6.3) contains information about the position of the insertion point 
within a mathematical expression ("Base" in this figure) and the adjacent 
text. Figure 6.4 shows examples of the insertion point in mathematical 
expressions and in a table. With the insertion point adjacent to the "1", the 
first up arrow indicates an exponent placement and the down arrow
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The cursor

indicates that the exponent has a subscript. In the second example the 
cursor is adjacent to the subscript and the down arrow indicates this.

1,1 IE

2,1 2,2

T i i [(1 ,2 ) Base ] 0
Figure 6.4 Insertion point position within a mathematical expression

When the insertion point is in a table or matrix, the status bar gives the 
row and column number of the element you are editing (Figure 6.4). A thin 
horizontal line in the "Base" panel (Figure 6.3) shows the fraction of RAM 
in use. The solid line represents actual usage and the dotted line represents 
the additional usage that can be purged by Mat?! Writer if necessary. As 
mentioned above, MathWriter documents are memory resident so you 
should allocate as much memory as possible to Math Writer.

Also on the status bar in Figure 6.3 are the horizontal scroll bar; the 
position of the insertion point within the document, line 1 and character 0; 
and the current font, font style, and font size, which are plain, Geneva, 12 
point. During computation-intensive operations like reformatting or 
loading a file, a progress indicator appears in the typeface indicator box 
also. MathWriter reformats off-screen text in the background when it is 
processing no new commands; you can follow its progress in the insertion 
point locator panel. The font typeface panel appears in inverse type 
(white letters on black background) when the automatic math options on 
the Style menu are in use. Brackets enclose this typeface indicator when 
you enable automatic revision tracking.

* I JL

'll
3 3 3 3

m m

The MathWriter cursor changes to convey 
information about operations that are possi
ble or in progress. The first row of Figure 6.5 
contains the arrow, the I-beam, and the split
I-beam cursors of the Character, Text, and <3t <3t> <a> <g$
Math Editors, respectively. The cursors of the 
second row indicate when the text cursor has 
moved into: the main body of the manuscript, 
the header, the footer, or the footnote, 
respectively. Because MathWriter  allows
you to edit these different sections of text without opening separate 
windows, you need to know into which portion of the document you have 
moved the cursor. The third row shows the search icons. The fourth row 
icons indicate that disk activity is in progress.

Figure 6.5 
MathWriter icons
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If you have trouble identifying the region in which the insertion point is 
located, select Show Layout on the Format menu. That displays the dotted 
lines that separate the different regions of the document. In addition, a 
pop-up window on the status bar at the bottom of the screen tells you 
whether you are in the "Body," "Header," or "Footer" (Figure 6.6).

0. 1 , 1 , 1 , 11, 1 , 1
-------  MLB Shout l a y o u t ..............
. i . 12, i . 1 . i , IS, i , 1 , i , 14, i , . i . 15,

4,\ *

Floating windows

Palettes window

j Page - i This is  the header area. MW treats this as a mini MW document 
Which you can edit within the same window. See Page Layout and Document 
Format on the File menu for controls.

| This is the text region. Show Layout displays the 
boundaries of the text body, headers, and footers using 
dotted lines. Cursor shape changes also identify the 
Regions.

[Ol Body
D  Header - Every page 
Q  Footer -  Every page

-GB

Figure 6.6 Show layout and pop-up region locator

The floating "Palettes" window contains the Greek alphabet and any rows 
of symbols from the "Palettes" pull-down menu that you choose. You can 
modify, move, or remove the floating Palettes window (Figure 6.7). It 
responds to the shift  key for uppercase Greek letters. To place the floating 
Palettes window on the screen, select it from the Windows menu. Then click 
on the name of a row in the Palettes menu, rather than on the specific 
symbols, to copy a row of symbols to the floating window. You can remove a 
row by clicking on it again in the Palettes menu. You can reposition the 
floating Palettes window by placing the cursor just below its close-box and 
dragging it (more easily seen in Figure 6.1).

□ a JL JL s c L JQL 0 X K A JL V L 0 fl p a T V ♦ Y CO <p
Figure 6.7 Greek alphabet in the Palette window

Templates window

Smart templates in the Templates window allow you to create fractions, 
radicals, products, summations, integrals, set operators, special structures 
such as limits, grouping brackets, vectors and matrices, and tables. Each of 
the ten icons in the Templates window (Figure 6.8) contains two to ten 
options in pop-out menu format.
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Pop-out menus

v t

n

z

c
u

□ I

I

fj
[: 0  ( :  : ) { : : } <: :> L= =J [■ =1

Figure 6.8 Templates window

To use the templates, click on the category icon to unfold the list and drag to 
select—just as you do with pull-down menus.

MathWriter 1.4 users:
Remember to drag to select from the new pop-out menus.

Alternatively, you can activate these menus from the keyboard. Press and 
hold command (Si) and type a numeral key (1-9, use 0 for number 10) to 
select a menu (e.g., H I  is the fraction menu). Then type the numeral 
displayed adjacent to the desired icon. If you do this without a pause, the 
menu does not unfold to remind you of the choices. Any invalid keystroke 
aborts the choice. (MathWriter displays tiny numerals within the specific 
icons when you use keyboard access.)

2 3
b L - 7_

1. The first fraction (Si 1) option displays the 
numerator and denominator in the current font size.
The second option immediately decreases the font 
size for smaller in-line expressions. The third option produces a slanted 
fraction line. MathWriter automatically draws the fraction bar long 
enough to accommodate the length of both the numerator and denominator 
and automatically centers the shorter expression. Press enter to move from 
the numerator to the denominator. Press return at any time to immediately 
return to the baseline.
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2. Three choices of radicals (S£ 2) are available.
The first is the usual square root, the second allows 
you to supply a root, and the third is for long 
division. Press enter to move from within the radical to the second entry, 
the root. Press enter to leave the structure.

n i i —
3. The product symbol template (#> 3) allows you to ■ 
place limits above and below the product symbol or to 
the right of the product symbol to conserve vertical space 
for in-line expressions. MathWriter automatically positions the cursor in 
the lower portion and reduces the font size. Supply the lower limit, and 
press the enter key to move to the upper limit. Supply the upper limit and 
press enter to return to the baseline to enter the function. The limits can be of 
arbitrary complexity. Use the split I-beam to edit within the limits. Press 
enter to move the insertion point to the base level.

4. Like the product symbol template, the summation 
template 4) allows you to place the limits above and 
below the symbol or to the right to conserve vertical 
space for in-line expressions. MathWriter  automatically positions the 
cursor in the lower index and reduces the font size. Supply the lower limit 
and press enter to move from the lower limit to the upper limit. Supply the 
upper limit and press enter to move to the baseline to supply the function. 
The limits of integration can be of arbitrary complexity. Use the split I- 
beam to edit within the limits. Press enter to move the insertion point to 
the base level.

The integral ($6 
can be single,

1 , -
j : u : m : i 5 n m *_ *

5.
5)
double, or triple, 
and you can place the limits either adjacent to or above the integral sign. 
Supply the lower limit and press enter to move to the upper limit. Supply 
the upper limit and press enter to move to the baseline, and then supply the 
integrand. The limits can be of arbitrary complexity. A contour integral is 
available. Press return to move the insertion point to the base level; if de
sired, use the split I-beam tool to edit within the limits again. To resize 
the integral for larger integrands, use Calc Prev on the Format menu or D 
with the insertion point positioned to the immediate right of the inte
grand. Make arbitrary size adjustments and vertical positioning adjust
ments using the Character Editor.

n u :
6. The union and intersection operators ($6 ■
6) also accept limits. Press enter to move I 
from the lower to the upper limit and again 
to move back to the baseline. Use the split I-beam to edit the limits.

n =

7. The 
special

n-------- 2 3 4 5 6 7 8 9 10
lim det gcd inf lim inf lim sup max min Pr sup
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function menu (38 7) contains constructs that include expressions centered 
below the operator name. Press enter to return to the baseline. Use the split 
I-beam to edit the limits. In contrast to use of | 4-1 on the Tools menu, the 
name remains a unit.

2=} 3[= If 1__
1 Min 11 •=>

8. Grouping brackets 
(I€ 8) include multi
ple rows grouped on
the left or right with braces, brackets, parentheses, and angle symbols. Use 
the split I-beam to edit within the structure. Press return to change rows 
and tab to change columns.

'[: : ] f t :  : ) f t :  :}l4|: :| R|: :||fr: : > n : :J| T : :]
9. Vectors, ■ 
matrices, and I 
determinants
(86 9) can have an arbitrary number of rows and columns. MathWriter 
provides various enclosing symbols. Use the tab key to change or create 
columns. Press return to change or create rows. Math Writer automatically 
formats the matrix as you type each keystroke. Use the split I-beam from 
the Tools window to edit inside a cell or within an expression inside the 
cell. Click inside a cell to outline it with a box (Figure 6.9). Click outside 
the structure or select the I-beam tool to return to normal typing. Click on 
the appropriate box in Matrix Format on the Format menu to specify the 
placement, line thickness and pattern, justification within cells or ele
ments, and row and column spacing of cells.

To modify the format of previously typed 
expressions, simply select the expression 
before using the Matrix Format command. To 
add or delete a row or column, select a cell 
within that row or column and then use Insert 
or Delete from the Edit menu.

1 B
3 4

Figure 6.9
Edit inside structures

10. The last menu produces tables (86 0). You can box the m  
entire table or each cell individually. MathWriter  |o| 
treats tables as matrices with additional horizontal and 
vertical rules. Click on the appropriate box in Matrix Format on the Format 
menu to specify the placement, line thickness and pattern, justification 
within cells or elements, and row and column spacing of cells. To modify the 
format of previously typed expressions, simply select the expression before 
using the Matrix Format command. Use the split I-beam from the Tools 
window to edit a cell (outlined with a dotted box when you click within a 
cell) or an expression within the cell. Click outside the structure to return to 
normal typing. Press option to temporarily change from an I-beam to a split 
I-beam cursor.
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Also, with the Templates window you can select any mathematical struc
ture using the Character Editor and replace it with any other structure from 
the same row in the Templates window without retyping it. For example, 
you can convert a matrix into a determinant this way.

Tools window

The floating Tools window (Figure 6.10) serves multiple 
purposes. Use the split I-beam cursor to place the inser
tion point inside an existing mathematical structure.
The full I-beam allows you to place the insertion point 
in ordinary text. The small, vertical, up and down ar
rows move the insertion point above or below a symbol, 
reduce the font size, and center the subsequent input. The 
slanted up and down arrows position superscripts and 
subscripts. Clicking the bottom icon is equivalent to 
pressing the enter key and will move you out of super
script or subscript mode and back to the baseline or to the 
level on which the insertion point was located before 
you clicked on the slanted up or down arrow. See appendix 3 for a table of 
keyboard equivalents.

□ 1 *

* +

JL i

1 %

Figure 6.10 
Tools window

The Main Menu Commands
6 File Edit Format Palettes Diac Style Windows

The dimmed menu commands are unavailable in this version.

The Apple # Menu

About MathWriter™ 2.0...

Alarm Clock 
Chooser 
Control Panel 
Key Caps

The Apple menu contains information about the application and 
provides access to the desk accessories (Figure 6.11). Use the 
Font/DA Mover to modify the list.

About MathWriter™ 2.0

Figure 6.11 The ft menu This window displays credits, copyright, and trademark notices
(Figure 6.12). The copyright notice is a reminder that illegal 

copying of this intellectual property constitutes theft, and that end-user 
technical support is provided by the publisher, Brooks/Cole Publishing 
Company, rather than Cooke Publications, Ltd. Click to close the window.
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MathWriter™ v™ 2.0
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Figure 6.12 The About MathWriter 2.0 window

Desk accessories
The names of desk accessories currently available to the system also 
appear on the Apple menu (Figure 6.11). Use the Font/DA Mover1 to 
modify this list. See the Macintosh Utilities manual for a discussion of 
desk accessories. The Font/DA Mover should be used under Finder, rather 
than MultiFinder. Math Writer's Font Table in the Windows menu is a 
generalization of the Key Caps desk accessory; it allows you to "type" 
characters directly using the mouse.

The File Menu
The File menu (Figure 6.13) contains the customary Macintosh file man
agement commands. A file named "Untitled 1" (or one of your choice in 
File/Preferences) opens automatically on start-up or when you use New (but 
not a submenu) in the File menu. In addition, New opens a submenu 
(Figure 6.14) that displays a list of your default files.

New

The New command together with Preferences on this menu allows you to set 
ALL of the default settings and create custom configurations of Math- 
Writer; the default fonts, font sizes, and font styles within the headers, 
footers, and main body of a document; the palette choices; and the page 
layout and initial file contents including current date markers. Such startup 
files are called stationery or MW Default files.

'Or SuitCase™ II, for example.
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You can create a stationery file for each distinctive type of document 
you use and designate one of the stationery files as the default, using 
Preferences on the File menu. When you choose from the submenu 
MathWriter copies that particular stationery. For example, you can 
create a standard memo form that includes your letterhead, footers, 
common text, and the current date. MathWriter  automatically keeps 
the date current. If you place several stationery files in the system 
folder, their names appear on the submenu of the New command for 
convenient selection. An unused stationery file automatically closes 
if you open an existing file without making any change to the 
stationery file.

Open... (960)

Use Open... to open an existing file. Note: The three dots following 
the word "Open" indicate that you have to supply additional 
information to complete the command. When you click Open..., a 
dialog box appears (Figure 6.15). The name of the current drive 
appears at the top right. If you press Eject, the computer ejects the 
disk. Pressing Drive moves you from one drive to another. The pull
down menu, here labeled MW 2.0/ lists folders on the current disk and 
lets you choose one. Use Open to open the file you selected from the 

Figure 6.13 File menu window or use Cancel to abandon it.

File
Neiu ►
Open... §§0
Close mil)
Sane
Sane fls...
Saue a Copy...

m s

Import Graphics File...

Preferences...

Doc Info...
Page Layout...
Doc Layout...
Doc Preferences...

Oueruieui...
Print... m i

Duit m u

Figure 6.14 Example of a New submenu showing default templates

Press All known types on the pop-up menu shown in Figure 6.15, and Math- 
Writer presents a list of allowable file types. The names of files already 
opened are excluded from the list. Drag to select the file type you wish to 
have appear in the list, and the scrollable window displays only files of 
that selected type. All known types are the file types that MathWriter  
can read with its present configuration. Initially, the file type, pop-up list 
includes MathWriter 2.0 files and text files. Text files are those that have 
been saved in a default font and have very limited formatting information.
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MathWriter  also saves the graphics and mathematical expressions in a 
named scrapbook file when you create a TEXT file.

Figure 6.15 Open dialog box

A translator for Microsoft's Rich Text Format (RTF) for file interchange 
among various word processors appears (in italics) in the File Type list too, 
when placed in the folder with MathWriter  or in the System folder.2 The 
RTF files do preserve character formatting and graphics within the file 
during import. Non-WYSIWYG, embedded text commands for generating 
mathematical expressions imported from Word® 4 RTF files are translated 
into fully editable, WYSIWYG expressions in MathWriter!

Use MathWriter 2.0 file type, MathWriter's own format, to keep the 
formatting and configuration information you chose when you created your 
document for subsequent printing and editing sessions with MathWriter. 
MathWriter automatically restores this environment when you open the 
file later.

The preservation of font choices when a file is opened on a different 
computer is crucially, not just cosmetically, important. Unlike alphabetical 
characters, the special symbols used in technical writing do not have 
standard keyboard assignments so an unintended font change will probably 
change the content of your document. Math Writer uses font names, rather 
than computer-specific font identification numbers, to prevent unintended 
substitutions. MathWriter uses this checking process for both native 
MathWriter files and RTF files when opened. If you use the File Warnings 
option in the File/Preferences dialog box (Figure 6.19), MathWriter issues a 
warning message if a font used in the file you open is not available to your

2 The RTF filter may be shipped separately, and will initially open, but not save files.



system. If a PICT displays correctly in the originating MathWriter file, it 
will display correctly when opened on another computer having the 
required fonts installed. In contrast with conventional Macintosh word 
processors, MathWriter  preserves file integrity, even when transmitted by 
network to a different computer, provided identical font files are used.

Close (Sew)

To close the active file, click in the close-box at the top-left corner of the 
active window or choose the Close option from the File menu. If you have 
made changes since the last save, MathWriter gives you an opportunity to 
save a permanent copy of the document in a file. Remember the RAM- 
resident copy will be lost unless you save it as a file!

Save (#S)

Save makes a disk copy of the active window document using the 
previously assigned file name and path. If you have not assigned a name, 
the Save As... dialog box appears so that you can assign one. If you have a 
power failure, the computer will lose the memory resident copy. Save your 
document frequently. We recommend that you click Auto save and Auto 
backup/Doc Preferences in the File menu to enable Auto save and Auto 
backup for additional protection. During a file save operation the Auto 
backup command retains the previous version of the file by appending 
".backup" to its name before making a new copy. If a ".backup" file already 
exists, MathWriter replaces it with the new ".backup" file. This approach 
assures that the two, and only two, most recent copies are preserved.
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MathWriter does not compute the size of a file before executing the save 
command. Therefore, if insufficient disk space is available to save a 
complete copy, the partial file (and the older copy) will be deleted and you 
will be prompted to insert a disk with sufficient space. Save a copy 
IMMEDIATELY.

Save As...

The Save As... command is similar in function to Save except that a 
window appears on the screen in which you can type a name for the file 
(Figure 6.16). This window also offers a pop-up list of allowable file types. 
If you have already saved the active file with a different name, 
MathWriter  closes it with the contents unchanged and applies the new 
name to the current file, which remains open, and creates a copy with this 
new name. Again, we recommend that you use the Auto save and Auto 
backup commands in Doc Preferences of the File menu for added safety and 
convenience, especially when you are composing original material at the 
keyboard.
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Figure 6.16 Save As dialog box

MathWriter™ 2.0 format

This format preserves your complete document and all document-specific 
configuration information. Always save a copy in this format; other 
formats may not preserve all the information needed to resume editing.

MathWriter Default File

The MathWriter Default File selection saves your Math Writer document 
configuration, placing it in the New submenu (on the File Menu), and for 
potential use as a startup file. Pull down the File menu to New to reach the 
submenu and drag to the file name you want to copy. The original is not 
affected.

TEXT file

Virtually every word processor can read or translate the TEXT file type. 
When MathWriter or any other word processor reads such a file, the file 
may not look on screen as it looked originally because TEXT preserves only 
limited formatting information. In particular, the character formatting 
(font, size, and style) and graphics are not preserved.

You can save text files in two formats. Text only is the more common format 
and retains the markers for paragraphing. Text with line breaks places a 
paragraph symbol and creates a new paragraph at the end of each line.

"Save equations in scrapbook" is MathWriter's automatic scrap feature. It 
automatically extracts graphics and mathematical expressions, converts 
them into PICT form, and places them in a Scrapbook file for use with 
other applications (Figure 6.17). This lets you use them in a page layout
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program or other application without having to collect them manually. If 
you desire, you can add a numbered marker to the text file to facilitate the 
reconstruction of the document. You can edit the symbols surrounding the "#" 
symbol in the box following "mark location in text with:."

To use a named Scrapbook file with the standard Scrapbook desk accessory, 
you must temporarily rename the existing "Scrapbook File," rename the 
created file as "Scrapbook File" and place it in the System folder.3 
MathWriter  stores the equations as PICTs (the object form used by 
applications such as MacDraw™) and provides three grouping levels. The 
lowest level enables you to edit each character with draw programs. The 
middle level is satisfactory for most purposes. The last level preserves 
entire lines of text that contain mathematical expressions or graphics; use 
this option to transform a file of displayed equations into a scrapbook. To 
transfer individual mathematical expressions to other applications, use 
the Copy As Picture command on the Edit menu.

TEHT options:
® Tent only
O Text with line breaks

[3 Sane equations in scrapbook
Mark location in text uiith: (* # *) 
Name of Scrapbook file:
Demo.text.PICT

Equation parser mill conuert...
O each symbol into a separate PIC1
(§) groups of symbols into separate PICTs

O entire line containing symbols into a PICT

Cancel Saue

Figure 6.17 Automatic scrap saves graphics and equations to a scrapbook

RTF and other filters

The list of file types that MathWriter can read and write will change as 
other translators (or filters, as they are also called) become available. As 
indicated above, place a translator, i.e., filter file, in the same folder with 
MathWriter or in the System folder, and MathWriter  automatically

3SmartScrap™ can read scrapbooks located anywhere on the disk with any name.
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updates the File Type list you see here to include the new filter file. You 
must save a document in the standard Math Writer format to retain all the 
information required for further editing within MathWriter. Filters can 
support one- or two-way translations4 between MathWriter and other 
applications. Some translators may preserve only a subset of formatting 
information used by MathWriter—the minimal information required by 
the receiving application. Other file types may save all the information 
required to restore the original MathWriter file.

Save a Copy...

Save a Copy... allows you to save a snapshot of the current file, including 
the changes since the last save, under a different name, different file type, 
and different disk. The dialog box is the same as with the Save As... 
command. In contrast with Save As..., however, neither the name, the file 
type, nor the status of the active file is affected. The pop-up list of file 
types includes MathWriter 2.0, MW Default File, TEXT, and the names of 
optional translators. To use the optional types, simply place the 
MathWriter filters or translators in the folder with MathWriter or in the 
System folder, and MathWriter adds them to this list at startup. Although 
MathWriter reads text and RTF files (and eventually other formats, too), 
use the MathWriter format for documents that you intend to edit or print 
later using MathWriter.

Import Graphics File-

Import Graphics File... allows MathWriter  to read graphics directly from 
a file, without the need for the application in which you created the 
graphic (Figure 6.18). Therefore, you can directly transfer MacPaint, PICT, 
and Encapsulated PostScript files into a MathWriter file even on a 1 
megabyte Macintosh. You do not have to pass the graphics through the 
Scrapbook or switch between applications, but some cropping within 
MathWriter may be necessary with directly read graphics.

MathWriter displays in the scrolling window folders and the files that are 
the file type(s) designated in the pop-up menu: All Graphics Types, 
MacPaint, PICT, and EPSF. You have the usual commands for moving among 
disks or within folders on a disk, as described above for Open....

4 The MathWriter RTF filter reads files from all word processors which export in this format.
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Preferences...
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Figure 6.18 Insert Graphics dialog window
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Preferences... on the File menu (Figure 6.19) allows you to set global 
defaults to configure Math Writer for your needs. In contrast with document- 
specific conditions set in Doc Preferences, Preferences... lets you establish a 
default configuration for the primary startup file and for the New 
command on the File menu. These startup files are called "stationery." You 
can create stationery for each distinctive type of document you use and 
designate one as the default.

First, choose any combination of the floating windows (Templates, 
Palettes, Tools, and Font Table) for MathWriter to place on the screen when 
you start up.

After you select the combination of floating windows (Tools, Templates, 
Palettes, or Font Table) appropriate to your routine needs and position them 
on the screen according to your personal preferences and your hardware 
configuration, store these choices in the MathWriter Prefs file with a 
single click. Then use the Use current window setup button to store these 
choices in the "MathWriter Prefs" file.
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Preferences... [no default file]

Palettes Windows
□  Geometry
□  Operators
□  Math/Calculus
□  Sets
□  Logic
□  Arrows
□  Misc.
□  Brackets
□  Uariables

□  Templates
□  Palettes
□  Tools
□  Font Table
□  Libraries

j—| Load 
u  Libraries

[ Use current libraries 
—  
Use current window setup

U___________________________________________________I

Save copy of file 
as Default File

/x4x
r'EL^l
/x4x

j

□  Auto Screen Aefresh
□  File Warnings

Cancel GD
Figure 6.19 Preferences window

In addition, MathWriter stores document-specific preferences in stationery 
or default files. These files contain all other configuration choices such as 
default font, font size, and font style in the body, headers, footers, and 
footnotes, as well as text and graphics common to a specific type of 
document, such as an automatically dated memo with a logo. In the Style 
menu select which font, font size, and font style you want.

Click Save copy of file as Default File (Figure 6.20). The ensuing dialog box 
gives you a chance to name the default or stationery file and save it. The 
Select Default File (Figure 6.21) button opens a box that lets you select a 
previously created stationery file.

1 c d JAC-1 |

1 CD-Current f K> C3JBC-1

Tii [ E je c t  1

[ D rw e  ]

c>

Default File... ( Saue ]

Untitled A File ( Cancel ]
IL...........

Figure 6.20 "Save copy of file as Default File" dialog box
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□ Memo A File 
Q  misc ( *)«< * ]
a  M1112 .Of f Osipe J
CD Personal A Files 
□ Uniuersity Letterhead

( Select ] 

[ Cancel

[ None ]

Figure 6.21 "Select Default File" dialog box

The name of this default appears in the top-right corner of the Preferences 
dialog box. On startup, Math Writer retrieves a copy of the selected default 
file if one exists. To override this default, change the choice of the 
stationery file using the Select Default File button. You can manually open 
these default files, too. Click OK to accept changes made or use Cancel to 
abandon your choices.

The Auto Screen Refresh option (Figure 6.19) provides supplemental, timed 
screen refreshing. Ordinarily MathWriter redraws the screen locally and 
only as needed to minimize computational overhead. Use this option for 
additional automatic refreshing and 88 option Z for supplemental manual 
redrawing of the entire screen.

The file warning option enables advisory messages when you open a file. A 
warning of missing fonts, discussed in connection with the Open command, is 
often crucial to assure file content integrity. The names of missing fonts are 
listed. The enable/disable status of automatic file saving is noted when 
files are being opened.

The conditions established or reported by File/Preferences apply to all 
documents. Use File/Doc Preferences to establish document-specific condi
tions.

Doc Info-

In the Doc Info... window you see that Math Writer automatically tracks 
the number of sessions, the creation date, the date last modified, and the 
size of your document file (Figure 6.22). The Abstract/Notes box lets you jot 
down notes about the file.
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Page Layout...

Abstract/Notes:

Sessions: 
Creation date: 

Modification date: 
Size on d isk :

Space fo r k e y w o rd s , a b s t r a c t , and notes

8
Sep . 4 ,  1 9 9 0 , 1 1 :3 4 :1  0  PM 
N o v . 2 7 ,  1 9 9 0 , 9 :2 3 :3 2  AM 
1 7 1 ,0 6 9  b y t e s ( 1 6 7 K )

Pages: 16 
Paragraphs: 1 0 6  

L ines: 3 4 8  
Words: 3 5 0 3  

Memos: 0

Characters 
on base line : 2 0 ,8 0 6

in sub-expressions: 1 5 5
containing sub-expressions: 1

Total: 2 0 ,9 6 1

Unique ru lers : 1 6  
Unique s ty le s : 14 

Style  runs: 10 4
[_0K

Figure 6.22 Doc Info window

When you open the Doc Info... window, MathWriter  counts the number of 
pages, paragraphs, lines, words, equations, memos, characters on the base
line, characters in subexpressions, and characters containing subexpressions 
of your file.

The Page Layout... command on the File menu controls the page layout 
specifications for the document (Figure 6.23). The portrait at the right 
illustrates a sheet of paper. The outer rectangle is the size of the paper; the 
inner is the print area. The portrait changes to illustrate your choices of 
columns, margins, etc.

You can increase or decrease the size of the margins by clicking in each 
respective box and changing the values. Supply units abbreviation (without 
punctuation) of in, cm, or pt according to the units set in Format/Ruler 
Options. Out-of-range values will be indicated by a invalid answers 
will not be accepted. .250 in ? Clicking in the Max box gives a print 
area of 7.66 inches by 10.1 inches for an 8-1/2  by 11 inch sheet of paper. 
"Std" restores the previous values.
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Margins:
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bottom

Header height: 
Footer height:

□  Gutter

E3 Facing pages

Page Setup...

0.750 in
1.250 in

1.250 in
1.555 in

0.402 in
0 .0 0 0  in

0 .0 0 0  in
Page width: 6.50 in . Page height: 8.19 in .

Cancel J | OK ^

Figure 6.23 Page Layout window

MathWriter measures the margins from the physical edges of the paper, 
not the edge of the print area. The actual print area is smaller than the 
paper. For convenience, Math Writer adds the width of the white border 
and any additional margin length excluded from the print area to get the 
margin measurements. The dimensions of the print area, including the 
headers and footers, appear just beneath the miniature portrait. You can 
add an additional binding margin (gutter) to the margin.

The gutter is the extra space in the margin needed for binding. If you choose 
"Facing pages," MathWriter reserves this binding margin on the left side of 
odd-numbered pages and on the right side of even-numbered pages.

The area with the lighter shading at the top is the header and is within 
the print area. Headers and footers are always present, so set the header 
and footer heights to zero to assign this space to the main body of text, as 
done in Figure 6.23. The contents of the headers and footers appear 
automatically throughout the entire document as specified in Doc Layout of 
the File menu.

Page Setup (Figure 6.23) lets you set paper size, reduction percentage, orien
tation, font substitution, text smoothing, graphics smoothing, and faster 
bitmap printing. Click the Page Setup button. Page Setup has ImageWriter 
options and LaserWriter options. Depending upon the printer you chose in 
the Apple menu, your screen shows ImageWriter (Figure 6.24) or Laser
Writer (Figure 6.25) options.
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The LaserWriter offers more controls than the ImageWriter. Click Options 
(Figure 6.25). LaserWriter Options (Figure 6.26) lets you flip the image 
horizontally or vertically, invert the image, use precision bitmaps, use a 
larger print area, or use unlimited downloadable fonts. The Larger Print 
Area option increases the print area to 8 inches by 10.7 inches (see Table 
6.1). Click Help (LaserWriter Page Setup, Figure 6.25) for an explanation of 
these terms (Figure 6.27).

ImageWriter v2.7 f  OK |
Paper ® US Letter O R4 Letter

O US Legal O International Fanfold Cancel ]
O Computer Paper

Orientation Special Effects: □  Tall Adjusted
E7K □  50 % ReductionIjjgjll

a

□  No Gaps Between Pages

Figure 6.24 ImageWriter options

LaserWriter Page Setup______________________________________5 2
Paper: (•) US Letter O R4 Letter O Tabloid 

O US Legal O B5 Letter

Printer Effects:
□  Font Substitution?
^  Tent Smoothing?
^  Graphics Smoothing?
S  Faster Bitmap Printing?

Reduce or Ip 
Enlarge: la

Orientation

t 0K ))
Cancel^)

[ Options ]

[ Help

Figure 6.25 LaserWriter options

LaserWriter uptions v5,

..............

[ t ^ |

n  Flip Horizontal Cancel
□  Flip Uertical
□  Inuert Image
□  Precision Bitmap Rlignment (4% reduction)
□  Larger Print Area (Fewer Downloadable Fonts)

Figure 6.26 LaserWriter options dialog box



LaserWriter Page Setup Help:

Font Substitution: If selected, the LaserWriter substitutes 
for New Vork, Heluetica for Geneua and Courier for Monaco.

Smoothing: This is a fine-tuning feature that can make some tent 
and graphic bitmaps (such as from MacPaint™) look better.

Faster Bitmap Printing: Tent and graphic bitmaps print faster with 
this option selected. Howeuer, some documents may not print.

LaserWriter Options Help:

Precision Bitmap Rlignment: This option eliminates the minor 
distortion you may find in printed graphic bitmaps. It also prints 
faster. Howeuer, the entire page is reduced by 4%.

Larger Print Rrea: This option uses the extra memory in the 
LaserWriter to increase the print area instead of storing more fonts.

Figure 6.27 LaserWriter page setup help

Times

If you make layout changes to an existing document, a "thermometer" type 
indicator appears in the typeface area of the status bar at the bottom of the 
screen while MathWriter is implementing the changes. Under normal 
circumstances you should set the page layout before creating your document. 
If you change the layout after you create the document, the page width 
could shrink too small for certain equations or graphics. Additional options 
are available from the Print dialog box (Figure 6.28).

The Print Bialog lets you set LaserWriter print options.

First, designate the number of copies or which pages of the document 
you want printed. Then, under Paper Source, designate paper 
cassette or manual feed. Click OK to confirm the options.

For manual feed, go to the printer and wait for a steady middle 
yellow light. Then insert the paper face up. The LaserWriter 
draws in the paper.
Wait for the steady yellow light and insert the next sheet of paper, 
and so forth until the job is complete.

To print enuelopes: specify Landscape in Page Setup (File Menu) 
insert the enuelope face up with its long side against the right side of 
the guide.

See the LaserWriter manual for a complete description of manual feed.

Figure 6.28 LaserWriter help from the Print dialog box
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Doc Layout-

Table 6.1 Minimum margins and maximum print areas for the LaserWriter

8.5 x 11.0 inch paper Normal Max Larger Print Area

w x h print area 7.66 x 10.1 8.00x10.7

Min left & right margins 0.416 0.430

Min top & bottom margins 0.250 0.111

Doc Layout... of the File menu allows you to specify the placement of 
headers, footers, footnotes, and endnotes throughout the document by 
clicking on icons (Figure 6.29). For example, if you click the icon in the top- 
left corner of Figure 6.29, headers will appear on every page. Headers and 
footers can appear on every page, or you can skip the first page, skip the 
last page, or skip the first and last pages. You can specify that common 
headers and footers appear on all pages, that they be common except for 
the first or the last page, or that the left and right page headers and 
footers differ. Note that left pages are even-numbered pages and right 
pages are odd-numbered pages.

Layout o f  headers, footers , and footn ote/en dn otes .. .

Same for all pages

Trtvrzr

iilliil Sliil!! 7Z.Z.-1
rrv rz :

1 ■ •!
i

— — —

Le ft/Ricjht pages(ij!ii
%

i!in

F irst  page different

Footnotes
t .A b.A

T~ T z~ T~
Endnotes

— b.A b.A ----

T~
2

space before space between

E> 5 S I C i i i i i 2 Cancel t 0K 1

Annotations can appear on the page where cited, or be collected at the end 
of the document. If you click the icon beside Footnotes, footnotes can appear

Figure 6.29 Document Layout window
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on every page. If you click Endnotes, annotations will appear at the end of 
the document, as endnotes. The last three icons illustrated in the line with 
the footnote and endnote icons offer three styles for separating the footnotes 
from text. Click one to choose it. By dragging the scroll bar shown at the 
bottom of Figure 6.29, you can set the spacing between the text and footnotes 
(5-30 pixels) and between footnotes (0-20 pixels).

MathWriter automatically numbers footnotes and endnotes and automati
cally renumbers them if you add or remove a footnote or endnote. Even cross- 
references within the text are updated automatically.

To insert a footnote (or endnote), position the insertion point in the text and 
then select the footnote icon on the Palettes menu (or type 96 option F). To 
type a footnote's contents, move the cursor into the footer (not a separate 
window) and type. When you move the cursor into the footnote/endnote 
region, the cursor changes shape. The space for footnotes grows 
automatically upward as needed. MathWriter  adjusts the lower boundary 
of the main text to avoid a collision with the footnote. To avoid manual 
scrolling to insert the content and to scroll back to the insertion point in the 
body of the document, use the pop-up selector in the insertion point/ 
selection indicator in the status bar (see Figure 6.6).

Doc Preferences...

Doc Preferences... offers a variety of options (Figure 6.30) for your document. 
On the left side of the Document Preferences window are several styles: 
Style 1, Style 2, and Footnote/Endnote. Each of these styles has a specific 
function.

Document Preferences...

Styles:

Revision styles.

Style 1...

Style 2...

Footnote/Endnote.

list to ■liaises style

Huto saue IQli! I •..: : :iO|5 minutes 
□  IDarn me before sauing 

□  Huto backup during saues

S  Compact file Smart quotes

n= R □  R e v is io n  tra c k in g  [c lea n u p ,."

□  F ra c tio n a l c h a ra c te r  uncifhs

□  Line num bers 
O  per page 
O  continuous Cancel Q O

Figure 6.30 Document Preferences menu
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Styles 1 and 2 enable you to create and assign style combinations with a 
keystroke. Footnote/Endnote lets you set the footnotes or endnotes default 
style. Since the instructions for Style 1, Style 2, and Footnote/Endnote are 
similar, let's look at only one set of instructions. You will be able to apply 
what you learn to the others.

Click on Footnote/Endnote. The Set footnote/endnote style... window ap
pears (Figure 6.31). To select the font in which you want footnotes or end- 
notes to appear, choose Font by clicking the box to the left of Font. Then 
click the box to the right of Font to get a list of font choices. Select one. Note 
that the rectangular portrait box beneath Font, Size, and Style illustrates 
your choice. In a similar manner you can select the size of the font and 
whether you want footnotes right-justified, left-justified, centered, or 
aligned (i.e., simultaneously left and right justified).

Set footnote/endnote style

[*]Font | Palatino]

^  Size 19 |

0  Style [select style...

| Justification | Left |

[x] Line spacing select spacing...

Figure 6.31 Footnote/Endnote dialog box

Now click the Line spacing... box. Then click Select spacing. The Line 
spacing... window appears (Figure 6.32). Here you can choose Automatic, 
Mostly fixed, and Fixed spacing. Automatic spacing automatically spaces 
lines according to the maximum size of an expression such as a 
mathematical equation. Mostly fixed allows simple subscripts and 
superscripts to protrude into the leading between the lines. Mostly fixed is 
a combination of automatic (or flexible) spacing and fixed spacing. When 
typing tall displayed expressions, Mostly fixed reverts temporarily to 
automatic. Fixed lets you set spacing with the four buttons: Single, 1-1/2, 
Double, and Other. The ascent and descent for the three fixed spacings are: 
(9,3) for Single, (14,4) for 1-1/2, and (18,6) for Double. The Other category 
lets you set the ascent and descent separately. This is the control that 
allows you to squeeze an extra line onto a page.



To accommodate personal preferences and a variety of fonts, you can set the 
vertical position in the number of pixels above or below the ascent, descent, 
or baseline. The baseline is the imaginary line on which a line of text rests. 
The descent is the imaginary line to which characters, Such as g, j, p, q, y, 
and z, extend below the baseline. The ascent is the imaginary line to which 
stems of characters, such as b, d, f, h, k, 1, t, extend above the baseline. 
(Refer to paragraph formatting in Chapter 4.) The displayed equation 
adjustment allows you to set space above and below equations displayed on 
a separate line.

Fixed ascent

i d . u .................i 6  9
Displayed equation adjustment

f t r  " □ " 1 •' ~ r e u
Fixed descent + leading

EDL a  3 Cancel 0 3
Figure 6.32 Line spacing dialog box

Click OK to accept your line spacing choices.

You can use automatic line spacing while composing a manuscript when you 
do not want to be concerned with making a line spacing choice. If your writ
ing includes in-line expressions, you can modify the line spacing by selecting 
or highlighting the relevant text with the mouse or keyboard and applying 
the desired line spacing. NEVER compose built-up mathematical expres
sions using fixed line spacing because a portion of the text is likely to be 
clipped and the screen refresh for the line will not erase characters that 
extend outside the specified height. There may be instances when you will 
assign fixed spacing to previously created paragraphs that contain 
mathematics, however.

Next, let's look at styles. Click the Style box in the Set footnote/endnote ... 
window. Then click Select Style. This opens the Other styles window. Here 
you have an array of choices (Figure 6.33). Most of the boxes in the left 
quadrant of the window let you choose a particular style of font. Underline



Command Reference 189

and Low underline offer additional options. Click in the box beside 
Underline. On the right side of the window, Underline pattern and 
Underline weight are now available. Click in the box beside Underline 
Pattern. Math Writer offers numerous underlining patterns. Click in the box 
beside Underline weight. This lets you choose the width of the underline.

Sometimes combining two choices can be desirable. For example, selecting 
both Underline and Words only means that MathWriter underlines the 
words but not the spaces in your document. Underline and Low underline 
together produce double underlines.

Figure 6.33 Other styles

The last box in the group of font choices offers UPPERCASE, lowercase, and 
Cap. First as mutually exclusive choices. That lets you choose whether you 
want text in all capitals, all lowercase, or the first letter of each word 
capitalized, regardless of the shift key. Case changes can be applied to 
existing text without retyping.

The Condense/Extend box removes or adds one pixel, respectively, after 
each character. The Gray box opens a scroll bar for setting the percentage of 
gray. Background pattern gives you a collection of possible patterns for 
backgrounds. Usually a low (1-5 percent) range is appropriate. Finally, if 
you have a color monitor, Background color and Character color let you 
choose a color for the background of your text and one for text characters.

The extra computational burden associated with a color display can be a 
heavy penalty. To avoid this penalty, use the Control Panel on the Apple 
menu to set the Monitors to Black & White.

Click OK to accept your style choices.
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To set text styles for Style 1 and Style 2, follow the same procedures that 
you used for Footnote/Endnote.

Several other options remain in Doc Preferences. Look at the right portion 
of the window. If you click Auto save, Math Writer saves your document at 
intervals, the length of which you determine with the horizontal scroll bar 
to the right. Click Warn me before saving if you want MathWriter  to tell 
you it is about to save your document and give you a chance to decline the 
save. If you click Auto backup during saves, MathWriter  automatically 
makes a backup of the previous version of your file in addition to saving the 
current file. Auto backup causes the previous copy to be retained. Compact 
file reduces the file size by eliminating data added for faster scrolling, 
which can be regenerated when needed.

Click on Smart quotes to replace the typewriter style "quote" and 'apostr
ophe' with the curved style "quote" and 'apostrophe' some prefer. Frac
tional character widths let you control the character spacing more finely 
than the 1/72 inch resolution of the screen pixels. This option might be used 
when fine control is important, such as when using fully justified (left and 
right) text. Because this option sometimes makes the screen display less 
readable, enable this option immediately prior to a final review of the 
manuscript before printing.

NEVER use fractional widths with documents that contain mathematical 
expressions. When using this system call, verify that the printed results 
are satisfactory.

When you have completed your preferences for the document, click OK to 
accept changes or click Cancel if you do not want to make any changes in 
this window.

Overview...

The Overview command is not available in this version.

Print...( XT)5

Depending upon the choice of printer you made in the Chooser of the Apple 
menu, when you click Print on the File menu, an ImageWriter (Figure 6.24) 
or LaserWriter (Figure 6.25) panel appears. I f  your file has previously been 
set up for one printer and you choose the other, click Page Layout (File 
menu) and then click in the Page Setup box before printing. This sets up your 
document for the correct printer. Because the printers' requirements are 
slightly different, we recommend scrolling through the document to verify 
page layout before printing it.

5 The Macintosh user interface standard specifies this command key. If you are accustomed to Command-P for print 
rather than plain, refer to appendix 5 for reassignment instructions using Cmd Key Switcher.
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In general, you should choose a printer type before composing your document 
because your choice of fonts and sizing of graphics and equations may be 
affected.

ImageWriter: (Figure 6.34) With the dot matrix printer, you can choose the 
print quality (Best, Faster, Draft) appropriate for your purposes. Click the 
circle beside one of these to make a choice. For the Best quality, your system 
file should contain the bitmaps for the specified font sizes and the fonts of 
twice the size requested. If a particular font size is available to the system, 
that font size appears outlined on the Font size menu. The remaining 
options apply to both the ImageWriter and the LaserWriter (Figure 6.35).

ImageWriter V 2.7  [( OK 1
Qualitg: O Best <•) Faster o Draft
Page Range: ®RII O From: f[ J To: | | ( Cancel ]
Copies: 1

Paper Feed: <•) Automatic O  Hand Feed

□  Page Range Refers To Rctual Page Numbers 
Print Markers For:

□  Memos Q □  Ruler Changes ra □  Reuisions |
Print Multiple Copies: O  Together ® Separatelg 
□  Print Both Sides □  Reuerse order

Figure 6.34 ImageWriter controls

Laserlilriter “LaserWriter II NT” 5 .2

Copies: OZ Pages:® Rll O From: To:

Couer Page: <•) No O First Page O Last Page

Paper Source: (i) Paper Cassette O Manual Feed
□  Page Range Refers To Page Uariable Numbers 
Print Markers For:

□  Memos D  □  Ruler Changes ra □  Reuisions
Print Multiple Copies: (•> Uncollated O Collated
□  Print Both Sides □  Reuerse order 
Paper Motion Configuration:

T R A Y  MAN. | J J M |  T R A Y  MAN. MAN.

asr Em  is e  &
LW+ LW+ L W II LW II LW II

[ Cancel]

t He|P ]

I

Figure 6.35 LaserWriter controls



Copies: In the box beside Copies, type the number of copies you want. This 
is the default location of the insertion point and the default number of 
copies is one.

Pages: The default is Print All. To print only a portion of the active 
document, specify the beginning and ending pages in the boxes beside From: 
and To:. To print a single page, type the same number in each box. If you 
supply no value for To:, the end of the document is assumed.

If your file is part of a larger document, the page numbers in the headers 
may differ from the physical page numbers. Check Page Range Refers to 
Actual Page Numbers on the dialog box just below the paper feed option if 
you prefer using the page numbers from the document header or footer. [The 
header page numbers are set using Starting at in the Variables Format... 
(Format menu).] Alternatively, MathWriter will calculate and display 
the translated values for you. The number in the vertical scroll bar is the 
physical page number that always ranges from 1 to the maximum number of 
pages in the document. When you press on the scroll box the page variable 
page number for that page is displayed in the status bar.

Cover Page: (LaserWriter only) If you share a LaserWriter with someone 
else and want to identify your document after it prints, click First Page or 
Last Page. Then the LaserWriter prints a first or last page with your name, 
the name of your document, the date, the time, and the printer name.

Paper Feed/Paper Source: The ImageWriter options are Automatic and 
Hand Feed; the LaserWriter options are Paper Cassette and Manual Feed. 
With the manual options, MathWriter prompts you for single sheet paper 
feed. If you select Print Both Sides or Reverse Order, you will be given 
instructions. For these two options to work properly with a LaserWriter, 
you must specify the paper-feed configuration for your particular printer. 
The icons depict the path from tray or manual feed to output. To avoid 
making this choice repeatedly, create stationery (MW Default file) with 
this choice preserved for you.

Page Range Refers To Actual Page (Page Variable) Numbers: Click this 
option to use the page numbers from the document header or footer, rather 
than the number displayed in the scroll bar. To set the starting header page 
numbers click Variables Format... on the Format menu. That opens the 
Variables Format window. Move down to "page #" and click. That opens 
another window on the right under Variable Style. Find the box beside 
"starting at" and type the page number at which you want to start printing.

Print Markers for Ruler Changes: Select this option to print markers in the 
left margin of the document to help you locate these changes.

Print Multiple Copies: When printing multiple copies you can either print 
all copies of each page before advancing to the next page (Uncollated) or 
print all pages of the file before beginning another set (Collated).
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Uncollated is faster, especially if the file is graphics-laden, because the 
printer has to compose each page only once.

Print Both Sides: This option causes the printer to print the odd- and even- 
numbered pages separately. You must identify the specific Paper Motion 
Configuration of your LaserWriter for this to work properly and reposition 
the paper as instructed (after all pages from one side have been printed). 
The first and second icons correspond to the older LaserWriter Plus.

Reverse Order: Check this option to print the pages in reverse order, i.e, 
reverse order in the output tray. When this option is not checked, the 
LaserWriter uses your Paper Motion Configuration so that the pages will 
appear in the output tray in the normal reading order. The actual printing 
sequence depends upon the hardware.

Quit (#Q>
This is the standard last menu item on the Macintosh File menu. Use this 
command or its command key equivalent 96Q to terminate the application. 
MathWriter reminds you to save modified files of any type before termi
nating the program.

The Edit Menu
The Edit menu (Figure 6.36) transfers formatted text and graphics, rulers, 
paragraph formats, styles, and text converted to PICTs from one location to 
another. Edit also provides a generalized find and replace facility that 
searches both mathematical expressions and text. Spell-checking appears 
on this menu.6 To access the entire Edit menu on a small screen, move the 
mouse to the small, triangular arrow at the bottom of the first portion of 
the menu and drag.

Undo (#Z)

The Undo command restores the document to its status prior to the most 
recently executed command. Undo lets you explore alternatives as well as 
correct mistakes. Undo is not available for a few situations (such as global 
replace and within mathematical expressions).

Math Writer uses spell-checker code from M icrolytics.
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Edit Edit
Cut (96X), Copy (960

The Cut and Copy commands are 
dimmed and disabled until you se
lect the portion of text you want to 
act upon. This is consistent with the 
Macintosh convention that an object 
must be selected before a command is 
issued. The Cut command removes 
the selected material from the 
document and places it on the Clip
board for subsequent transfer to 
another location, while the Copy 
command simply copies the selected 
material to the Clipboard without 
disturbing the original. To view the 
contents of the Clipboard, pull down 
the Windows menu at the top of the 
screen until you reach Clipboard and 
then release the mouse. The Clip
board stores material from only one 
Cut or Copy operation at a time. 
Clear removes a selection, but does 
not affect the Clipboard. The Clip
board remains intact even after you 

exit MathWriter, allowing you to transfer material to another application.

Undo Typing W.Z

Cut
Copy 3§C
Paste Picture
Clear
Select Rll m
Copy Other ►
Paste Other ►
Shout Selection
Reoiso Selectio n
UnReuise Selectio n

Find. Replace 3€F
Find Newt *:G
Replace Selection *H

Check Spelling...
▼

Figure 6.36 Edit

Clear
Select Rll *R
Copy Other ►
Paste Other ►
Shout Selection
R eoise P a ra g ra p h
UnReuise P arag rap h

Find/Replace... 9€F
Find Next :#:&
Replace Selection

Check Spelling...
T h e sa u ru s ...
H yphenation ►

Insert ►
Delete ►

(scrolling with arrows)

Paste (#V)

Paste inserts into the document material previously cut or copied to the 
Clipboard. Click the I-beam at the place in the document where you want 
to paste material. Then pull down the Edit menu to Paste and release the 
mouse. The pasted material appears in the document. If you select or 
highlight a portion of text and then use the Paste command, MathWriter 
replaces the highlighted portion with the contents of the Clipboard. 
Unlike Cut or Copy, Paste does not remove material from the Clipboard; 
instead, you can paste Clipboard material into another document or even 
into a document of another application. (See Table 6.2 for a summary of 
these commands.)

Clear

Clear removes a selection of a document without placing a copy of that 
selection on the Clipboard. It is equivalent to pressing the delete  key. Use 
this command to remove large blocks of text when memory is limited.
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Table 6.2 Editing summary

Action
Affects

document
Affects

Clipboard

Cut yes yes

Copy no yes

Paste yes no

Clear yes no

Delete yes no

Select All (XA)

Select All selects all of the material in the portion of your document (body, 
header, etc., identified in the pop-up menu at the insertion point locator in 
the status bar) that contains the insertion point. From the keyboard you can 
also select everything by clicking just before the first item and then shift 
clicking at the end. Various cursor key combinations also provide selection 
capabilities (see appendix 3).

Copy Other

Cut, Copy, and Paste apply to the combination of types of textual and 
graphic material within a selection. However, you can choose various 
types of formatting information such as Ruler, Format, Ruler and Format, 
Style, and Picture and copy them using Copy Other (see Figure 6.37). Copy 
Ruler, Copy Format, and Copy Ruler and Format relate to the paragraph 
containing the blinking insertion point.

Copy Ruler (X shift R) copies only the ruler and associated tab settings. 
Copy Format (X shift F) copies only the values you set using Paragraph 
Format... and Line spacing... of the Format menu. Copy Ruler & Format (X  
shift A) combines these two commands. Copy Style (X  shift  S) relates to 
text you select or highlight and copies all the information prescribed in the 
Style menu. Copy As Picture (X shift [ ) turns the selected material into a 
PICT format graphic element and places it on the clipboard. Use this 
command if you wish to transfer an equation to another application.

Copy Other ► Copy Ruler rneoR
Copy Format aeoF
Copy Ruler B Format * O R
Copy Style &OS
Copy Memo V A Ni
Copy fls Picture 8§t>[

Figure 6.37 Copy Other from the Edit menu
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Paste Other

Show Selection

Paste Other (Figure 6.38), which complements Copy Other, pastes the 
information you retrieved with Copy Other into the document at the 
location of the insertion point. Paste Other includes: Paste Ruler (S€ shift  
T), Paste Format (Si shift  G), Paste Ruler and Format (Si shift  Z), Paste 
Style (Si shift D), and Paste In Context (Si shift  V). When you use the 
additional command, Paste In Context, pasted text assumes the type 
characteristics of its new context, rather than preserving its original.

Paste Other ► Paste Ruler
Paste Format
Paste Ruler & Format
Paste Style §€ O D
Paste  Memo N
Paste In Content a§ou

Figure 6.38 Paste Other from the Edit menu

Show Selection scrolls to the paragraph containing the blinking insertion 
point of the active window.

Revise Selection (Si M) and UnRevise Selection

Revision tracking is not available in this version.

Find/Replace... (Si F)
Find/Replace... is a generalized, substantially enhanced search utility 
(Figure 6.39). One of the consequences of Math Writer's total integration of 
mathematical expressions into text is its ability to search for such expres
sions. You can replace portions of mathematical expressions provided you 
can select the unit with the I-beam cursor. In other words, Math Writer only 
locates portions of expressions that extend to the baseline.

The Find: and Replace with: categories are completed by the more specific 
choices in the Match and Affect pull-down menus. The match can be on text, 
and additionally on any combination of font, size, style, case, or word. The 
Affect list includes text only, or text in combination with font, size, and 
style.
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r— --------------------------------------------- ----------—------ -------------- —
Match Affect Wildcards Special Direction £

[ Find 38F ] | Replace, then Find ] [Replace 3€H [ Replace All

Figure 6.39 Find/Replace window

Find Next (9SG)

The Find Next menu command (or the Find dialog button) searches for the 
next match.

Replace Selection (S6H)

Replace Selection replaces the selected text with the previously specified 
contents of the Replace window.

After specifying the search and replace contents and search filter, you 
have the option of controlling the search from the keyboard. Press return to 
remove the Find/Replace window and initiate the search from the inser
tion point. Use Find Next G) and Replace Selection (M H) to control the 
substitutions from the keyboard. If you leave the Find/Replace window in 
view, you can use the mouse to activate Find; Replace, then Find; Replace; 
and Replace All buttons.

The Find/Replace feature illustrates one of the primary design goals of 
MathWriter; to extend the scope and power of virtually every feature of 
traditional word processors without making tasks more difficult to perform. 
For example, using the defaults that exist when you activate MathWriter  
(find text, match text only, replace with text, affect text only), the 
commands Find; Replace, then Find; Replace; and Replace All perform in 
the customary manner. In particular, suppose you type a text string in the 
large Find: text box and another text string in the large Replace with: text 
box. When you click the Find button, the search starts from the location of 
the blinking insertion point and advances through the file until it finds a 
substring match or reaches the end of the file. If it finds a match, you can 
abandon the search; click the Replace button to make the substitution; click 
the Replace, then Find button to make the substitution and search for
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another match; or click Replace All to automatically replace all other 
matches without your intervention.

Warning: Use Replace All with caution because Undo does not apply to 
this command. Unless you have made a backup before using this command, 
you may be unable to easily restore your document if unanticipated changes 
result.

Find/Replace
Match Rffect Special Direction

Find:

Replace with:

[ Find %F )

word 
Symbol 
Structure
Template Category... 
Template Object...

[ Replace, then Find [Replace 36H [ Replace Rll

Figure 6.40 Find/Replace window has seven menus

MathWriter provides five pull-down menus as part of its very powerful 
search capability. Using these menus (Figure 6.40 and Figure 6.42) it is 
possible to define very complex search and replace strategies quite easily.

You can search on text strings, typeface, or any combination of these using 
combinations from the Match menu. For example, to search for a text string, 
regardless of the combination of font, size, or style, the combination of 
upper and lowercase, or whether it is a whole word or embedded string, you 
set Match to Text only. Any combination of the Match menu items can 
replace Text only to allow you to locate text having those qualifying 
attributes, too.

MathWriter supports five types of wildcards (Figure 6.41 and Figure 6.42):

• word represents any leading or trailing string of zero or more characters, 
comparable to the in MS-DOS. •

• ? matches any single character in a string, comparable to the "?" in MS- 
DOS.

?A represents a mathematical structure.

y/i
word j:

Figure 6.41 Wildcards for searching



Command Reference 199

Match
v/Te«t only

Font ^Tent only
Size
Style Font
Case Size
Words Style

Wildcards
Word
Symbol
Structure
Template Category... 
Template Object...

Special
Tab
Line Break 
Column Break 
Page Break 
End of Paragraph 
Character Code... •

Direction

✓ Forward

? Backward

Wrap around

Figure 6.42 Find/Replace menus

• You can use any of the ten classes or rows of mathematical structures on 
the floating Templates window in a search. Any template icon at the 
beginning of a row in the Template window is the Template Category 
(Figure 6.43) of that row and is used to match any template within that 
row.

• You can locate specific templates (Figure 6.44) using the Template Ob
jects list.

You can also search for invisible formatting characters (Tab, Line Break, 
Column Break, Page Break, and End of Paragraph) by name (Figure 6.45) or 
ASCII number (Figure 6.46).

A search begins wherever you place the blinking insertion point whose 
relative position within the file is indicated in the box to the right of the 
direction menu (Figure 6.42). You may direct the search to the end or begin
ning of the file or wrap from the end to the beginning for a complete search 
of the document.



Figure 6.43 Template categories

Figure 6.44 Template objects
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♦

a
□
<n

Figure 6.45 Invisible formatting commands and display characters

Special
Tab
Line Break 
Column Break 
Page Break 
End of Paragraph 
Character Code...

Enter character code:

(•) Hen
O Decimal

Cancel OK___________ ^ l —

Figure 6.46 Search for individual characters by ASCII code

Check Spelling...

When you began Math Writer, you should have placed the main and user 
dictionary files in the same folder with MathWriter or in the System fold
er. Otherwise, you must locate those files by clicking Check Spelling in the 
Edit menu and then the corresponding buttons Main Dictionary and User 
Dictionary in the Spell Finder window (Figure 6.47). Only one User dic
tionary can be open at any time.

Spell Finder® from Microlytics1

Main Dictionary: Mathlllriter Dictionary

( User Dictionary:] MID User Dictionary

Status:

S  Alternates I

0  Skip capitalized words 

Change to:

0  Check for repeated words

Check | ( Replace Skip Learn Cancel

Figure 6.47 Check Spelling options



202 Chapter 6

If you want MathWriter to offer possible spelling alternatives, before you 
begin checking spelling, check the Alternates box. Check Skip capitalized 
words if you do not want to check them, and click on Check for repeated 
words if you want the program to look for words that have accidentally 
been typed twice. Click Check to start the spell-checking at the insertion 
point. Misspelled words appear in the rectangular box under Status. A bar 
chart to the right indicates where in the document spell-checking began 
and how far the search has gone. A dialog box appears to let you choose 
Continue Checking or Stop Checking.

If the spell-checker finds a misspelled word and the Alternatives box is 
checked, Math Writer pauses to generate a list of suggested spellings. If you 
recognize the word being examined as correct, clicking the mouse aborts the 
alternatives-search process. If the alternatives listed in the pop-up menu 
include the correctly spelled word, click on the word to transfer it into the 
Change to field. Otherwise, you must type the correct word in the Change 
to box. Click Replace to replace the misspelled word in your document with 
the correctly spelled one.

Warning: The presence of a word in the dialog box does not necessarily 
imply a suggested spelling. Check the status line and the alternatives list.

The Skip choice tells MathWriter  to ignore a possible misspelling. Click 
on Learn to add the word to your user dictionary. You can also return to the 
document window, edit the text, open the Check Spelling window once 
more, and click Check to resume checking. Anytime after you return control 
to the spell-checker, you can terminate checking by clicking Cancel.

When two identical, consecutive words are found, a message is placed after 
the inconspicuous word Status: and you either click Replace to delete it 
(and a space character) or click Check to retain the repeated words and 
resume checking.

When the checker encounters an unknown, but correctly spelled word that 
you are likely to encounter in the future, click Learn to add it to the User 
Dictionary. To remove a word from the User Dictionary, click Edit in the 
dialog box; MathWriter opens a window that lets you edit the User 
Dictionary. Select a word in the scrollable list. If you want to delete that 
word, click Delete Word.

Thesaurus...

The Thesaurus command is not available in this version.

Hyphenation...

The Hyphenation command is not available in this version.
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Insert, Delete

Insert and Delete (Edit) extend the cut and paste commands to apply to 
rows and columns of matrices or tables. To enable these commands, first 
create a matrix or table and then select a cell using the split I-beam 
(Figure 6.48).

1,1 (E

2,1 2,2

(0 ,2) Base ] 0
Figure 6.48 Select a cell of an array

With the Insert command (Figure 6.49) you can create a new row before or 
after the row of the selected cell or create a new column before or after the 
selected cell (Figure 6.48). Use the split I-beam to edit within the newly 
created cells.

Insert
Delete

Figure 6.49 Insert row or column in an array or table

Rom Before * o q
Rom After * 0  LI
Column Before * t > 0
Column After

When you click Delete (Figure 6.50), Math Writer deletes the row or column 
passing through the selected cell.

Delete iJ Rom * O J
Column * O K

Figure 6.50 Delete row or column of an array or table

The Format Menu
The Format menu (Figure 6.51) contains such selections as paragraph for
matting, matrix formatting, and footnotes. The basic unit of organization in 
MathWriter  is the paragraph—created when you press the return key. The 
ruler always remains at the top of the window and never scrolls out of view. 
If desired, you can hide the ruler. The ruler units can be inches, centimeters, 
or picas and can begin at the left of each column or at the left boundary of 
the window.
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Hide Ruler/Show Ruler (Si ')

The first command, Hide Ruler, toggles with Show Ruler. When 
you select the Hide Ruler command, the tab and justification 
controls from the vertical scroll bar (Figure 6.52) disappear too. 
The ruler displays the formatting information for the para
graph that contains the blinking insertion point.

Ruler Options

Ruler Options lets you choose from a pop-up menu (Figure 6.53), 
a ruler measured in Inches, Centimeters, and Points (Figure 6.54) 
that correspond to the 1/72 inch pixels on the Macintosh screen. 
Page Ruler on that menu toggles with Column Ruler; they 
measure from the left border of the page or from the text 
boundary, respectively.

Figure 6.51 Format menu

Format
Hide Ruler
Ruler Options ►

Paragraph Format...
Line Spacing...
Matrin Format...
Uariables Format...

Insert Memo 
Insert Column Break 
Insert Page Break

Calc Preu / or I Size 36D

Hide Layout 
Hide Messages 
Shorn Inuisibles 
Hide Pictures

6  File Edit Format Palettes Diac Style Windows

Figure 6.52 Show/Hide Ruler command
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Ruler Options ► ✓ Inches
Centimeters
Points

Page Ruler

Figure 6.53 Ruler Options

Inches: I Ip. i ■ i . i . M. i ■ i . ' ■ 12. 1 , 1 . 1 . 13. 1
A i

Centimeters: I IQ.. . li.... 12 ... 15... 14 ... 15... 16... 17 .. ri3~l
___ A i  ... ..... .. . ... . .

Points: No. . . ............... Moo. . ................. ..  7~
■*• 1

Page Ruler: I  ̂ .......................  , .............. I500.

Figure 6.54 Ruler units

Paragraph Format... (96 J )

To change the format of a paragraph, place the cursor within that para
graph to select it. Now, click on Paragraph Format.... Within the Para
graph Format... window, you can set the vertical spacing before and after 
paragraphs from 0 to 40 pixels by scrolling within the arrows under 
"Spacing". This eliminates the need to type more than one return at the end 
of a paragraph, regardless of the spacing you desire. In this window you can 
also tell MathWriter to link paragraphs, begin a new page with a 
particular paragraph, or not split a paragraph over a page break. Use the 
Page break before option to force the text that immediately follows the 
insertion point to appear on the first line of the following page.

Paragraph format... 
.....................Spacing..................

Before SI IQ I I : :.l| C\ 0
After SI \Q\ l : • :~[Ql 0

Borders

..................Attributes ....................
□  Link to ne«t SI
□  Column break before
□  Page break before
□  Can't split ouer page break

tilhitespace |Qjj|j

Click above for thickness and pattern
Cancel G D

Figure 6.55 Paragraph format window



No icon is associated with Page break before. Use this dialog box 
(Figure 6.55) to verify its existence or to remove it.

................Borders.................................
♦ _ v— vyvyvvvyvyvyvyvvv-

0 M m \

Click above for thickness and pattern 

Figure 6.56 Paragraph borders

Click at the center of the shaded paragraph icon at the bottom-left corner 
of the window to place borders on all four sides of the paragraph 
(Figure 6.55 and Figure 6.56). Click on or near individual sides to select or 
"deselect" each of the four borders separately. A paragraph portrait just to 
the right displays the borders selected. Borders consist of one or two lines; 
you can assign the line thicknesses and patterns as well as the background 
pattern for the entire paragraph. Whitespace (Figure 6.55) refers to the 
space between the paragraph and the inner border measured in pixels. 
Click in the paragraph portrait to open a window that assigns Outer 
borders, Inner borders, Background pattern, and Space between borders 
(Figure 6.57).

Select thickness and pattern... 
—  Outer border............................

Thickness
Pattern

—  Inner b

Thickness
Pattern

.....  Backgn

Pattern

Space betic

: : : : :
a s s s  w w

iCDOC

m m
•'*/*/*/*? ********'

565$ ;
♦♦♦♦■ gray

Cancel

M  2

if ok ))
Figure 6.57 Pop-up menus for border lines and patterns
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No inner border
Hairline Hairline
1 point 1 point
2 2
3 3
4 4
5 5
6 6
7 7
8 8

Figure 6.58 Border line thicknesses

• » »  m t i
6 5 6 6  5 5 5  WOW 
infinc

y/// e e e e  t t t t
yyyy*} . a a a a a a a a

56565
>44>44 gray

Pattern | Gray stale | [Q| • , 5: I ! .....................j ^  50

Space between borders lOPIl R j I ! ’ .'ll,lit,! .• : :jrt>l 2
Figure 6.59 Pattern palette

Use the pop-up menus available when you click the rectangles beside 
Thickness and Pattern to set line thickness, line pattern, and background 
pattern for each (Figure 6.55 and Figure 6.56). Drag to select from among the 
choices. The line thickness choices range from hairline to 8 point in one 
point increments (Figure 6.58). Math Writer has a No inner border option for 
the inner border. When you choose "gray" from the bottom-right corner of 
the pattern pop-up menu shown in Figure 6.59, a scroll bar for setting the 
percentage appears on the right. "Space between borders" has a scroll bar 
that lets you set the space between inner and outer borders of a paragraph 
box.



With Automatic line spacing enabled, MathWriter  automatically spaces 
lines to include the maximum size of such expressions as mathematical 
equations (Figure 6.60). Mostly fixed means that MathWriter allows 
simple subscripts and superscripts to protrude into the "leading" between 
the lines. Fixed lets you set the spacing using four buttons: Single, 1-1/2, 
Double, and Other. Samples appear at the right, as in Figure 6.60. The 
default ascent-and-descent-plus-leading values for the three fixed spacings 
are: (9,3) for Single, (14,4) for 1-1/2, and (18,6) for Double. The Other 
category lets you set the ascent and descent separately. Ascent is the height 
provided for the characters above the baseline on which the letters rest. 
Descent plus leading is the space allowed for the character below the 
baseline.

You can use automatic line spacing while composing a manuscript when you 
do not want to be concerned with making a choice. If your writing includes 
in-line expressions, you may wish to modify the line spacing subsequently to 
achieve greater uniformity. To modify the spacing, select the relevant text 
using the mouse or keyboard and apply the desired line spacing. Never 
compose variable-height mathematical expressions with fixed line 
spacing because portions of the line may be displayed improperly and 
inadequately refreshed.

Figure 6.60 Line spacing dialog box
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Matrix Format...

This window (Figure 6.61) controls matrix and table formatting. Under 
Placement, click on "descend below line" to place a matrix below a line of 
type. "Center on line" centers it within a line of text.

Click in the box below Line type. This opens a window that lets you choose 
the thickness and pattern of the outer border of a matrix (Figure 6.62). 
Select an outer border pattern by clicking in the box beside Pattern. Since 
matrices use single line borders, the inner border is not enabled. Select a 
background pattern by clicking the box beside Pattern. Click OK to accept 
changes or Cancel to reject them.

The alignment of elements within the matrix can be centered (most often 
used for symbolic expressions), positioned to the left or right, or decimal 
justified. Under Justification, click on center, left, right, or decimal to align 
elements within the matrix. MathWriter automatically handles the 
spacing of rows and columns. It reformats a matrix with each input 
keystroke. Changes made while a matrix is selected apply only to that 
matrix; changes made with none selected apply to all subsequent matrices.
Cell spacing affects the size of the cells of a matrix. Drag the vertical and 
horizontal arrow icons to change the size of the cells vertically or 
horizontally (Figure 6.61).

Placement Line type Justification
descend line

below

center on line

Click here to 
select

thickness and 
pattern

■ .... <EI Cell spacing

B horizontal spacing = 10 points 
vertica l spacing = 5 points

[  0.1 100.01
[ .1.000 10.1 cen ter

[ 0.1 100.01]
L 1.000 10.1 J

[ 0.1 100.01] 
L 1.000 10.1 J

[ 0.1 100.01]
L 1 . 0 0 0  io . i  J

le ft

rig h t

decim al

□  f i ik jrs  r< m n Cancel t QK 1
Figure 6.61 Matrix format window
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Select thickness and pattern... 
.....  Outer border...........................

Thickness
Pattern

..... Inner border

Thickness j 
Pattern

.....Background pattern

Pattern [

Cancel G D
Figure 6.62 Line type window

Variables Format...

Variables Format... on the Format menu (Figure 6.51) lets you select format
ting options for such variables as the date, time, page number, and footnote 
marker. These variables automatically appear in the text in the form that 
you choose here. Show Invisibles (Format menu) displays a dotted box 
around these dynamic variables.

Click on Variables Format.... Then click in the box Variable Style:. To the 
left of this window is a Variable Style box. Click in that box. A window 
opens that lets you choose Font, Size, Style, Justification, and Line spacing 
for each of the variables in the Variables Format window (see Figure 6.64). 
(For a discussion of these, go to Doc Preferences...(File menu).) Click Cancel. 
You are back in the Variables Format... window. If you do not select 
Variable Style, the typeface matches the adjacent text. Alternatively, 
whatever style type you assign here overrides the style of the surrounding 
text as far as the variable is concerned.

Creation date [fill and current date m Select "creation date" from the 
group of variables at the left (see Figure 6.63). In the rectangular box to the 
right of the Variables Format window are various choices such as 
month/date/year (m/d/y) and date/month/year (d/m/y). Click in the 
button beside m/d/y. An illustration of your choice appears in the box 
labeled "example" in the lower-left comer of the window. Click "leading 
zeros," and a zero appears before single-digit numbers. Click "short year,"
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and the year appears in two digits rather than four. Click "month, date, 
year," and the month appears as a word rather than a number. Click "day, 
month, date, year," and the day and month appear as words rather than 
numbers. Click "abbrev. month" and "abbrev. day," and the month and day 
are abbreviated. Click OK to accept your choices or click Cancel to reject 
them.

Uariables Format.

[i] creation date
[T] current date 
US creation time 
Q  current time

0  page #
$  # of pages in document
1 footnote/endnote
TT re-reference footnote/endnote o

Nem, Rename

Example

Uariable Style.

(§) M/D/V 

o M-D-V
o D/M/V 
OO-M-V

Leading Zeros 
Short Vear

O Month, Date, Vear 
O Day, Month, Date, Vear

E3  Rbbtem Month 
M Rhhreo. Day

1 2 / 0 4 / 9 0

Cancel I
Figure 6.63 Creation date format

Click "current date." Note that the choices here are the same as those for 
"creation date."

: Click "creation time." (See 
Figure 6.65.) To the right of the Variables Format window are various 
choices such as hr:min:sec and hr:min. Click hr:min:sec. An illustration of 
your choice appears in the box labeled "example" in the lower-left corner of 
the window. Click hr:min, and only the hours and minutes appear. Click 12 
hr., and AM and PM appear beside the time. Click 24 hr, and hours are 
numbered from 1 to 24.

Click "current time." Note that the choices here are the same as those for 
"creation time."

Creation time i □□ and current time ©



Set style for current date variable...

□  Font

□  Size j ...) □  Justification

D  s t Ule [Select s t y le ,, , '  D  Line spacing I sp<;<log,,.

The current date variable appears like th is. The Font, Size and 
Style are taken from context.

Cancel

C O
Figure 6.64 Style assignment for variables

Page number\2h and number of pages1L̂ !J: Click "page #." (See Figure 6.66.)&
Depending on which type of numbering you want, choose Roman numerals 
(i,ii,iii,...), uppercase Roman numerals (I,II,III,...), or traditional Arabic 
numerals (1,2,3,...) from the left side of the window. In the box labeled 
"leading text" you can type "Page" and in the box "trailing text," you can 
type "of " and produce an entry such as "Page 3 of 25" if you also use the 
number of pages variable. If this file is a continuation of a previous file and 
you want the page numbers of this file to pick up where the other left off, 
type the correct beginning page number for this file in the "starting at" box, 
but omit the total pages variable.

Footnote/endnote l_ l  and re-reference footnote/endnote LSI : Math Writer
formats footnotes and endnotes alike. It offers five automatic numbering 
styles: example1, example121, example(3), example[4], and example(5), as 
well as a collection of symbols (see Figure 6.67). Click in the buttons at the 
right to choose which type you prefer. If you need at most six footnotes, you 
can define and use symbols of up to three characters. If this file is a 
continuation of a previous file, you can assign a starting footnote number 
where the numbering for the previous file ended.
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Figure 6.65 Creation time format

Uariables Form at...

[T] creation date  

[7] current date  

Fog creation time  

®  current time

0  page #

O

[5S # o f pages in docum ent  

~  foo tnote/endnote  

IT  re -re fe re n c e  footn ote/en dn ote O

Rename

Example

T~

Uariable Style.

O  i, " ,  iii

O  I, M, Ml
®  1, 2,  3

Leading Text 

Trailing Text

Starting Rt 1

Cancel IL^JI
Figure 6.66 Page number format
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Uariables Format...

[t] creation  date  

[3 current date  

m  creation time  

0 current time  

0  Pa9e #
$  # o f pages in docum ent

i footnote/endnote

i -  re -re fe re n c e  footn ote/en dn ote

O

O

Uariable Style...

New. R enam e.

Example

1
(•) e x a m p le 1 Starting Rt 

O e x a m p le 11'

O  exam ple1'1'1 

O example[1 ]

O e x a m p le d )

O Use Symbols

* * * * * * t t t •

Cancel OK

Equation number

Figure 6.67 Footnote format

and You can format equationequation reference
numbers and references to equations within the text (Figure 6.68) in several 
standard styles: with or without a descriptive text label; with Arabic or 
Roman numerals; with parentheses, brackets, braces; or with a user-defined 
symbol. You can, of course, assign the starting number. Here are some 
illustrative examples: 10, 5.10, 5-10, J, j, X, x, [eq. 10], (5.10). Click in the 
buttons at the right to choose which type you prefer. The example box 
illustrates your choices.

Subequation # LitLl: A subequation variable automatically numbers groups of 
equations that are subsidiary to other equations. MathWriter  offers five 
numbering styles (Figure 6.69): lowercase and uppercase Roman alphabet, 
Arabic numerals, and lower and uppercase Roman numerals. You can 
separate these from the equation number by a dash, period, or no space. 
Here are some illustrative examples: [la], lb, lc, [1A], 1.1, 1.2, 1.3, 1-1, 1-i, 
5.10.1, and 5.10.2. Subequations inherit the label and enclosing symbols 
assigned to the equation numbers. Click in the buttons at the right to choose 
which type you prefer.
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Uariables Format.

0  page #
[55 # of pages in document 
T~ footnote/endnote 
r r  re-reference footnote/endnote
2 # equation #

sub-equation # 
equation reference

□# User category * O

Neu*. Renam e,,,

Example

1]

Uariable Style...

® 1 ,2 ,  3 O H , B-RH, BB
0 « . 1 , k .2 O  a, b-aa, bb

O h-1, h- 2 O l , l l , I M  

O  i, ii, Ni

O  —  < •)[_]  0 (- 

o Other) { |—  [ T

_ )

Starting Rt 11
Label

Cancel OK

Figure 6.68 Equation number format

Uariables Format...

0  page #
# of pages in document 

T~ footnote/endnote

re-reference footnote/endnote 
2 * equation #

B
equation reference

n# User category *

O

O

N e m „ . Renam e,,,

Example

Uariable Style...

(§) a, b, c-aa, bb, cc 

o fl, B, C-flfl, BB, CC
O  1 , 2 , 3

O  I, i i ,  III
O  i, ii, iii

®  H 0 “H O  K

[la]

Cancel 1 °K 1
Figure 6.69 Subequation number format
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User category sub-User category \*ki, User category reference L SI: User' l l

defined variables (Figure 6.70 and Figure 6.71) are a generalization of the 
equation numbering variable described above. The formatting options are 
the same. However, you can create a user-defined variable as needed for 
paragraphs, figures, tables, theorems, lemmas, etc.

In the dialog box shown in Figure 6.70, scroll to User category #, click 
Rename, and MathWriter  asks you to rename the category (Figure 6.72). 
MathWriter renames three new entries analogous to equationnumbering. 
Supply formatting information. You can edit the default label Category 1, 
which initially is the same as the category name you assigned.

Uariables Format...

T~ footnote/endnote
re-reference footnote/endnote 

2 # equation #
2a sub-equation #

2  ̂ equation reference

n# User category
in sub-User category *

11* User category reference

Cr

o

Rename.

Example

[Category

Uariable Style.

@11,2,3 O H , B-HR, BB
O k . I , h.2  O a, b-aa, bb

O h- 1, h-2  0 1 , 11,111
O i, »i, iii

O — (§)[— ] 0 (- 

O Other|{ |—  [ G

Starting Rt 11|
Label
Category 1

Cancel G O
Figure 6.70 User-defined category format

MathWriter numbers the entries consecutively when you select the 
variable. Even if you intersperse additional entries among existing 
variables, MathWriter automatically updates the higher numbered 
variables. If you insert a reference to one of these variables into the text 
using the re-reference command from Palettes, MathWriter  automatically 
updates those textual references also.

Computer-supplied variables in the document remain linked to the defini
tion and conditions established in Variables Format. If you make changes in 
the Variables Format dialog box, the implementation throughout the 
document is immediate. Similarly, format changes must be made here, 
rather than in the document.
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Uariables Format...

F" footnote/endnote
re-reference footnote/endnote 

2 # equation #
£  sub-equation # 

equation reference 
□# User category *

sub-User category

i>

U* User category reference m
Rename.

Example

[Category 1 la]

Uariable Style...

Cancel

<•> a, b c-aa, bb,cc
O H , B C-fiR, BB, CC

0 1 , 2 3

O  i, M Ml
O i ,  ii, iii

® H O - K  O-K

GO
Figure 6.71 User-defined sub-category format

1 Rename category...

|||Uset category

Cancel |( Rename
-

Figure 6.72 Name user-defined variable

Insert Memo

The Insert Memo command is not available in this version.

Insert Column Break, Insert Page Break

The Insert Column Break is not available in this version. Click on Insert 
Page Break to move the text that is beyond the blinking insertion point to 
the top of the next page. When you use Show Invisibles (Format menu), this 
commands appears as Q. These markers do not terminate the paragraph; 
return provides that control so press return if the alignment, line spacing, 
tabs, etc., are to be different for the two parts.
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Calc Prev} or I Size (96D)

Use this command to automatically size the j  or I symbols. For example, 
after you enter the integrand, press 96 D to resize the integral sign. To 
manually adjust the size, use the Character Editor.

Show Layout/Hide Layout

Show Layout toggles with Hide Layout to reveal the boundaries of the 
headers, footers, margins, etc. Without these boundaries you obtain an 
uncluttered view, but with them you can tell where various regions are on 
the page (Figure 6.73 and Figure 6.74).

n

2

The mathematical derivation of the complete equation is complex and can be found in 
Parlange et al. (1985). Here we shall instead provide an intuitive and very simple derivation 
of a more practical equation "which is almost identical. We start from Richards' equation

Figure 6.73 Page without margin indicators

2

The mathematical derivation of the complete equation is complex and can be found ini 
Parlange et al. (1985). Here we shall instead provide an intuitive and very simple derivation
bf a more practical equation "which is almost identical. We start from Richards' equation
j I

Figure 6.74 Page with margin indicators

Hide Messages/Show Messages

Hide Messages toggles with Show Messages, and they display the markers 
for paragraph rulers. Use Print on the File menu to print these markers.

Show Invisibles/Hide Invisibles

Show Invisibles toggles with Hide Invisibles and provides visual access to 
the hidden formatting characters (Figure 6.75), such as tabs, line breaks, 
page breaks, end of paragraphs, and spaces. To remove these markers, click 
just before the next character (NOT just after the marker) and press delete.

♦  ?  Bi O  n
Figure 6.75 Hidden character symbols
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Hide Pictures/Show Pictures

Hide Pictures toggles with Show Pictures and suppresses the display of 
pasted graphics in order to produce faster scrolling. A rectangular 
placeholder preserves the page layout (Figure 6.76).

Mill Shorn layout I E ll
I 0, i 1 I ,1.11.1.1 . l . 12. 1 . I . i . 13, i , 1 . i i 14, i , 1 . i , J5. i . 1, i , IS4 ►

♦
0

; Page -  1 This is the header area. MW treats this as a mini MW document 
Which you can edit within the same window. See Page Layout and Document 
Format on the File menu for controls.

I This is the text region. Show Layout displays the 
boundaries of the text body, headers, and footers using 
jdotted lines. Cursor shape changes also identify the 
regions.

This line contains a memo note.

This line contains a hidden picture

L6 , C40W P
a

Base Geneva 12 a
Figure 6.76 Hide pictures for faster scrolling

The Palettes Menu
Palettes

Geometry 0L 1II0o
y-s.zi□□a 0=~

Operators +-X ~ =*<>ex±*i
Math/Calculus f n 2I □»-3- / jV

Sets unc C<Z€0©0
Logic AV“I V33
Arrows <—T 4— <==>ft ft c=bJ
Misc. n3X«' t t ■ £§an•oz.ZW
Brackets ()[]{}L J r 1<)
Uariables mffl ©$T~ 2#2[i#[]l]l 1

gradient, divergence, curl

Figure 6.77 Palettes menu

The Palettes menu (Figure 6.77) displays all of the symbols from the 
Symbol font except the Greek alphabet, which is available when you click
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on the Palettes window (Windows menu). In addition, the Greek alphabet 
is immediately accessible from the keyboard. Press Si spacebar to toggle 
between the current font and the Greek alphabet. Pull down the Palettes 
menu and move the cursor among the items in the window. Note that the 
name of the character on which you place the cursor appears in the row at 
the bottom of the window. Click on a character to insert it into your 
document.

You can copy each row of this Palettes menu to the Palettes window. First 
select the Palettes window (Windows menu). This places the Greek 
alphabet at the bottom of the screen. Then pull down the Palettes menu 
and select Geometry. The Geometry row of characters appears at the 
bottom of the screen with the Greek alphabet. To remove Geometry from 
the screen, select it again from the Palettes menu. MathWriter marks each 
row that you copy to the Palettes window with a check.

The Diac Menu

0 0 0 1 3 * 0 0 0
E E E T

f  " \

■ I ' > j
»___.— i

■ 1 --»
Ra ise «R
Lower 3SL

1 Remoue
umlaut or dieresis |

Figure 6.78 
Diacritics menu

When you place the cursor immediately to the right of an alphabetical 
character, the diacritics on the top row of the Diac menu (Figure 6.78) 
become available. Note that the name of the diacritic on which you place 
the cursor appears in the row at the bottom of the window. Click to 
associate a diacritical mark with a character. Use the Raise and Lower 
commands to adjust the height of these diacritical marks. Use Remove to 
remove a diacritic. If you repeatedly require a spacing different from the 
default, use the Library macro capability (Windows menu) to save and type 
the adjusted combination quickly.

When you highlight a group of characters, the remaining commands on 
rows two, three, and four become available. MathWriter automatically 
stretches these overbars, underbars, grouping brackets, etc., as needed. Use 
the split I-beam to edit within the structure. The Raise, Lower, and 
Remove commands apply to the structures while selected.

The Style Menu
The Style menu contains menus for assigning fonts (typefaces), sizes, and 
styles.

Text Fonts

Pull down the Style menu (Figure 6.79) until you reach Text Fonts. A menu 
pops out containing a list of fonts (Figure 6.80). The list depends upon those 
fonts currently available to the system. (Use the Font/DA Mover to change
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the list. Refer to the Macintosh User's Manual for a discussion.) The laser 
fonts available to the LaserWriter Plus are underlined. If you press the 
option key while selecting text fonts, each font name appears in its 
respective style (Figure 6.81).

Because mathematical writing necessarily involves many nonal- 
phabetic, special characters, making global font changes could 
significantly change the document content because special symbols 
are not assigned to the same ASCII code throughout all fonts. To 
guard against this pitfall, MathWriter identifies the fonts by 
name, not just ID numbers. When you open a file, MathWriter 
warns you if the entire set of fonts used in the document is unavail
able to the operating system. MathWriter extends this machine 
independence to include the PICT pasted into a MathWriter 
document. Because the font identification number is not a unique 
identifier, conventional word processors allow the font name to be 
lost and hence a loss of assurance that the document is unchanged. 
Because mathematical symbols have no universal ASCII position, 
a font change can have serious, not just cosmetic, consequences. If a 
MathWriter document has the correct appearance, including 
imported PICTs on your computer, it will have the same 
appearance on any other Macintosh that has the correct set of fonts 
installed—even if they have different font identification numbers. 
Use the File Warnings option on the Preferences command of the 
File menu to warn you if the document being loaded requires 
additional fonts to match those of the originating computer. 
MathWriter's  font identification procedures allow you to share a 

document by electronic mail, provided the recipient is using the identical 
set of fonts.

Style
Tent Fonts ►
Tent Sizes ►
Tent Style ►
Greek &
Larger Size
Smaller Size §€-
Style 1 *<
Style 2 m>
Last Style m\

fluto Math 36E
fluto Math Options.. .

it a lic s  £)*< o ptio ns L is t ...

M e tric s ,,,

User S ty le s ...

Figure 6.79 Style menu

Chicago Chicago
Courier Courier

✓ Geneua ✓  G e n e v a
Heluetica H elvetica
Monaco Monaco
New Century Schlbk New Century Schlbk
New York N e w  York
Symbol SyypoA
Times Times
Uenice km icc

Figure 6.80 Font submenu Figure 6.81 Fonts listed using own font

Text Sizes

When you drag to Text Sizes (Figure 6.79), a menu (Figure 6.82) pops out 
that contains various standard font sizes. The outlined sizes identify the
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fonts with actual bitmaps available to the system. The system must create 
the other sizes, which will appear ragged on the screen and on Image- 
Writer output, but not on LaserWriter output. System 7.0 addresses this 
problem.

6 point
7
8
9

✓ n s

0®
84
36
48
Other (64)...

Figure 6.82 Text sizes submenu

With the Other (64)... command (Figure 6.83) you can select sizes not 
included in the submenu list. Enter the desired integer font size and click 
OK. This new size is displayed in the Other ( )  command.

Select font size...

— t ------ = = !\
Cancel OK

— 1 Jl

Figure 6.83 Select other font sizes

Text Style

The standard Text Styles (Plain, Bold, Italic, Underline, Outline, Shadow, 
Condense, and Extend) are available from the submenu (Figure 6.84). When 
you select Plain, all other styles are overridden. Uppercase and Condense 
appear dimmed until you check them. Then each has a pull-down menu. 
The pull-down menu for Uppercase provides all uppercase letters, all 
lowercase, or Cap. First, which capitalizes the first letter of each word. 
Condense and Extend alter the spacing of any group of selected characters 
by removing or adding a pixel between characters. You can apply a limited 
form of kerning to letter combinations throughout the document using the 
style-sensitive feature of Find/Replace (Edit menu). See Chapter 3 for 
instructions on how to do this.
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^Plain 3€P
Bold
/talk * 1
Underline #:U
EmODBuo

a M C D E J
Condense
E h tend
Other Styles...

Figure 6.84 Text Style menu

Click Other Styles... (Figure 6.84). This opens an Other styles window 
(Figure 6.85) that supplements the standard choices. The first column 
repeats the standard styles of Plain, Bold, Italic, etc. If you select 
Underline or Low underline, Underline pattern and Underline weight 
options become available. Click in the rectangular box beside Underline 
pattern (or on the name) for a choice of patterns and Underline weight for a 
choice of weights. When you check Gray, a scroll bar for setting the gray 
scale appears. Seven of the options (UPPERCASE, Condense, Underline 
pattern, Underline weight, Background pattern, Background color, and 
Character color) provide alternative choices using pop-up menus. To use the 
pop-up menus, press on a choice and drag to make a new selection. See 
Figure 6.86 for examples.

Use Words only to make other choices apply to the words, but not the 
spaces between the words. Use Strikeout to indicate deleted text. Use 
Overbar for vectors and complex conjugates in mathematical manuscripts. 
Use Box to denote added text, and use Underline and Low underline, 
individually or together, to identify new text or to place special emphasis 
on certain sections.

Without retyping, you can change text to lowercase, uppercase, or make the 
first letter of a word uppercase. First highlight the text you want to 
change. Then open the Other Styles window of Text Style (Style menu) and 
click on the style change you want. MathWriter preserves the original 
style information and allows you to restore it without retyping.

Background pattern, Background color, and Character color provide pop-up 
menus that offer a variety of choices. You need a color monitor to benefit 
from the Background color and Character color choices.

The shading styles may also be useful to mark added text or make blocks of 
text more prominent. If you have a color monitor, you can enable color from 
the Control Panel (Apple menu) and assign a background and character 
color for display on a color monitor.
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□  Plain 
0  Bold
□  ftaf/c
l~~l Underline

□  ErnGODme
□ aojataatiD

□  Words only
□  Strikeout
□  Ouerbar

□  |oE
□  Lom underline
□fumncIsEj

O  i: <mde nst>

□  Gray

Underline pattern 

Underline weight

Background pattern 

Background color 

Character color

White

Black Cancel I °* )
Figure 6.85 Other styles

When processing the additional information needed for a color monitor, 
MathWriter  will perform more slowly. For additional details refer to the 
discussion of the Other styles in connection with Doc Preferences (File 
menu). When you finish changing styles in the Other styles window, click 
OK to accept your choices, or click Cancel to reject them.

Underline pattern
Background pattern

rmirm BBS
..........
<8533 HWHH
moon

=
'///✓  mm h-

A ®
6 5 5 6  ZZZZ

n r a i ,aaaa. y■ ay 0

Character color 
Background color

Black 
✓  White 

Red 
Green 
Blue 
Cyan 
Magenta 
Yellow

Underline weight

Gray |Q i 11111101 50 %

Figure 6.86 Other styles pop-up choices
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Greek (96 spacebar)

Because the Greek alphabet is so widely used in mathematics, science, and 
engineering, a dedicated menu command and key command for rapid access 
are provided. The Greek command is disabled by a selection from the text 
font submenu. For rapid changes, both the mouse and keyboard commands 
toggle between Greek (on the Symbol font) and the last font in use. The Last 
Style command on this menu plays the same role for all other fonts.

Larger Size (96 +), Smaller Size (96 -)

Because you change font size so frequently when typing mathematics, 
MathWriter supplies special menu and keyboard commands for changing 
font size. You can easily step through the font sizes on the font size menu 
using these keyboard commands. When used with the option key (96 option 
+ and 96 option -), these commands make smaller changes—one point steps, 
rather than going through the sizes on the menu.

Style 1 (96 <), Style 2 (96 >)

Style 1 and Style 2 let you compose two of your own style combinations. 
First, open Doc Preferences... (File menu). Click on Style 1. This opens the 
Set style number 1... window where you can choose the styles you want to 
use. Click OK to accept the styles and close the window. Click OK to close 
the Doc Preferences... window. Now select or highlight a portion of text. 
Pull down the Style menu to Style 1 and release the mouse. The selected 
text should appear in the style you chose for Style 1. These style 
combinations are merely a typing aid. MathWriter does not preserve any 
linkage with the text you type using these styles. However, you can use 
Find/Replace (Edit menu) to make local or global style substitutions 
without altering the text.

Last Style (96 \)

The Last Style command provides a quick return to the immediate past 
style. This feature is especially useful when you must toggle between two 
styles, such as the frequent use of boldface notation for vectors and scalars.

Auto Math (96 E), Auto Math Options...

The next group of commands provides for automatic handling of two routine 
tasks associated with typing mathematics. Click Auto Math Options... and 
select the options you want from the open window. Then, clicking Auto 
Math (not just their selection in the options box) enables those choices. 
While composing a manuscript, use 96 E to toggle on and off the combination 
of features selected using Auto Math Options (Figure 6.87).

Auto Math options include: auto-bracket sizing, and automatic replacement 
of arithmetic operators with the corresponding, better-formed characters
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from the Symbol font. For example, the plus sign in the Times font is larger 
than the Symbol plus sign.

When Auto Math is enabled, MathWriter  automatically sizes brackets as 
you form an expression (Figure 6.88). If Auto Math is inactive while you 
create an expression, you can select an existing expression and then choose 
Auto Math, 36 E, to size the expression automatically.

Ruto Math Options...
(Ruailable Only Lilith Ruto Math Turned On)

0 □  R u to -S p a cin g  Ground O perato rs 

B S  Ruto-Bracket Sizing
ag-s= i □  R u t o " it a ik iz o

g □  it a l ic iz e  Greek Chare* tors

„  Ose Symbol Font For Keyboard 
-vs L:J generated Operators find Brackets

Cancel K___ il
Figure 6.87 Auto Math options

\+x f \+x ' 
l - * 2 [ l - x 2 ,

Figure 6.88 Parentheses typed without and with Auto-sizing

If you click Use Symbol Font for keyboard-generated operators and 
brackets, MathWriter substitutes the Symbol font for other, less attractive 
font characters. You can select these options using the mouse or type the 
appropriate 36 option letter (36 option with the first letters B, S), but they 
are not enabled until you use Auto Math (36 E).

The typeface indicator in the status bar at the bottom-right corner of the 
document window appears in inverse when Auto Math is active. If you turn 
this feature off, MathWriter runs faster.

Italics Exception List...

The Italics Exception List command is not available in this version.

Metrics...

The Metrics command is not available in this version.

User Styles...

The User Styles command is not available in this version.
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The Windows Menu
The Windows menu (Figure 6.89) provides access to various windows— 
Tools, Templates, Palettes, Font Table, Modules, Clipboard, Help, and any 
open document window. You can arrange the windows of the open documents 
for convenient access. The use of the Tools, Templates, and Palettes 
windows is discussed in detail at the beginning of this chapter. The Font 
Table provides increased typing speed for infrequently used characters in 
all fonts.

Clean Up Windows

Clean Up Windows "stacks" the document windows with a slight offset 
that makes the multiple file names partially visible and allows you to 
make any file active by clicking within its window. Math Writer brings 
the active file to the front. Up to four files can be open at once.

MathWriter provides four floating windows: Templates, Palettes, 
Tools, and Font Table. You can place these on the screen by selecting 
them in the "Windows" menu. If you do not like their position on the 
screen, place the mouse in the gray area of a window and drag the 
window where you want it. Math Writer remembers the locations of the 
floating windows when you retrieve the file later. To completely 
remove these windows, either click their close-boxes or reselect the 
window from the Windows menu. Scrolling will be faster if the floating 
windows do not obscure the document window, which would require the 
screen to be redrawn more often.

Tools Window

The Tools Window selection (3§ A, i.e., command tab) displays or hides
the floating Tools window (Figure 6.90). If you reposition the Tools

r-  ̂on up j  window, MathWriter retains the new location of the window even if vouFigure 6.89 Windows menu . , 7temporarily remove the window.

Type 9£ tab (9$ A) to bring the Tools window (Figure 6.90) to the foreground. 
We use A to denote the tab key.

□1

* +

X 1

I’T

Windows
Clean Up Windows

Tools Window 3§A 
Tools ►

^Templates Window 
Palettes Window 
Font Table Window

library Window 
l ib r a r y  ►

Modules ►

Clipboard
Help §g?

</untitled 1

Figure 6.90 Tools Window
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Tools

The Tools submenu (Figure 6.91)provides menu access to the four editors:

yient Editor 380'
Math Editor 38-0;
Character Editor §eo [
Sidebar Editor 8801

Figure 6.91 Editor selection menu
• Text Editor, identified by the traditional I-beam cursor

• Math Editor, identified by a split I-beam cursor and used for editing 
within mathematical expressions

• Character Editor, identified by an arrow cursor and used for moving 
characters

• Sidebar Editor, identified by the "+" cursor, is not available in this 
version.

You can reach these tools from the Tools window or from the keyboard using 
the commands shown in Figure 6.91.

Templates Window

Palettes Window

Click the Templates window selection on the Windows menu. A col
umn of mathematical templates appears on the left of the screen 
(Figure 6.92). These include fractions, radicals, products, summations, 
integrals, set operators, special structures such as limits, grouping 
brackets, vectors and matrices, and tables. Click on the first template, 
the fraction template. A pop-out menu provides three types of 
fraction templates. Move the arrow cursor to the one you want and 
release the mouse. This places that choice in your document at the 
location of the blinking cursor. To type a fraction, type the numerator, 
press enter, type the denominator, and press return. The other 
templates operate in a similar fashion. (For a more detailed discus
sion, see Chapter 4.)

Figure 6.92 Templates Window

HI

vS

Click the Palettes Window on the Windows menu. A row containing 
the Greek alphabet appears (Figure 6.93) at the bottom of the screen. 
Click one of the letters of the alphabet. The letter appears in your 
text at the location of the blinking insertion point. You can add 
palettes from the Palettes menu at the top of the screen. Pull down

u

735
M 
1
the
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Palettes menu to Geometry and release. This places the row of Geometry 
symbols at the bottom of the screen for easier access. To remove Geometry, 
pull down the Palettes menu and click on Geometry again.

+ - X + ~ = 2 < > cx ± * II
1 n 2 1 A V a / /r

u n z> c 3 C € * © 0

A V —1 v V 3 3

a p X 6 C L 0 X K A X V 1 0 ft X c T V * jL to X G3

Figure 6.93 Palettes window

Font Table Window

The Font Table (Figure 6.94) is an especially useful window to have open if 
you must type rarely used symbols or symbols that do not correspond to 
easily remembered keys. You can type characters directly from the Font 
Table, unlike the Key Caps desk accessory. This is especially useful for 
symbols that may have little mnemonic correspondence with the keyboard. 
Special mathematical symbol fonts such as Machais are prime candidates 
for use here. To gain access to other fonts, click on the name of the font in the 
window. A pop-up menu gives you a list of possible fonts. Select a different 
font by dragging to the name of the font you want and releasing the mouse. 
Resize the font window, if screen space is at a premium, by clicking in the 
boxes at the lower-left corner and dragging.
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Figure 6.94 Font Table

Library Window/Library

The Library and Library Window commands are not available in this 
version.

Modules

The Modules submenu provides access to the modular extensions to Math- 
Writer. You can extend the scope of Math Writer by adding modules, or you 
can remove unneeded features for disk space. The first module is a disk- 
based database that can interact with the data structure of MathWriter 
and use MathWriter for formatting and output.

To add a module, simply place it in the system folder or in the same folder 
with MathWriter. MathWriter  locates and incorporates such modules 
when you next open the application. To remove a module, exit from Math- 
Writer and remove the module from its folder.

The Modules feature allows you to customize Math Writer with ease. Read 
the "Read Me" file on the distribution disk and the section on modules at 
the end of Chapter 4 for additional information.
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Clipboard

The Clipboard command on the Windows menu provides diagnostic access to 
the contents of the Clipboard, which is used to transfer text and graphics 
between applications or from one location to another within a document. 
The mathematical expression in Figure 6.95 is shown as a PICT file because 
it was placed there using Copy As Picture (Copy Other submenu) on the Edit 
menu. To copy text to the Clipboard, select or highlight the text and then 
select Copy (Edit menu). To copy a picture, select Copy as Picture (Copy 
Other, Edit menu).

Help (#  ?)

The Help window supplies online hints on the use of Math Writer features. 
Scroll through the list or select a topic to go directly to a specific, topic.

Document names

The final entries on the Windows menu are the names of open documents. 
Either click on an exposed portion of a document window or select it here by 
name to make it the front window on the screen.
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1

Interface Fundamentals

The Macintosh interface embodies three qualities—responsiveness, permis
siveness, and consistency. Responsiveness means that commands are intui
tive and results are direct. Permissiveness means that you can perform rea
sonable tasks at any time. Consistency means that all applications have 
similar interface standards. This shared interface makes your transition to 
MathWriter much easier. In fact, experienced word processor users probably 
can use many of the Math Writer enhancements without reading the manu
al. Although we have extended the scope of MathWriter well beyond tra
ditional word processors, we believe MathWriter's interface makes the use 
of this greatly expanded functionality intuitive.

MathWriter's hallmark is its visual orientation. Whenever possible, 
Math Writer provides a visual means for selecting commands such as scroll
ing lists and palettes. Generally, when you make a choice by clicking, your 
choice is highlighted by a reversal of its black and white pixels. Because 
the primary purpose of a word processor is the preparation of printed out
put, an immediate and faithful visual representation of the document on 
the screen expedites the process. This characteristic is called "What you 
see is what you get," or WYSIWYG (pronounced "wizy-wig"). Math Writer 
updates its screen display after each keystroke. Even the editing of the 
various components on the displayed page (header, footer, footnotes, and 
equations) is handled in context.

Keyboard and Mouse
The standard keyboards contain two types of keys—character and modifier 
keys. The character keys produce letters, numbers, symbols, and spaces. 
Other character keys (enter, tab, return, delete,  and clear) provide format
ting and other control and may be context-dependent.

MathWriter uses the return and enter keys for different tasks when you edit 
mathematical expressions. The enter key moves the cursor to the next lower 
hierarchical level in an expression, but the return key immediately moves 
the cursor to the baseline of ordinary text. For example, if you position the 
insertion point at a superscript to a superscript, pressing enter moves the 
insertion point down to the first superscript, but pressing return immediate-



ly moves it to the baseline. In this example, pressing enter twice is equival
ent to pressing return once.

Tab advances the insertion point to the next field or tab marker. Enter sign
als that text or data in an input field is complete. Return signals movement 
to the leftmost field one step down; during text entry it signals a new para
graph. Both return and enter close dialog boxes. When creating a table in 
MathWriter, use tab to create a new column and return to create a new row.

Pressed modifier keys [shift, caps lock, option, control, and command (3£)] 
change the interpretation of keystrokes and mouse actions. Shift  and option 
change the character set associated with the character keys. Press the 
shift  key to select the upper character on keys with two symbols. Caps lock 
latches the shift  key only for alphabetic keys. You can use caps lock and 
option in combination on alphabetic keys. Use shift return to force a new 
line while still in the current paragraph, such as for a mathematical ex
pression that needs to be continued on another line. Use option spacebar to 
toggle between the current and Greek alphabets. Character keys that you 
select while you press the command key usually produce commands. You can 
execute many menu commands using combinations of command, option, and 
shift  keys. See appendix 3 for a list of these combinations and scrolling 
commands.

If the Macintosh is busy executing previous commands, MathWriter  saves 
the keyboard and mouse commands in a queue for subsequent processing. If 
you hold a character key down longer than the time you specified in the 
Control Panel, the computer types the key repeatedly. The arrow keys 
control the movement of the cursor.

There are both mouse and keyboard controls for the blinking insertion point. 
Most mouse actions involve positioning of the cursor "hot spot", e.g., the tip 
of the arrow, over an object and pressing the mouse button. The cursor shape 
changes to indicate the nature of its current use. With an I-beam you edit 
within the body of the text, the header, or the footer. Use the arrow for 
selecting. Use the split I-beam to position the insertion point in 
mathematical structures.

Mouse actions include clicking, pressing, and dragging. To click, position the 
pointer with the mouse and then press and release the mouse button. To 
press, position the pointer with the mouse, then hold the mouse button 
down without moving the mouse. To drag, position the pointer with the 
mouse, hold the mouse button down while you reposition the pointer, and 
then release the mouse button. To accommodate even the fastest typist, 
mouse actions ("mouse-ahead") and keyboard commands ("type-ahead") 
made during the normal execution of other commands are saved in a buffer 
for subsequent execution.
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MathWriter provides several composite operations. Click to position the 
insertion point where you want to add new text in a Math Wn'ferdocument. 
Double-click to select a whole word and triple-click to select an entire line 
of text. Use the Control Panel to adjust the double-click speed and the 
sensitivity of the cursor to mouse movement. To make an extended, 
contiguous selection of text, click at one end of the selection and either drag 
to the other end or shift click to establish the other end. The status bar 
reports the line and character of the beginning and ending of the selection.

To scroll the active document window in Math Writer by mouse: (1) click in 
the scroll arrows to scroll a few lines, (2) option click in the scroll arrows to 
scroll a single line, (3) press in the scroll arrows to repeatedly scroll in 
multiple line increments, (4) option press to repeatedly scroll in single line 
increments, (5) drag the scroll box to move larger distances (the position of 
the scroll box indicates the relative position of the current screen within 
the entire document, and the page number1 is displayed here), and (6) click 
in the scroll bar above or below the scroll box to scroll the height of the 
current window. See appendix 3 for a table of commands.

To use Mat h Writer for screen presentations, option click in the scroll bar to 
advance to the top of the header of the next or previous page or command 
option click to advance to the top of the text body of the next or previous 
page. With a screen image projector, MathWriter doubles as an overhead 
projector.

MathWriter lets you open multiple windows at the same time. Up to ten 
documents can be open, but only one can be active at any time. Math Writer 
identifies the active document with lines in the title bar and a scroll box in 
the vertical scroll bar, and it is the front-most document window. Click 
anywhere within an uncovered portion of a window or select it from the 
Windows menu to make it the active window.

MathWriter also provides floating windows, selectable from the Windows 
menu that can be active while a document window is active. These windows 
contain tools and information you use to modify the document in the active 
window. You control the placement of all windows by dragging the title 
bar. You cannot drag it completely off the screen. Click in the close-box at 
the top-left corner to close or remove a window. You can enlarge or reduce 
the size of a window by dragging its size box at the bottom-right corner of 
the window. The zoom box at the top-right comer toggles the window 
between its current size and placement to full-screen utilization. The 
horizontal scroll bar allows you to select the horizontal portion of the 
document you want to see if the document is wider than the window.

1 The page number of the page number variable in the header or footer is displayed in the status bar when you press 
on the vertical scroll box.
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MathWriter handles some scrolling automatically. If you drag the cursor 
above or below the active window when selecting text, the document win
dow scrolls. If a selection is not currently showing in the window when you 
perform an operation, the window scrolls automatically. Some operations, 
such as Find/Replace or Check Spelling, automatically scroll the selection 
into view. Show Selection on the Edit menu scrolls the document such that 
the insertion point becomes visible.

Menus and Commands
Commands either perform operations on the entire document or the current 
selection or specify the attributes of an object. Attributes apply to the 
current selection and to subsequent input until you change the attributes. 
When you place the insertion point adjacent to existing text, the typeface of 
the new text will match the typeface of the character immediately before 
the insertion point. Many commands apply only to the current selection; 
such commands remain unavailable and, therefore, dimmed unless you 
make a selection. You must identify the object first and then give the 
command. Menu commands not available in this version remain dimmed at 
all times. Gray lines group related commands on a menu.

The MathWriter menu bar lists commands grouped by function. Drag to 
select an item from a pull-down menu list, which remains hidden until 
needed. Menu items marked with the three dot ellipsis (...) produce a 
dialog box in which you make choices or type information. Some menu items 
provide additional alternatives in submenus. Drag to select the menu item; 
when the submenu appears, continue dragging to select the command. 
MathWriter's extended command set benefits from this organizational 
hierarchy. Check marks indicate the current choice among mutually 
exclusive choices such as the active document window and the current font 
name. In a selected portion of text MathWriter  identifies a common font 
with a check mark; but if you include multiple fonts within a selection, 
MathWriter identifies the fonts in the selection with a bullet adjacent to 
each font included. If multiple attributes such as bold, italic, etc., are in 
effect at one time, a bullet identifies the selected attributes. In all cases, 
Plain cancels all other style attributes.

Some menu lists change to reflect the current status. For example, some 
commands toggle between two choices such as Show Layout and Hide Lay
out. MathWriter dims currently unavailable menu commands. It displays 
the names of open document files on the Windows menu.

Finally, those menu commands that you can execute from the keyboard use 
the key combinations of command, shift,  and option shown on the menu. See 
appendix 3 for a list of these commands. The command to abort the current 
operation, command period, has no menu equivalent.
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Math Writer has eight menus. The Apple menu provides information about 
MathWriter and access to the desk accessories. The File menu provides 
access to the file handling capabilities, various global defaults, printing, 
and session termination. The Edit menu provides tools for modifying the 
text. The Edit menu adapts according to the current choice of editor— 
character, text, and math. The Format menu handles the various 
formatting functions. Palettes and Diac provide rapid access to special 
symbols. Style provides controls for typeface changes. Windows provides 
control of the document and floating window choices.

Dialog and Alert Boxes
When a command is incomplete or ambiguous you must supply additional 
information before MathWriter  can complete the command. You can make 
multiple choices within a single dialog box and even revise your choices 
before you accept the entire combination. This approach is easier for the 
user than responding to a series of prompts presented individually. Click on 
the Cancel button or the close-box to abandon a dialog box without making 
any changes. Click on the OK button when you are ready to implement the 
choices you have made. The default or preferred choice is boldly outlined. 
Pressing return is equivalent to clicking on the default button.

MathWriter uses more than two dozen dialog boxes that include scroll 
windows, circular radio buttons for mutually exclusive choices, square check 
boxes for nonexclusive choices, text boxes for text input, buttons to issue 
commands and select alternatives, pop-up menus for mutually exclusive 
choices, and scroll bars. Alerts warn you when unusual situations occur. For 
example, if you attempt to close a file that you have modified since you 
last saved it, MathWriter alerts you to the potential loss of information 
and allows you to take corrective action.
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2 MathWriter Files

Math W riter™  2.0

Jxdx

MW document

text

MathWriter™ 2 .0  MW document text text .PICT

n. •••• U| a—
!■'. •• • •

a
Jx4x

MathWriter Dictionary MW User Dictionary MathWriter™ P re f Default file

MathWriter Help A Sample F ilte r A Sample Module 

Fig A.l MathWriter file icons

The MathWriter 2.0 file icon is a variation of the older MathWriter 1.4 
icon. Some lines of text have been added to illustrate that you can combine 
mathematical expressions with text.

AM athW riter  document is a file created using Save on the File menu. Save 
your manuscript in this format if you expect to edit or print it with 
MathWriter  later. In addition to text, graphics, mathematics, and format
ting information, MathWriter  saves all the configuration information; 
when you subsequently open the document, the previously defined writing 
environment is restored.

MathWriter can also create standard ASCII text files for export to other 
applications. A text file preserves the text characters. MathWriter 
optionally creates consecutively numbered place holders to identify the 
placement of mathematical expressions and graphics stripped from the file 
and automatically stores them in a user-named scrapbook file. Unless you 
use a utility such as SmartScrap, you must place the Scrapbook in the 
System folder and rename it "Scrapbook File" to access its contents.



Appendix 239

text PICT

Y/7. ••••Hi

MathWriter Dictionary

MathWriter™ P re f

/ x d x

Default File

f x 4 x

MathWriter Help

A Sample Filter

When you create a text file, MathWriter's AutoScrap feature optionally 
stores the mathematical expressions and graphics in a scrapbook file for 
subsequent transfer into other applications. MathWriter optionally adds 
placeholders to the text file.

High-end word processors provide various editing aids, e.g., a spell
checker. The spell-checker also identifies repeated words, a frequent 
typing error.

A United Kingdom version of the dictionary is available. To use it, replace 
the United States version in the System folder with the UK version, and 
rename it to match the US versions, i.e., remove the three characters "UK " 
from their names. Alternatively, use the button on the Spell-check dialog 
box to select this file.

MathWriter  automatically saves the default configuration applicable to 
all documents in a preferences file (MathWriter Prefs) in the System 
folder. The MathWriter application should remain locked to reduce the 
risk of a computer virus infection. The defaults retrieved when you open a 
document supersede these global preferences.

Stationery files or default files are templates for frequently used document 
types that you create using Preferences on the File menu. A list of user- 
created default files is available (when you subsequently restart Math- 
Writer) as a submenu of the New command on the File menu. When you 
select New, a copy of a stationery file, including the Math Writer configu
ration, layout, typeface, content, etc., becomes the basis for a new document. 
The stationery file remains unchanged. MathWriter automatically loads a 
user-designated default file on startup; use Preferences on the File menu to 
designate the startup file.

Online help is retrieved from this file using the Windows menu. Help 
provides general information, a summary of keyboard commands, descrip
tions of menu commands, and steps to complete common tasks.

An anticipated family of file filters or translators allows you interchange 
files with other applications. To the extent feasible, MathWriter  saves 
the formatting as well as text with these filters. Simply place these filters 
in the same folder with MathWriter  or in the System folder, and 
MathWriter automatically recognizes them during startup, adding them to 
the pop-up list of file types in the file dialog boxes. This modular design 
allows you to customize MathWriter easily. A MathWriter  filter for 
Microsoft's Rich Text Format (RTF) for file transfer is supplied with 
MathWriter. Most word processors can create RTF files.
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A Sample Module

MathWriter  modules extend the functionality of MathWriter, the first 
word processor to provide modular extensions. Simply place a MathWriter 
module in the folder with MathWriter  or in the System folder, and 
MathWriter will automatically link it to the main program and provide 
access to the enhanced features via the Modules submenu of the Windows 
menu. This feature lets you customize MathWriter  to your specific needs 
and make enhancements without awaiting a new release of MathWriter.
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3 Keyboard Commands

Arrow Key Usage
(<—, — T, or 1 with key combination)
Command Option Shift Result

Moves insertion point a line or a character*

Cmd Scrolls window large amount

Option Begin/end line; top/bottom page, then doc.

Shift Extends Selection small amount

Cmd Option Scrolls window small amount**

Cmd Shift Move between cells in a matrix/table
Option Shift Extends Selection large amount

Cmd Option Shift <NotUsed>

* Arrow keys (<---- »' i )  alone.
** Cmd Option i  scrolls document window down approximately 1 line

Vertical Scroll Bar Usage
Key Mouse Result

Drag Scroll Box Scroll arbitrary amounts
Click Arrow Scroll large amount (approx 8 lines)

Option Click Arrow Scroll small amount (approx 1 line)
Click Scroll Bar Scroll 1 screen

Cmd Click Scroll Bar Top of Next/Prev Page*
Option Click Scroll Bar Top Next/Prev Header*

Cmd Option Click Scroll Bar Advance to top of Next/Prev Page Body*
*To scroll through lecture note screens



242  Appendix

Keyboard Commands
Key Command (98) Command Shift Command Option

A Select All Copy Ruler & Format
B Bold Auto Bracket
C Copy Copy As Picture
D Calc Prev J or 1 Size Paste Style
E Auto Math Number equation
F Find /Replace Copy Format Insert footnote
G Find Next Paste Format Italicize Greek
H Replace Selection
I Italic
I Paragraph Format Delete Row
K Line Spacing Delete Column
L Lower Diacritical
M Revise Copy Memo
N New Entry From Selection Paste Memo
O Open Column Before Auto Operator Spacing
P Plain Column After
Q Quit Row Before
R Raise Diacritical Copy Ruler Revision Tracking
S Save Copy Style Auto Use Symbol Font
T Print Paste Ruler
U Underline
V Paste Paste In Context
W Close Row After
X Cut
Y Other Styles
Z Undo Paste Ruler & Format

1-9,0 •Template Categories
' (~) Hide/Show Ruler
= (+) Larger Size (on menu) 1 Pt. Larger Size
- (_) Smaller Size (on menu) 1 Pt. Smaller Size
, (<) Style 1
.(> ) Style 2
/(? ) Help
M l) Last Style
; (:) •Center Subscript Math Editor
TO •Right Subscript Normal Editor
[(1) •Center Superscript Character Editor
10) • Right Superscript Sidebar Editor

Tab Tools Window
Return •Same as Enter key

Spacebar •Toggle Greek
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Special Key Combinations:2

Command +

Option + [^] + stretchable char3

Option + scroll up/down 
Command + [ ] ; '

Option

Option + drag tab 
Command + drag left margin 

Option + | symbol in Palettes 

Command K or Command F

Can't select sublines.

Enables stretching (noted by the word stretch in the 
bottom of the Tools window). Clicking and dragging in 
bottom or top of symbol stretches symbol. Clicking in 
center of symbol causes a reset to standard size.
10 pixel scroll, as opposed to 80 pixel scroll.
Corresponds to superscripting/subscripting tools as 
follows:

* [= |T | * 1 = 0
* ;  = [T| * ’ = [ 3

Toggles between

Smooth drag.
Doesn't move indent marker.

Vertical bar; always extends to the limits of the line.

Immediately after clicking OK in Print dialog box press 
and hold down until a banner appears to produce and 
save PostScript file for the active document.

2 Command = 96

3 Stretchable characters include any of the brackets and the integral symbol.
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Speed Enhancement

Graphical Representation
MathWriter is remarkably easy to learn and use because it is very visual. 
Within the limits of the technology, the screen image is a faithful 
representation of the document to be printed. MathWriter  uses all of the 
currently available. information to format the screen, even when you are 
creating complicated mathematical expressions. To the maximum extent 
possible MathWriter assumes responsibility for the complex formatting 
details, freeing you to concentrate on the substance of your document. With 
this approach MathWriter  caters to the needs of the scientist-authors, 
while also making the task of the technical typists and desktop publishing 
professionals easier.

This high level of interactive visual support requires considerable compu
tational power—even more than most explicitly numerical Macintosh 
programs such as our MacPoisson™ and MacElastic™ for solving partial 
differential equations using the finite element method. We recommend 
usingMaf/; Writer with the more powerful Macintosh models that utilize 
the 68020 and 68030 CPU.

Because of the computational requirements, we also designed MathWriter 
to retain the open documents in RAM for quicker access. However, portions 
of MathWriter  itself are RAM-resident as needed. When your document 
approaches the RAM limitations, the additional disk activity required to 
retrieve code will slow MathWriter.

MathWriter's data structure is necessarily more complex than those for 
conventional word processors. In particular, the editable mathematical 
expressions, which inherently contain multiple fonts, font sizes, and font 
styles as well as characters displaced from the baseline, require a richer 
data structure.

Approximately one third of MathWriter's 100,000 lines of code were 
written in the C language for increased performance.
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Speed Improvement
Here are some possibilities.

Hardware

• Use the most powerful Macintosh available to you

• Install more RAM

Operation

• Use existing RAM effectively.

a) Set Application Memory Size to utilize the available memory using Get 
Info on the File menu at the MultiFinder level. The memory allocated is 
used by Math Writer and your open documents. Allocate at least 2 mega
bytes, although minimal configuration is 800 kilobytes. This setting is 
irrelevant if you are using the Finder, rather than MultiFinder.

b) With severe RAM limitations, operate under Finder, rather than using 
MultiFinder.

• Disable features not currently needed.

Many of MathWriter's features can be individually enabled and disabled.

a) Use the Black & White setting for the Monitor using the Control Panel. 
Color is marginally useful and significantly impacts speed.

b) Toggle the Auto Math features off ($?£) when not entering a mathemati
cal expression.

c) Reduce screen refreshing by hiding the graphics, hiding the layout lines, 
hiding invisible formatting characters, and hiding the message icons in the 
left margin using the Format menu.

• Use multiple, smaller documents, especially if the memory utilization 
indicator on the status bar exceeds 90%. Also have only necessary documents 
open simultaneously when RAM is limited.

• Configure the document window and floating windows to minimize overlap, 
thereby reducing complicated screen refreshing.

• Use the typing aids (Style l ,  Style 2, Font Table, Auto Math, keyboard 
command equivalents for mouse actions, etc.) effectively.

• Use configuration and stationery files to reduce startup time.

• When possible, enter text at the end of paragraphs to reduce screen refresh
ing time. •

• Because Encapsulated PostScript files contain dual representations and 
therefore are larger, import them as late as possible.
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5 Command Key Switcher

Swap Command Keys
MathWriter uses X P  to select plain text and 96 T to print (type) output as 
specified in the Macintosh interface standards. Many have become 
accustomed to swapped roles for these commands so we have included a 
simple utility that will make this change.

A special-purpose utility

1. Verify that MathWriter  is available and that neither 
the disk on which it resides nor MathWriter is locked.

2. Double click the Command key switcher icon.

3. Click a radio button to select the preferred assign option (Figure A.2).

MathWriter Command Key Utility

This utility sets MathWriter's command key equivalents 
for print and plain to one of two different configurations.
Select a configuration below and click in the button to 
locate MathWriter and change its configuration.

® 3§T = Print I 9€P = Plain 

O = Print I X I  = Plain

, ... " "■ -------
Set Key Equiualents

k_______________________________________________________________
Fig A.2 Command key utility dialog box

4. Click the Set Key Equivalents button, locate the MathWriter applica
tion using the usual file opening dialog box, and click to save the change.

Cmd Key Switcher
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6 MathWriter Versions4

Educational Version
Ma th Writer /Educational Version is a subset of the Professional Version of 
MathWriter and is intended for use by authors who do not require the 
advanced features and who do not have access to the more powerful 
Macintoshes.

You should use the Professional Version if you have a Mac II or an SE/30 
with 2 megabytes or more of RAM and a hard disk. If you have a Macintosh 
Plus, SE, Portable, or Classic (68000-based CPUs) with only 1 megabyte of 
memory and two disk drives, use the Educational Version.

Both versions fully support the creation and editing of mathematical 
expressions within the document, as well as traditional word-processing 
functions. Math Writer is a completely new and powerful technical word 
processor designed specifically to address the demanding requirements of 
creating scientific manuscripts. The Educational Version retains the core 
features of the Professional Version, including its mathematical expression 
editor, and maintains file compatibility with the larger version.

Features removed

Color, Thesaurus, Hyphenation, Math-Science-Engineering dictionary, 
Revision tracking, Library, Memo notes, Sidebars, Background pictures, 
User styles, Adjustment for some defaults, Overview, Multiple columns, 
Auto-italics in mathematical expressions, Tab on user-selected character, 
Tab leaders, and Line numbering.

Features restricted

Character Editor retains cropping and sizing of graphics, up to one user- 
defined variable allowed, Find/Replace limited to traditional character 
searches, no more than one modular extension can be used at a time, and no 
more than four documents can be open at one time.

4 The specifications for the various versions are subject to change without notice.
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Features retained

Retained are within-the-same-document window editing of mathematical 
expressions, headers, footers, footnotes, etc.; dynamic variables for 
automatic numbering of pages and equations and their cross-references in 
the text; one user-defined variable set; Font Table for mouse access to all 
characters in all fonts; direct importation of graphics (bitmapped, object, 
encapsulated Postscript); resizing and cropping of graphics; easy typeface 
changing; automatic transfer of mathematical expressions and graphics to a 
scrapbook file; automatic numbering of footnotes; automatic pagination; 
automatic line spacing; easy access to multiple stationery files; and easy 
customization.

Demo Version
The Math Writer/D em o  Version is a virtually complete working version, 
but code has been removed to make it unusable for productive purposes, 
except to permit evaluation. All productive uses, except evaluation to make 
a licensing decision, are legally prohibited by the license agreement 
governing the use o f this version.

• Document saving capabilities have been removed.

MathWriter can open files created by a working version. All the document- 
creating tools are enabled in the Demo, so documents can be created, but 
cannot be saved for later use.

• All cut and paste features have been removed.

Output cannot be transferred into other applications via the Clipboard.

• The Spell-checker, Thesaurus, and Hyphenation code segments have 
been removed.

• Printed output is limited.

Randomly selected lines are truncated on each page.

Module Version
This minimal version provides formatting and printing for MathWriter  
modules. This version is available only as a host for a module. Modules, 
however, are compatible with the larger versions of MathWriter.
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Professional Education Module Ver
Math ✓ ✓

User category numbering limit (1) X
Revision tracking X X

Library X X
Auto Math limit (2) limit (2)
Font Table ✓ X

Tables ✓ v/
Char editor limit (3) x (#0)

Color X X
Auto Scrap ✓ X

Math-Sci-Engr Diet X X
Spell-Checking ✓ X

Thesaurus X X
Hyphenation X X

Sidebars X (#1 ) X (#1)
Headers/Footers ✓ ✓

Footnotes ✓ X
Auto-pagination ✓ ✓

Find/Replace limit (4) X
Line spacing ✓ ✓

Import Graphics ✓ ✓
Stationery ✓ ✓

Ruler ✓ ✓
User-selected Tab X X

Para borders y X
Metrics cmd X X

Typeface changes ✓ Limit (5)
Modules Limit (6) limit (7)

Customization ✓ ✓
User Styles X X

Line numbering X X
Memos X X

Multiple columns X X
Overview X X

Fract. Char Width X X
Doc. Open at once 4 2

RTF ✓ X
Online help ✓ </

Documentation limit (8) limit (9)
RAM 1 Meg IMeg

Storage 2 Floppies 2 Floppies

a) Maintain core mathematics features, b) Maintain 
[upward] file compatibility.

Limit (1) Disable New Variable, i.e., allow only one 
variable in addition to equation numbers.

Limit (2) Keep only auto bracket sizing.

Limit (3) Retain sizing and cropping of graphics.

Limit (4) Retain only traditional text search and replace 
(remove style only and revision style searches).

Limit (5) Remove Other Styles dialog.

Limit (6) Allow one Module at a time.

Limit (7) Restrict to a specific Module.

Limit (8) Delete material pertaining to deleted features; 
include Quick Summary.

Limit (9) Module manual will contain a terse summary; 
include Quick Summary.

(#0) Will retain sizing and cropping info assigned by 
larger versions; otherwise will require exact size from 
paint/draw program.

(#1) Discards contents of sidebars if included from full 
version doc.

These specifications are subject to change without notice.
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7 Other Software by the Authors

Macintosh Software

The authors collaborated with others in the creation of the following:

• MathWriter™ 1.4 The mathematical expression editor predecessor of 
MathWriter™ 2.0—The Scientific Word Processor for the Macintosh.

• MW2Te X™ 1.0 A translator of MathWriter 1.2-1.4 files into T^X.

• MacPoisson™ 1.0 and MacElastic™ 1.0 Instructional finite element 
analysis programs for two-dimensional and axisymmetric problems in 
steady heat conduction, electrostatics, ideal fluid flow, seepage, etc., and 
classical elasticity, respectively. Both are available in student and 
professional versions. MacPoisson was selected for "The Best Engineering 
Software" in Higher Education in 1989 by EDUCOM.

• MacRegistrar™ 1.03 A specialized database for managing class records.

• StomateTutor™ 2.0 A HyperCard presentation of original research on gas 
exchange in higher plants (includes two Pascal computational/graphics 
modules).

• ExamBuilder™ 1.0 A MathWriter™2.0 database module for exam items.

IBM-PC Software

PC-Poisson and PC-Elastic Instructional finite element analysis programs 
for two-dimensional and axisymmetric problems in steady heat conduction, 
electrostatics, ideal fluid flow, seepage, etc., and classical elasticity, 
respectively. Both are available in student and professional versions.

DiskManagerPC™ 1.12 Hard disk security and disk management program.

PC-Registrar™ 2.0 A specialized database for managing class records.

QuikBase™ 1.0 A pull-down menu, flat file database program with 
template editing and report generating support.
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theorem, vhich makes n possible to evaluate many definite integrals

P a a d a m e n t a /  T h e o r e m  a f C h J e m J m s , P e r l  2  Suppose 
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for all h j.h j  ■ A and k ,,k j  ■ H No». m particular, that If k a  H , k*0 ,th en
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Proof To be fillad m later

M e c h a n ic s  o f S to m a te s

When die pore opens, the vtdth W t§ 
described by a multilinear function (Eq 1 ] of 
the internal pressure Pf  and the external 
pressure P,

The coeffinent b( represents the change m pore vidth for a m 
remains constent Lihesrise, the coefficient b, represents the i 
unit increase In P ,, If Pg remains constant

P I  b . -  i  I and b. ■ 2 - 1

System Requirements
Macintosh ■ SE/30 or Macintosh II family with two megabytes of RAM 
and a hard disk. MathWriter will run on machines with only one 
megabyte, but document size will be limited.
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